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How to discover WINDEV?
WINDEV is a powerful Windows-focused Integrated Development Environment, that includes all
the tools required to design and develop applications.
To quickly and efficiently learn how to use WINDEV, we recommend that you proceed in the
following order:

1

Read the “Concepts” (online or on physical documentation).
This guide presents the main concepts required to create a WINDEV application. Some
concepts are followed by a “Practical” section that presents some features of the editor.

2

”Tutorial” (online tutorial + exercises).
The tutorial provides a first "hands-on" approach to WINDEV. It allows you to familiarize
yourself with the main editors of WINDEV.

3

Try the examples.
Try the examples provided with WINDEV in the fields you are interested in (sales management, scheduling, etc.).

The online help, available on Internet at https://doc.windev.com or installed with WINDEV, allows
you to quickly find the syntax of a WLanguage function, get help about the interface and more, ...
For each programming theme, you will find a description of the associated feature and the list of
the corresponding WLanguage functions.
Remember to visit the download section of www.windev.com on a regular basis to check
whether upgraded versions are available.

Remark: If there is a difference between the tutorials and the online help, follow the instructions
in the online help.
We hope you enjoy getting started with WINDEV.

Email address of our Free Technical Support: freetechnicalsupport@windev.com.

This documentation is not contractually binding. Modifications may have been made to the
software since this guide was published. Please check the online help.

All product names or other trademarks mentioned in this publication are registered trademarks of their
respective owners.
© PC SOFT 2022: This publication may not be reproduced in part or in full without the express consent of
PC SOFT.
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Main concepts

Project and
analysis

Contenu

The development of a Windows Application with WINDEV is based on two main elements: the
Project and the Analysis.
A WINDEV Project is a set of elements: windows, reports, controls, classes, components, etc. The
combination of these elements is used to create a Windows application.
A WINDEV Analysis corresponds to the diagram of data used by the application. The analysis
groups the different tables (also called data files) used by the application.
An application is built from a project.
In most cases, a project is associated with an analysis.
An analysis can be associated with one or more projects.
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Projects in practice

To open the dashboard of your project:
1. In the open document tabs, open the context
menu of the "P" ("Project") icon.
2. Select "Display dashboard".
For more details, see "Project dashboard", page 57.

1 Overview
The first step to create an application consists in
creating a project.
When creating a project, you will be asked multiple
questions so that your project meets all your

expectations. All project characteristics specified
when creating the project can be modified later.
Remark: The analyses are presented in Analysis:
database structure.

2 Creating the project
To create a project:
1. Click
in the WINDEV quick access buttons.
The creation window appears: click "Project". The
project creation wizard starts.
2. Specify the different project options. The main
options are as follows:
• the type of project. Multiple options are
available: application, component, Java
application, etc. These options will be
presented later. In most cases, a project is
used to generate an application (executable).
• the operating system (Windows or Linux).
• the creation mode (blank project or based on
an example).
• the runtime mode and the type of executable
to generate (if necessary).
• the creation mode of the project. You can
create a blank project or a project based on
an existing example.
• the name and location. These options cannot
be modified. The project corresponds to a
".WDP" file. All elements associated with
the project will be created in the specified
directory.

All project managers seek to have a global and
synthetic vision of the progress status of the
projects they lead.
The QA manager wants to know the number of bugs
and their priority, and follow up their status.
The product manager would like to know what new
features are requested by the users.
The developer wants to quickly access the most
10
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The project includes windows, reports, queries,
sets of procedures, etc.
To know the list of elements of a project, on the

4 Operations performed on a project
• whether the project will be used by several
developers. You have the ability to use the
source code manager (SCM) to share the
project.
• the code style. This code style is used to
automatically prefix names of controls,
windows, etc. It is also possible to
automatically add prefixes when creating
variables.
• the style book.
• the supported languages. These languages
will be proposed by default if an option can be
translated in a control, window, report, etc.
3. Specify whether the project must use a
database. If yes, you can use an existing
database, or create a new one.
4. Validate the wizard. The created project
becomes the current project.
Remarks:
• If you chose to create a database, the analysis
creation wizard will start automatically.
• The specified information can be modified in
the project description. To open the project
description window, go to the "Project" tab,
"Project" group and click "Description".

3 Dashboard and project elements
3.1 Dashboard

3.2 Project elements

"Project" tab, in the "Project" group, click "List of
elements". This option is used to:
• add to your project elements belonging to
projects that can be accessed from your
computer. The corresponding files will not be
moved to the directory of your project.
• delete elements from your project. The
corresponding files are not physically deleted.
To quickly find an element in your project, press
"Ctrl + E" from any editor.

frequently used project elements, sections of code,
etc.
The dashboard meets all these requirements.
Additionally, it contains different indicators or
"Widgets". These widgets can be configured by the
user: the user can add, delete or resize them.
You can also display the project statistics (e.g., the
number of windows), the results of different audits
(static audit, dynamic audit, etc.)

Let’s see the main operations that can be
performed on a project:
• Make a backup copy of the project,
• Restore a project,

• Duplicate a project,
• Copy or delete a project,
• Rename a project.
For more details, see the online help.

5 Technical documentation of the project
WINDEV allows you to print different technical
documentations describing all the elements of the
project (windows, reports, data files, items, etc.). To
print the technical documentation:
• on the "Home" tab, in the "General" group,
expand
and select "Print project technical
documentation". The technical documentation
can contain all the characteristics of the project.
• on the "Home" tab, in the "General" group, click
. In this case, the technical documentation
will contain only the details of the current
element (window, report, query, etc.).

5.1 Type of technical documentation
There are different types of technical
documentation:
• Overall: Contains basic information about the
project elements.
• Code: Contains the code of all the project
objects and procedures.
• Full documentation: Contains all project
information. This type of technical
documentation can be very extensive.
• Custom: Corresponds to a selection of
information to print.
Generating the technical documentation
The technical documentation can be printed on the
selected printer. It is generated and displayed in
the report viewer. You can:
• start the print job,

• export the technical documentation as PDF (via
the "Export" tab of the report viewer).
For more details, see the online help.

5.2 Print areas
If graphical representations (LDM, UML diagrams,
etc.) must be printed, the print areas must be set
before printing the technical documentation.
To specify the print areas of the current graphic
representation:
1. Display the print areas in the current editor.
For example, in the data model editor, go to the
"Display" tab, "Help for edit" group, and check
"Print areas".
2. A series of borders that represent the printable
areas in the documentation will appear in the
current editor.
3. Reduce the graphic representation (change
the value in the combo box with a percentage in
the "Display" pane, or use the Ctrl + Mouse wheel
shortcut) to see the entire graph.
4. With the mouse:
• move these borders to the desired location by
keeping the mouse button down (the mouse
cursor is black).
• choose the number of pages on which the
graphic representation must be printed (the
mouse cursor turns into a North-West/SouthEast double arrow).
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Development cycle of an
application

Contenu

WINDEV covers the entire development cycle of an application:

Design

Development

Specifications

Create the project

UML modeling

Create the analysis

Test and
generation

Deployment

Test and debug
the application

Generate the setup

Generate the
application:

Final test

- Win32 executable
- Win64 executable

Import the
existing files

Development
-

Project RAD
Window RAD
Queries
Reports
Input of source code

- Linux application
- Windows/Linux service

First setup:
local, network, by HTTP, push
...

- Webservice

Update the application
Synchronize the deployed
data

Details of different steps:
Design step: An application can be designed from specific requirements, from UML modeling of
processes or even from existing data files.
Development step: The project and the analysis are created via specific wizards. The application
can be developed in RAD (Rapid Application Development) mode, with automatic code and
interface generation; or it can result from creating multiple project elements.

12

Part 1: Main concepts

Test and generation step: WINDEV proposes several automatic test tools to guarantee the
reliability of applications and to make sure that no regression occurs during the development
steps.
Deployment step: A WINDEV application can be deployed according to several methods: download,
via a local area network (including Push mode) or via Internet. In any case, the HFSQL data files
will be automatically updated according to the evolutions made in the application.
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UI:
Windows

Contenu

The UI (User Interface) of an application is mainly composed of windows.

The applications created with WINDEV can use several types of windows (and mix each one of
these types).

WINDEV includes an advanced window editor allowing you to easily and quickly develop all types
of UI.
Several features allow you to easily obtain intuitive and user-friendly applications:
• powerful controls,
• an anchoring mechanism allowing the UI to automatically adapt to the size of the display,
• a UI compilation system with error detection (empty titles, untranslated text, overlaps, etc.),
• ...
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Modal windows
A modal window is opened in the foreground of the application and it locks the access to the other
windows that are already opened (if any). In most cases, modal windows are used as:
• main windows of an application,
• dialog boxes whose validation triggers an action.
With WINDEV, when a modal window is opened, a gray shadow appears on the windows displayed
in the background: it is the DDW feature or Dim Disabled Windows.
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Internal
window

Non-modal windows

Contenu

A non-modal window is opened in parallel of other application windows. Each window remains
accessible. In most cases, non-modal windows are used:
• as tool palettes,
• as dialog boxes that affect the main window when modified.

The Internal Window control is used to include a window (and its code) in another window. At
runtime, the internal window will be dynamically merged with the host window.
1. Creating an internal window.
To create an internal window:
• Click
in the quick access buttons.
• The element creation window appears: click "Window" then "Internal window".
An internal window is a specific window that
contains no title bar and no menu.
All types of controls can be used in this
window.
In the example, an internal window is used to
select files.
2. Using an internal window.

In this example, each description window of a chair opens the description window of another
chair. All open windows remain accessible.

MDI windows
In an MDI application, all the application windows are displayed in the same main window: the
MDI parent window. There are two types of windows in MDI applications:
MDI parent window:
The other windows of the application are
displayed in this window. This window allows
the user to handle the main menu of the
application.

To use an internal window:
• Create an Internal Window control.
• In the control description window, select the
internal window to use.
• Validate the control description window.
Remarks:
• The internal window used in the "Internal
Window" control can be modified through
programming.
• Limitations: The host area is rectangular
and no override is allowed. To perform
overrides, it is recommended to use control
templates.

MDI child window:
Application window displayed in the parent
window. The user will be able to type
information in these windows.
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Window
templates

Contenu

WINDEV allows you to create window templates. These templates contain all the graphic elements
common to all windows of your application.
The changes made in a window template are automatically applied to all windows using this
template.
A window template follows the style book defined for an application.

View of a window template.
The template is bordered by an orange line
in the editor.

Template used in multiple windows.
The elements belonging to the template are identified by a yellow square.

Remark: The programming associated with the template elements can be performed in the
template directly.
The characteristics of the elements can be dissociated from the template. For example, dissociate
the position of a control from the template to move it elsewhere while keeping other changes
(code, style, etc.). This is referred to as control inheritance. In this case, the elements are identified
by a blue square.
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Windows in practice
The purpose of a window is to display, present or
allow users to enter information. This information
can come from data files in an analysis, external
files, queries, etc.
There are multiple options to create the windows of
a project in WINDEV:
• Create a blank window with the wizard.
• Build all the windows of the application from the
analysis description.
• Create a window from the analysis description
(with or without code).
• Create standard windows.
• Create windows based on a template, etc.
Regardless of the method used, the window can
be modified once it has been created: you can
add, modify or delete controls and change the
characteristics of the window.

For more details on how to manipulate controls in a
window, see "Controls in practice", page 38.
This chapter presents the following topics:
• "Creating a window", page 19.
• "Simple operations on a window from the editor",
page 20
• "Main characteristics of a window", page 20.
• "Window and image", page 22.
• "Opening a "popup" window", page 24
• "Dim disabled windows", page 25
• "Internal window", page 25.
• "Window templates", page 26.
• "Events associated with windows", page 26.
• "Context menus", page 27.
• "The status bar", page 31

1 Creating a window
WINDEV allows you to create several types of
windows:
• Blank windows, without controls.
• Windows created via RAD/RID.
• Internal windows. These windows can be used in
"Internal Window" controls.
• Windows based on a window template.
• Windows imported from a non-WINDEV
application.
This paragraph explains how to create blank
windows, internal windows or windows based on a
template. For more details, see the online help.

1.1 Creating blank windows
To create a blank window:
1. Click
in the quick access buttons. The
creation window appears: click "Window" then
"Window". The window creation wizard starts.
2. Choose the "Blank" type.
3. Select the window skin template.
4. Validate the window creation. A blank window
is created in the editor. The save window appears
automatically.

5. Specify the window title and name. The window
corresponds to a ".WDW" file. By default, this file
will be created in the main project directory. This
name will be used to handle the window.
6. Validate the window.
7. Create the controls in the window.
Remark: The main characteristics of the windows
are available in the online help. The different types
of controls are presented in Controls in practice.

1.2 Internal window
An internal window is a window without title bar
or status bar that will be directly included in the
other windows of your application via the "Internal
window" control.
This allows you to include a window (and its code)
in another window.
To create an internal window:
1. Click in the quick access buttons. The
creation window appears: click "Window" then
"Window". The window creation wizard starts.
2. Select the "Internal window" tab.
3. Select the type of window and the associated
skin template.
4. Validate. The save window appears
automatically.
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1.3 Window based on a template
WINDEV also allows you to create a window based
on a window template. In this case, simply select
the desired window template.
The window templates contain the graphic
elements and code common to all the windows in
the application.
To create a window based on a window template:
1. Click
in the quick access buttons. The
creation window appears: click "Window" then
"Window". The window creation wizard starts.

2. Select the "Based on a template" tab.
3. Select the desired template and the associated
skin template.
4. Validate. The save window appears
automatically.
The changes made in a window template are
automatically applied to all windows using this
template.
Window templates allow you to keep the style book
defined for an application.

2 Simple operations on a window from the editor
The window editor allows you to perform the
following actions on the windows:
• Open a window in the editor: All you have to do
is double-click the window name in the "Project
explorer" pane.
• Resize a window.

• Save and copy a window.
• Import and export a window.
• Change the tab order.
For more details, see the online help.

A window can include all types of controls. A
window can:
• be resizable: the end user will be able to change
the window size. Depending on the anchors
defined for each control, the position of the
controls can change when the window is resized
(see "Controls in practice", page 38).
• include a background image: this image is
displayed in the window background and the
controls will be positioned over the image. You
can also define the resize options via the 9-slice
scaling mode. For more details, see "Window
and image", page 22.
• be clipped: the window will have custom shapes
(window shaped like a circle, a computer, etc.).
For more details, see "Clipped window", page
24.
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Remark: To force an action on a window, simply
set a Button control of this window to "Automatic
execution" mode. For more details, see "Controls in
practice", page 38).

3.2 Description window
The description window includes several tabs that
group all the characteristics that can be configured
for the window.
Remark: You can also view and/or change the
characteristics of a window in the modifier. For
more details, see the online help.

3.3 Displaying the characteristics

3 Main characteristics of a window
3.1 Characteristics

• be automatically dimmed when it becomes
inaccessible. This feature is called DDW, which
stands for Dim Disabled Windows. For more
details, see "Dim disabled windows", page 25.
• allow drag and drop. For more details, see the
online help.
• allow end users to change the UI. For more
details, see the online help.

• include a drop-down menu: this menu allows
users to quickly access the main functionalities
of the application. To create a drop-down menu
in a window, go to the "Window" tab, "Bars and
menus" group, expand "Main menu" and select
"Add main menu". The first option appears in the
window. The options can be manipulated via the
context menu. Then, the menu options can be
handled programmatically. For more details, see
"Context menus", page 27.
• include a status bar: the status bar will display
the help message associated with the different
controls in the window. This bar can also be
used to display additional information. For more
details, see "The status bar", page 31.
• be multilingual: all the languages defined for
the window will be available for all its controls. A
window can be associated with more languages
than the project (windows shared between
several projects for example). For more details,
see "Multilingual applications", page 135.

To open the description window:
• double-click the window background.
• select "Description" in the context menu of the
window.
• select the window and press Alt + Enter.

3.4 Characteristics by tab
This section presents the different categories of the
characteristics displayed by each tab.
For more details on the options available in each
tab, see the online help.
General tab
The "General" tab allows you to specify the window
name and title.
UI tab
The "UI" tab allows you to define the parameters of
the window interface:
• visibility of the window,
• position of the window,
• right click, mouse cursor,
• association with a context menu, etc.
Details tab
The "Details" tab allows you to define the different
window settings:
• type of window
• UI modification by end user,
• animation,
• automatic closing.
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Image tab
This tab allows you to define:
• the window background image,
• the image of the sizing handle,
• the window icon.
Languages tab
This tab shows the languages supported by the
window as well as the language displayed in the
editor. You can add, change or remove languages.

Notes tab
The "Notes" tab allows you to describe the window.
This information will be printed in the technical
documentation of the project, window, etc..
Help tab
The "Help" tab allows you to associate a contextsensitive file with the window. This help file contains
the context-sensitive help pages displayed by each
control.
Style tab
The "Style" tab allows you to define the window
style:
• Show the title bar.
• Show icons.
• Show the status bar, etc.

4 Window and image
4.1 Overview
To customize the style of the windows in your
applications, WINDEV allows you to use:
• background colors. Several standard colors can
be used. The background color is configured in
the "Style" tab of the window description.
• images. These images are used as the window
background. The controls are displayed over the
image. The background image can be set in the
"Image" tab of the window.
Remark: To customize your windows, you can also
use a skin template or a window template.

4.2 Setting the background image
The settings are defined in the "Image" tab of the
window description.
You can set the background image by selecting a
file or by choosing an image from the image catalog.
The main image formats that can be displayed are:
BMP, JPEG, TIFF or GIF.
You can also drag the image from the file explorer
and drop it onto the WINDEV window.
The options available for the image are:
• Management of multilingual images.
• Display mode.
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•
•
•
•
•

Position.
Transparency.
Symmetry.
9-slice scaling.
Clipping the window according to the
background image.

Management of multilingual images
A different background image can be displayed
according to the program runtime language. The
display characteristics can be specific to each
language.
To define a multilingual background image:
1. Click the icon to the right of the background
image name.
2. Select the "Multilingual" option.
3. Choose the appropriate image for each
language defined in your window.
4. Validate. The "Multilingual Value" text appears
in the background image field.
Display mode
An image can be displayed in a window according
to several display modes. These display modes
produce different results:
• 100%: the image is displayed at 100% from the
upper-left corner of the Image control.
• 100% Centered: the image is displayed at 100%
and is centered in the Image control.
• Stretched: the image is stretched to occupy the
entire surface of the Image control.

• Tiled: the image is displayed at 100% and is
tiled in the Image control to occupy the entire
surface.
• Homothetic: the image is proportionally
enlarged to be entirely displayed in the Image
control.
• Homothetic centered: the image is homothetic
and is centered in the Image control.
• Homothetic extended: the image is
proportionally enlarged in order for the smallest
image side to be entirely displayed in the Image
control.
• Homothetic centered extended: the image is
extended and centered in the Image control.
• Homothetic without enlargement: if the image
can be entirely displayed in the window, it is
displayed at 100%. If the image is larger than
the window, it is automatically resized to be
displayed in its entirety.
• Homothetic centered without enlargement: the
image is centered without enlargement.
In homothetic mode, the "High-quality display (HQ)"
option allows improving the image quality when it is
reduced from its original size.
Position
This parameter sets the position of the upper-left
corner of the image, relative to the window area.
These options will be kept even if the image is
modified through programming (Image property).

Symmetry
The symmetry options are used to change the
orientation of the image in the image file. These
options will be kept even if the image is modified
through programming (Image property).
Initial image:

Vertical
symmetry

Horizontal
symmetry

Horizontal
and vertical
symmetry

9-slice scaling
If this option is selected, the 9-slice scaling mode
will be used on the background image of the
window.
The 9-slice scaling method consists in dividing the
background image into 9 areas.

Transparency
The transparency options for the background
image are as follows:
• Transparent magenta: The magenta color in
the image will be transparent when the image is
displayed in the editor or at runtime.
Transparency: none

Transparent magenta

• Top left pixel: all pixels with the same color
as the top left pixel of the image will be
transparent.
These options will be kept even if the image is
modified through programming (Image property).

For each area, you can define whether the section
of the image corresponding to the area must be
displayed or not: simply click the area to make
it visible or invisible. If the image section is not
displayed, it will be replaced by the background
color of the window or control.
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The margins are used to define the size of each
area. You have the ability to enter the values of the
different areas or to move the line corresponding to
the margin.
When resizing the window, only the areas 2, 4, 6, 8
and 5 are resized to occupy the entire space:

The 9-slice scaling method is used to manage the
behavior of each area when resizing the window.
For each area, the image will be enlarged:
• by repeating the image that constitutes the area
• by stretching the image that constitutes the area

4.3 Clipped window
WINDEV allows you to clip windows. The windows
will have custom shapes (window shaped like a
circle, a computer, etc.).
The window shape is defined by an image. In
this image, define the color that will be used to
define the transparent areas ("Light magenta" for
example). All these areas will be invisible when the
window is displayed at runtime: the window will be
clipped.
Caution: The image borders must be as sharp as
possible (no gradient, etc.) to avoid any unexpected
display effects when previewing or opening the
clipped window.
The window clipping is configured in the "Image"
tab of the description window.

WINDEV gives you the ability to open "popup"
windows.
A "popup" window is a small window that opens
above the current window. In most cases, this
window allows users to select a value. Then, it
returns the value selected by the user to the main
window. This window closes automatically when the
user clicks inside or outside the popup window.
For example:
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Your application opens several windows at the
same time and you don’t know which one to use ?
The inactive windows can be automatically
dimmed. This feature allows you to always know
which window to use.
This feature is called DDW, which stands for Dim
Disabled Windows.
For example:

Step 1: You change the customer information and
then click "Validate".

5 Opening a "popup" window
5.1 Overview

6 Dim disabled windows

Remark: The characteristics of a popup window are
as follows:
• by default, it appears below the control that
opens it (above or to the left if there is not
enough space below the control).
The initial position can be changed
programmatically.
• it closes automatically when it loses focus or
when Close is called.
• only the closing icon is displayed in the title bar
of the window (if the title bar was defined in the
style).

Step 2: A window prompts you to confirm or cancel
the changes. The main window (in the background)
has become unavailable. It is automatically
dimmed. You immediately identify the window that
must be used.
The DDW features are available for the entire
project or they can be customized for each window.
You can also set the DDW feature through
programming.
For more details, see the online help.

7 Internal window
Internal windows allow you to dynamically share the
same UI section in one or more applications.
The UI to be used multiple times is created in an
"Internal Window".

This UI can be used in the different windows of your
application via the "Internal Window" control.
Remark: The internal window can come from a
component.
For more details, see the online help.
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8 Window templates
WINDEV allows you to create window templates.
These templates contain the graphic elements
and code common to all the windows in your
application.
The changes made in a window template are
automatically applied to all windows using this
template.
Window templates allow you to keep the style book
defined for an application.
Using window templates in your applications allows
you to:
• create windows more easily.

10 Context menus
• set the layout of the windows.
• easily update the application style book.
A window template is as easy to create as a window.
To create a window from a template, select "Based
on a template".
By default, all changes made to the template are
applied to the windows that use it. However, it is
possible to define particular cases in a specific
window by overriding the template elements.
For more details, see the online help.

9 Events associated with windows
9.1 Events managed by default
WINDEV manages the following events by default
(in order of appearance in the code editor):
• Global declarations:
Declaration of variables global to the window.
• End of initialization:
Executed when opening the window, before the
code for gaining focus. The initialization event of
the window controls is executed after this code.
• Closing:
Executed when closing the window. Remark:
resuming the input in one of the window controls
in this code prevents the window from closing.
• Request for refreshing the display:
Used to group the code for updating the window
controls: content of controls, state (visible,
grayed out...), text to refresh, etc, ...
This event is started upon request by the
following functions:
• RequestRefreshUI: Executes the event at
the end of the current event (asynchronous
execution).
• ExecuteRefreshUI: Executes the event
immediately.
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• Set the Value property (internal windows only)
Executed when a value is assigned to the Value
property in the Internal Window control.
• Get the Value property (internal windows only)
Executed when the Value property is used in
read mode in the Internal Window control.

The user can open a context menu by pressing
the right mouse button. This menu allows users to
easily access the specific features of a window or
control.
WINDEV allows you to manage two types of context
menus:
• system context menus managed by Windows.
These context menus appear when the user
right-clicks on some types of controls (Edit
control, Table, etc.). For more details, see
"Default system context menu", page 28.
• custom context menus managed by WINDEV.
These menus are created in the window editor
and can be handled through programming.
WINDEV allows you to create custom context
menus and associate them with:
• one or more controls in a window.
• a window.

For example:

10.1 Context menu edit windows
WINDEV allows you to create and modify custom
context menus in a specific edit window. To better
understand how to manage custom context menus,
let’s take a look at the vocabulary related to this
edit window:

9.2 Optional events
Several optional events can be managed. Simply:
1. Click "Add other events to" at the bottom of the
list of events displayed in the code editor.
2. The optional events window appears.
3. Select the optional event(s) to add and validate.
4. The selected events are automatically added
after the default events.
You can manage, for example:
• gain and loss of focus,
• changes in one of the window controls,
• window size changes,
• mouse hover over the window,
• left mouse button down, up, double click,
• right mouse button down, up, double click,
• mouse wheel, etc.
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10.2 Available features
WINDEV allows you to:
• Create a custom context menu.
• Associate a custom context menu with one or
more elements (window or controls).
• Edit a custom context menu.
• Open the description window of a custom
context menu.
• Delete a custom context menu.

For more details on the translation of this menu,
see the online help.
• ActiveX control:

11 Main menus
11.1 Overview
A main menu is always associated with a window. In
WINDEV, this menu is displayed below the window
title bar. In most cases, the applications contain a
menu window. This window only contains a main
menu and is used to access the other windows of
the application.
For example:

For more details, see the online help.

10.3 Default system context menu
The following types of controls have a default
system context menu (displayed if no custom
context menu is associated with the control):
• Edit control:

11.2 Vocabulary associated with the main
menus
To easily handle a main menu, you must be familiar
with the following vocabulary:

For more details on the translation of this menu,
see the online help.
• table column:
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Remark: The system context menu displayed
depends on the ActiveX program associated with
the control.
This default context menu can be disabled from the
editor or in the code.
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11.3 Available features
WINDEV allows you to:
• Create a main menu.
• Edit a main menu.
• Delete a main menu.
For more details, see the online help.

Special case: Tool menu
WINDEV allows you to automatically insert a "tool"
menu ("?" type) in your application. On the "Window"
tab, in the group "Bars and menus", expand "Main
menu" and select "Add the "?" menu".

12 Menu options
12.1 Overview
A menu (main menu or context menu) includes one
or more options and sub-options. Each option runs
a WLanguage code.
In the editor, you can handle menu options in the
same way for both main menus and custom context
menus.
To handle the menu options, simply edit the
relevant menu.
To edit (or display in the editor):
• the main menu of a window:
• open the relevant window in WINDEV.
• select one of the menu options. The options
and the sub-options are automatically
displayed.
• the custom context menu of a window: on
the "Window" tab, in the "Bars and menus"
group, expand "Popup menus" and select
"<ContextMenuName>".

12.2 Handling menu options in the editor
The window editor allows you to easily perform the
following operations:
• Add a menu option.
• Add a separator.
• Add a submenu.
• Delete a menu option.
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The menu options can also be defined in the
window editor, and their characteristics can be
modified via a description window.
The description window of the menu options allows
you to:
• change the option caption.
• check or uncheck a menu option.
• associate an image with a menu option.
• associate a keyboard shortcut with a menu
option.
You also have the ability to associate a WLanguage
code with a menu option. Only menu options
without submenus can start a WLanguage process.
For more details, see the online help.

12.3 Handling menu options through programming
Options are handled in the same way in context
menus and main menus.
To handle a menu option programmatically, use the
following syntax:
• "<OptionName>" if the menu option is handled
from the window.
• "<WindowName>.<MenuName>.<OptionName>"
if the option is handled from another window.

13 The status bar
The status bar of a window can display:
• an information message linked to the current
control. This message can be entered in the
"Help" tab of the control description window.
The message will be displayed in the status bar
when the user selects the control.
• a specific information message. This message
is displayed through programming with
Message.
• a progress bar. This progress bar is displayed
through programming with ProgressBar.
To display different types of information
simultaneously, you can divide the status bar into
several cells ("Insert a cell" in the context menu of
the status bar).

13.1 Status bar description window
The description window of a status bar allows you
to:
• add and/or delete cells.
• change the order of the cells.
• specify the information that will be displayed for
each cell.
For more details, see the online help.

13.2 Type of cell in the status bar
The type of allows you to display:
• The progress bar. This progress bar will be run
when using ProgressBar.
• The help message associated with the control
that has focus. This help message is defined in
the "Help" tab of the control or in the code using
the Message property.
• The date of the current computer.

• The time of the current computer.
• The cursor position in the current Edit control
("Column and row of the caret" option).
• The status of the Caps Lock key that indicates
whether it is enabled or not.
• The status of the Insert key that indicates
whether it is enabled or not.
• The name of the current user in an application
that uses the User Groupware.
Two specific options are also available:
• Through programming: The information
displayed in the status bar is specified
programmatically (using Message for example).
• The update event: The "Whenever updating"
event is automatically associated with the cell
of the status bar. This event is run on a regular
basis. This event can contain the elements that
will be displayed in the cell, for example.

13.3 Characteristics of a cell in the status bar
The status bar description window also allows you
to define the display characteristics of the cells.
• The position of the cell in the status bar.
• The background image of the cell.
• The background color of the cell.
• The width of the cell.
• Whether the cell is editable.
• The anchors of the cell (its behavior when the
window is resized).
All these characteristics can be handled through
programming via the properties available for the
cells in the status bars.
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Different types of
standard controls

Contenu

Select a date.

WINDEV includes different types of controls. Let’s see how to use them according to the
operation to perform:

In order to...

Calendar

Use the following
control...

Display a text, a title, etc.
Static

Display an image (photo, etc.), an animation or use
drawing functions.
Image

Read a PDF file

PDF Reader

Display and edit a Word document.

Word Processing

Select a value from a list (Country, City, etc.)

Display the contents of a data file in a table (list of
customers, order details, etc.).

Radio Button, Combo Box,
List Box
Select multiple values from a list (message recipients,
etc.)

Table
Check Box, List Box

Select one or more values from a ListView (picture
directory, etc.)

Show the same controls multiple times in a window (e.g.
product catalog with images, etc.)
ListView

Looper

Select a value in a preset range.
Slider,
Round Slider,
Spin,
Range Slider
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Display a video or animation.

Group the controls by theme and display the themes one
by one.
Web Camera
Multimedia
Conference

Tab
Sidebar
Drawer

Enter information.
Edit control

Display a bar code.

Program an action in a window (display another window,
start a print job, etc.).

Bar Code
Button

Display information in a hierarchy (directory).

Display events over a period of time.
TreeView
TreeView Table
Organizer

Display a column chart, a line chart, a pie chart, etc, ...

Chart

Create statistical tables.

Pivot Table
Spreadsheet

Display a progress.

Progress Bar
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Smart
controls

Contenu

Represent weighted data.

TreeMap

Display important elements in a dashboard.

Smart controls are an innovative concept for creating UIs. A Smart controls is a ready-to-use
control (or group of controls) that includes a "business logic" WLanguage code where necessary.
Thanks to the Smart controls, you can add sophisticated behaviors to your WINDEV applications
with a single click.
WINDEV includes several Smart controls: Twitter, Instagram, Signature, Countdown, Date range
selection,
Menu with drawers, Workflow, Cookie consent, Process monitoring, and more.
To integrate a Smart control into your interfaces:
1. On the "Creation" tab, in the "Smart" group, click "Smart controls".
2. Select the desired control in the window that appears:

Dashboard

Display HTML data.
HTML Display control

Enter HTML data.

HTML Editor control

Select intervals or change zoom

Range Slider

Display a map or an itinerary.

Map
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Edit an image

Image editor

Display an ActiveX control

ActiveX
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You can:
• Browse through the different types of controls,
• Enter keywords in the search box.
Remark: The "Go" button that appears when hovering over the Smart controls allows you to see
and try the control before integrating it in your window.
3. Select the desired control, drag it and drop it onto the window editor.
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Controls in practice
WINDEV includes different types of controls that
can be easily used in your windows. These controls

2 Control characteristics
can be created via the "Creation" tab of the ribbon.
All controls can be handled through programming.

All the controls in the window editor include a
description window. This window has several tabs
that group the characteristics that can be set on
one or multiple controls.

1 Creating a control
1.1 Different types of window controls
The following controls are available in the WINDEV
window editor:
• Gantt Chart,
Edit control,
• TreeView Table,
Static,
• TreeView,
Button,
• Diagram Editor,
Image,
• Organization chart,
Image Editor,
• Progress Bar,
HTML Editor,
• Looper,
Radio Button,
• Multiline zone,
Check Box,
• Scrollbar,
List Box,
• Slider,
Combo Box,
• Spin,
ListView,
• TimeLine,
Sidebar,
• Tab,
Drawer,
• Ribbon,
Web Camera,
Conference control, • Internal Window
control,
OLE control,
•
Toolbar,
ActiveX,
•
Splitter,
Shape,
•
Chart,
Bar Code,
•
Map,
HTML Display
• Carousel,
control,
• Cube,
• Supercontrol,
• Widget,
• Organizer,
• Xaml,
• Scheduler,
• Calendar,
• Rating,
• Control template,
• Pivot Table,
• Layout control,
• Dashboard,
• Dockable panel,
• Table,
• PDF Reader.
• Spreadsheet,
• Word Processing,
All controls can be handled through programming.
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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For more details, see the online help about each
type of control, their main characteristics and their
programming in WLanguage.

1.2 Creating a new control
To create a control:
1. Select the type of control to create via the
corresponding icon in the "Creation" tab of the
WINDEV menu.
2. The shape of the new control appears under
the cursor.
3. Click where you want to create the control. The
control is automatically created.
Remark: Other creation modes are available. For
more details, see the online help.

1.3 Creating a control associated with an
item
All the controls in a window can be bound to a data
file item, EXCEPT the following:
• Button

• Timeline

• Shape

• Dashboard

• Tab

• Xaml

• Toolbar

• Carousel

• Map

• Cube

• Ribbon

• HTML Display
control

• Splitter

• Layout control

Remark: You can also view and/or change the
characteristics of one or more controls in the
modifier. For more details, see the online help.

2.1 Displaying the characteristics
To open a control description window:
• double-click the control.
• select "Description" in the context menu.
• select the control and press Alt + Enter.

Remarks:
• The description window can be displayed for a
set of selected controls. Only the characteristics
common to the selected controls will be
displayed.
• Several description windows can be opened
at the same time. Each description window
displays the characteristics of one or more
controls.

There are multiple methods to create a control that
is bound to an item:
• Drag and drop the item from the "Analysis" pane.
• Using the "File" tab of the control description
window.
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2.2 Characteristics by tab
This section presents the different categories of the
characteristics displayed by each tab.
General tab
The "General" tab allows you to specify the name
and all the display characteristics of the control
(text, input mask, etc.).
UI tab
The "UI" tab allows you to define the parameters of
the control interface:
• Initial state of the control when the window is
opened,
• Control visibility,
• Control size,
• Alignment, etc.
Details tab
The "Details" tab allows you to define the different
parameters of the control:
• input parameters,
• Drag and drop, etc.
The content of this tab depends on the type of the
current control.
Binding tab
This tab allows you to select the item (from a
data file or query) to which the control is bound.
Depending on the current record, the content of the
bound item will be displayed in the control.
The binding can be established to a single file or to
multiple files.
Content tab
This tab is available for the window controls only.
The "Content" tab allows you to define:
• the initial content of the control (for Edit controls
only).
• the data source used to populate the control (for
List Box, Combo Box, and Table controls only).
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Notes tab
The "Notes" tab allows you to describe the control
operating mode in detail. This information will be
included in the technical documentation (project
documentation, window documentation, etc.).
Help tab
The "Help" tab allows you to enter and set the types
of help systems associated with the control. A
control can have:
• A tooltip, displayed when the control is hovered
over by the mouse cursor.
• A help message, displayed in the status bar
when the control gains focus.
• A help window with a specific title, displayed
when pressing the F1 key.
A control can also be associated with a specific
help page from a CHM help file. This help page will
be displayed:
• as a context-sensitive help (tooltip displayed
upon request), if a help file was defined for the
window.
• as a help page. In this case, use WHelp to
display the help page.
Style tab
The "Style" tab allows you to define the style of the
different control elements. This tab lets you:
• Change the control aspect: simply select the
control element to be modified, and then choose
the style characteristics. Only the aspect of the
current control is modified.
• Apply an existing style to the control: simply
select the style to apply.
• Create or change a style: the created or modified
style is updated for all project controls that use
this style.

3 Handling controls in the editor
3.1 Control handles

3.2 Available operations

Handles appear around new or selected controls.
Handles allow you to:
• view the control size,
• change the control size.
The colors of the handles identify the actions that
can be performed:
• The black handles (different color depending on
the skin template used) allow you to distinguish
and resize the selected control.
• White handles are used in two cases:
• simple selection: the selected control is in
read-only mode. For example, these handles
may appear if the control is selected and its
description window is open. In this case, the
control cannot be directly modified or moved
in the editor.
• multiple selection: the selected control is part
of a multiple selection, but it is not the first
control selected.
This type of handles is also displayed when a
window is in read-only mode for the developer:
the controls cannot be modified.
• The gray handles indicate the first control
selected in a multiple selection. This control will
be the reference control.

The window editor allows you to:
• Select one or more controls (with the lasso for
example),
• Group selected controls,
• Move controls,
• Change the text of the controls,
• Show an advanced tooltip (when the cursor
hovers over the control) with: the control name,
position, size, anchors and initial state.
• Use a control outside the window. This control
will be visible in edit mode and invisible at
runtime.

Remark: You can use a control outside the
window to:
• associate it with the window without displaying it
at runtime. This allows you to use the content of
the control programmatically (like a variable).
• display new controls in a window when resizing
it.

4 Aligning controls
The alignment of controls allows you to create
"professional" and outstanding interfaces. The
following tools help you create standard interfaces
in WINDEV:
• rulers.
• grids.
• real-time interface checker (appears
automatically when positioning controls).
• advanced interface checker.
• alignment options.

4.1 Rulers
You can display alignment rulers in the window
editor.
These rulers have snap-on guides: any control that
comes close to a guide is automatically "snapped"
by it.
This feature allows you to easily position, align or
resize controls in a window.
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Displaying the rulers
To display the rulers, go to the "Display" tab, "Help
for edit" group and check "Rulers". Two types of
markers can be used:
• markers, which allow you to align and place
the controls inside the windows using the
associated guides.
• border markers, which allow you to obtain a
border of the same size on each side of the
window. A guide allows you to view the border
area.
Remark: To show or hide the window guides,
select "Show guides" in the context menu of the
rulers. Guides are always enabled even if they are
not visible: any control moved toward a marker is
automatically snapped by it.
Example in a window:

Handling markers
The markers can be easily handled with the mouse
in the editor. When a marker is hovered over by the
mouse, the cursor turns into a double arrow.

4.2 Snap-on grid
The snap-on grid is used to position vertical and
horizontal markers in the window. The created
controls are attracted to these markers, as if the
controls and the markers were magnetic. The snapon grid is used to align the controls according to the
markers.

4.3 Real-time interface checker
When a control is moved in a window, guides are
automatically displayed by the real-time interface
checker. The objects snap to the guides, allowing
you to align the moved control with the other
controls found in the window.

4.4 Advanced interface checker
The advanced interface checker is a tool used to
improve the layout of the controls in the different
windows of the application.
This interface checker also enables you to apply the
interface rules from the Windows standard to the
current window or to the selected controls: control
alignment, standardization of Button control sizes,
etc.

4.5 Alignment options
To align multiple controls, WINDEV includes:
• a preset alignment (available on the "Alignment"
or "Modification" tab, in the "Depth and
Alignment" group).
• a custom alignment (available on the
"Alignment" tab, in the "Other alignments"
group).

The custom alignment allows you to use specific
alignment properties. In the custom alignment, you
can define:
• the horizontal or vertical alignment: controls
can be aligned to the left from the beginning of
the control or from the input area. They can also
be aligned to the right according to the end of
the control or input area
• the even spacing: the spacing between controls
is adapted in order to be the same between
each control (horizontally or vertically).
• the size: the size of the selected controls
automatically adapts to obtain controls with the
same height and/or width.
• the reference control: to align and define the
size of the controls, the reference control can
be:
• the first selected control (the one with the
white handles).
• the last selected control.
• the largest selected control.
• the most top left selected control.

5 Control edit options in a window
The edit options allow you to set:
• the display options.
• the snap-to behavior of the controls.
• the clicks and double-clicks on the controls.
• the control selection options.
• the position of the window when it is opened.
These display options are used to customize
the operations performed on the controls in the
window editor.
To open these options, go to the "Display" tab and
click the dialog box launcher (
) in the "Options"
group.

42

Part 1: Main concepts

5.1 Making a control visible/invisible
To make a control visible/invisible in the window
editor:
1. Select the control in the editor.
2. On the "Modification" tab, in the "Help for edit"
group, check/uncheck "Visible (editor)".
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5.2 Locking/Unlocking a control

5.3 Framing (or not) a control

6.1 Anchoring a control in the editor

To lock/unlock a control in the window editor:
1. Select the control in the editor.
2. On the "Modification" tab, in the "Help for edit"
group, check/uncheck "Locked".
A locked control cannot be selected by clicking
and dragging over it. Let’s look at an example
with a Tab control. When you click and drag over
multiple controls in a tab pane, the Tab control is
not automatically selected.
All other operations can be performed on a locked
control.

To frame a control in the window editor:
1. Select the control in the editor.
2. On the "Modification" tab, in the "Help for edit"
group, check/uncheck "Framed".

To anchor a control:
1. Select the controls you want to anchor.
2. Define the control anchoring options:
• in the "UI" tab of the control description
window ("Description" in the context menu).
• via "Anchor" in the context menu of the
control (right click).
3. In the window that appears, select the type of
anchors to be applied. The most common options
are represented by different icons:

6 Anchoring controls
The windows of a WINDEV application can be
resized at runtime. With the anchoring mechanism,
controls are automatically resized and positioned
when the window is resized.
The anchors of a control include two settings:
• the type of anchor: defines the control behavior
based on the new window size. The control
can be moved to the left and/or down, or be
stretched horizontally or vertically, ...
• the anchor rate: defines how much a control
stretches or moves. This option allows you to:
• keep a control centered horizontally in the
window regardless of its size.
• proportionally enlarge some controls.
These settings can be defined:
• in the window editor.
• through programming with the WLanguage
properties.

Framing a control allows you to easily view all the
controls of a window (especially Image controls).

No anchors: The control does
not change when the window is
resized. No anchoring option is
selected.
Width: The control stretches to
the right when the window is
enlarged. Set the "width" anchor
rate to define how much a control
stretches relative to the window.
Right: The control moves to the
right when the window is enlarged.
Set the "right" anchor rate to define
how much the control moves.
Horizontally centered: The control
remains centered horizontally
regardless of the width of the
window.
Height: The control stretches
downward when the window is
vertically enlarged. Set the "height"
anchor rate to define how much
a control stretches relative to the
window.
Width and height: The control
stretches to the right and
downward when the window is
enlarged. Set the "width" and
"height" anchor rates to define how
much a control stretches relative to
the window.

Height and right: The control
stretches downward and moves
to the right when the window is
enlarged.
Set the "right" anchor rate to define
how much the control moves.
Set the "height" anchor rate
to define how much a control
stretches relative to the window.
Vertical distribution: This option
is available only when multiple
controls are selected. The selected
controls stretch downward and are
distributed proportionally when the
window is enlarged vertically.
Bottom: The control moves down
when the window is enlarged
downward. Set the "bottom" anchor
rate to define how much the control
moves.
Width and bottom: The control
stretches to the right and moves
downward when the window is
enlarged.
Set the "bottom" anchor rate
to define how much the control
moves.
Set the "width" anchor rate
to define how much a control
stretches relative to the window.
Right and bottom: The control
moves to the right and down when
the window is enlarged. Set the
"bottom" and "right" anchor rates
to define how much the control
moves.
Horizontally centered at bottom:
The control remains centered
horizontally regardless of the width
of the window. However, the control
is anchored to the bottom and
moves down when the window is
enlarged.
Set the "bottom" anchor rate
to define how much the control
moves.
Vertically centered: The control
remains centered vertically
regardless of the height of the
window.
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Horizontal distribution: This option
is available only when multiple
controls are selected. The selected
controls stretch to the right and are
distributed horizontally when the
window is enlarged.

6.2 Example for configuring the anchoring
of controls

7 Automatic button execution

The following example shows how controls are
anchored in a window.
Initial window:

To force an action on a window, simply set a Button
control of this window to "Automatic execution"
mode. The principle is very simple, if no button
has been used for a given period of time, the
click code of the Button control associated with
the "Automatic execution" will be automatically
executed.
At runtime, the duration is automatically
decremented. When it reaches zero, the code of
the Button control is automatically run.

Vertically centered to right: The
control remains centered vertically
regardless of the height of the
window.
However, the control is anchored to
the right and moves right when the
window is enlarged.

7.1 Implementation

Set the "right" anchor rate to define
how much the control moves.
Centered: The control remains
centered vertically and horizontally
regardless of the size of the
window.

Enlarged window:

4. Define (if necessary) the different anchor rates.
5. Validate. If the "Anchor" option is enabled
(on the "Display" tab, in the "Show (all controls)"
group), the anchor signs are automatically
displayed in the control (red arrows).

To run the code of a Button control automatically:
1. Define which Button control must be run
automatically.
2. In the window description ("Details" tab of the
description window), specify:
• the time before the automatic execution of
the Button control.
• the name of the Button control to be run.
3. At runtime, the remaining time is automatically
displayed.

7.2 Programming
You can also define an automatic validation Button
control using DelayBeforeClosing.

7.3 AAF: Automatic Application Feature
This feature is also directly accessible to the end
users. They can request a Button control to be
automatically run after a specific duration.

To obtain this result:
1. Select the [<-] and [->] Button controls: center
these controls vertically and horizontally (
).
2. Select the two List Box controls: anchor these
controls to the right, horizontally and vertically
(check the "right", "width" and "height" options).
3. Select the three Button controls: these controls
must stretch to the right proportionally (
).
Remark: The anchors of the controls can be set
programmatically using different WLanguage
properties.
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Control
templates
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Reports
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WINDEV allows you to create control templates. A control template is a set of controls that can be
reused in several windows.
The changes made in a control template are automatically applied to all windows using this
template.
A control template is used to:
• group a set of controls for a specific purpose.
• make the controls independent of the host window.

A report provides a custom view of data: data entered in the database, data in a text file, data
from a Table control, etc, ...
Reports can be displayed on the screen, saved in an HTML file, printed, etc.

View of a control template.
The template is bordered by an orange line in the editor.

A report can be used to summarize and synthesize data.
You can:
• group data.
• sort data based on different criteria.
• perform calculations (means, statistics) or even create charts.
The diagram below illustrates the concept of reports:
• the data to print comes from a data source (data file described in an analysis, HFSQL view,
query, memory area or text file).
• the report groups, sorts and formats the data.
• the report can be represented on the screen, as an HTML file, as an RTF file, ... or sent to the
printer.

Template used in a window.
The elements belonging to the template are bordered
by a blue line and identified by a yellow square.

To create a window based on a control template, create a "Control template" control.
Remark: The programming associated with the template elements can be performed in the
template directly.
The characteristics of the elements can be dissociated from the template. For example, dissociate
the position of a control from the template to move it elsewhere while keeping other changes
(code, style, etc.). This is referred to as control inheritance. In this case, the elements are identified
by a blue square.
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templates
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Most organizations use a standardized appearance and layout for their print jobs: date in the
upper-right corner in a specific format, page footer with print time and file name, logo in the upperleft corner, etc.
The report templates are used to easily standardize the layout of your reports.

View of a report template in the report editor.

Template used in different reports.
The elements that belong to the template are identified by a yellow square.
Overridden template elements are identified by a blue square.

A report template can be created:
• via the
icon in the quick access buttons. In the window for creating a new element, click on
"Report" then "Report template".
• from the current report (on the "Home" tab, in the "General" group, expand "Save" and select
"Save as a template").
To create a report based on a template, select the template that will be used when creating the
report.
The characteristics of the elements can be dissociated from the template. For example, dissociate
the position of a control from the template to move it elsewhere while keeping other changes
(code, style, etc.). This is referred to as inheritance. In this case, the elements are identified by a
blue square.
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To handle a project, WINDEV proposes several editors:
• project editor.

• data model editor.

• query editor.

• window editor.

• report editor.

• UML editor.

• ...
These editors are used to easily handle the different project elements.

Report editor

Data model editor

Project editor
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User-friendly editors in practice
1 Introduction
WINDEV is built around a set of editors operating in
a single environment and adapted to the developer
requirements:
• project editor.
• data model editor.
• UML editor.
• query editor.
• window editor.
• report editor.

• code editor, debugger and compiler.
• help editor.
• modeling editor.
• document editor.
• image editor.
These editors allow you to create the different
elements (windows, reports, databases, programs,
...) handled by the application.

The project editor allows you to:
• quickly view all the elements of a project.
• know the status of the project:
• necessary updates (window models,
components, etc.),
• elements from SCM (Source Code Manager)...
Let’s see some characteristics of the project editor:
• Managing the project via a dashboard.
• Interaction between the different panes and the
project elements.

2.2 Data model editor
The data model editor is used to describe the
characteristics and the structure of data files.
The data model editor supports the Merise method
(CDM and LDM).
The data model editor allows two types of database
descriptions:
• direct description of analysis linked to the
project (also called Logical Data Model (LDM))
• description of the Conceptual Data Model (CDM)
then automatic generation of the analysis.
Let’s see some characteristics of the data model
editor:
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Let’s see some characteristics of the UML editor:
• Creation and description of UML diagrams.
• Automatic formatting of links.
• Automatic generation of a class (or set of
classes) from a class diagram.
• Zoom in the UML editor.
• Insertion of comments into a UML model.
• Interaction between the different panes and the
elements of the UML model.

2.4 Query editor

2 The different editors
2.1 Project editor

The UML editor is mainly used to:
• describe one or more UML diagrams.
• build a UML model by reverse engineering of
your project.
For more details on how to create a UML model,
see "UML models", page 120.

• WYSIWYG editor ("What You See Is What You
Get"). You can directly view all the data files and
the links of your project.
• Creation and description of the data files and
their items.
• Automatic formatting of analysis links.
• Information about the links via tooltips.
• Simplified retrieval of the description of an
external database (SQL Server, Oracle, ...).
• Description independent of data files.
• Encryption of data files.
• Automatic modification of data files when
modifying the structure of files.
• Check of referential integrity.
• Automatic analysis generation.
• Zoom in the data model editor.
• Insertion of comments into the analysis graph.
• Interaction between the different panes and the
analysis elements.

2.3 UML editor
The UML language is a graphical language allowing
you to:
• represent the information system studied as
objects.
• generate the object structure of the application
(skeleton of application as object classes)
corresponding to the information system
studied.

The query editor is used to automatically create
queries on the data files. Programming is simplified:
windows, Table or Combo Box controls, reports, ...
can be based on queries.
A wizard helps you create queries: choose the items
to include and type the selection conditions via
the wizard. The query is automatically generated
(in optimized SQL code) and the query test can be
immediately run.
Let’s see some characteristics of the query editor:
• WYSIWYG editor ("What You See Is What You
Get"). You can directly view the query and its
result.
• Simplified query creation via a wizard.
• Automatic generation of SQL code of each query.
• Ability to immediately run the test of queries.
• Zoom in the query editor.
For more details, see the online help about the
query editor.

2.5 Window editor
The window editor is used to describe the
characteristics of the user interface for your
project.
Several skin templates (style sheet associated with
the window) and types of windows are proposed.
They help you make your windows more ergonomic
and make your applications more user friendly.
For more details on how to create a window, see
"Windows in practice", page 19.
Let’s see some characteristics of the window
editor:
• WYSIWYG editor ("What You See Is What You
Get"). Ability to directly view your window as it
will appear to the user.
• Creation and description of windows and
controls.
• Drag and Drop to copy, paste or move controls
from a window to another one.
• Skin templates of windows and preset control
styles
• Presence of several icon catalogs used to
associate images with controls.
• Real-time interface checker to simplify the
positioning of controls.
• Anchoring of controls in the window.
• Ability to type the captions of controls in the
work area of the editor.
• Management of context-sensitive help in the
windows.
• Zoom in the window editor.
• Interaction between the different panes and the
editor elements.

2.6 Report editor
The report editor is used to easily create printed
reports.
Let’s see some characteristics of the report editor:
• WYSIWYG editor ("What You See Is What You
Get"). You have the ability to view the reports as
they will be printed.
• Simplified report creation without writing a
single code line.
• Drag and Drop to copy, paste or move controls
from a report to another one.
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• Skin templates of reports and preset control
styles.
• Real-time interface checker to simplify the
positioning of controls.
• Use of a form in a report background.
• Creation of multi-column labels.
• Ability to edit a report in HTML format (to publish
it on Internet for example) or in RTF (to use it in
a word processing software for example).
• Zoom in the report editor.
For more details, see the online help about the
report editor.

2.7 Code editor
The code editor allows you to write all processes/
events in WLanguage (the programming language
included in WINDEV). For example, it allows you to
enter the source code of the following elements:
• controls,
• windows,
• reports,
• local and global procedures,
• classes and methods, etc.
Let’s see some characteristics of the code editor:
• Automatic formatting of information typed.
• Automatic completion.
• Glossary of functions.
• Immediate detection of typos and help for
correction.
• Incremental compilation.
• View of the different WLanguage events
associated with a window, control or report in
the project.
• Insertion of WLanguage events specific to the
use of the mouse or keyboard.
• Management of the code modification history
with ability to rollback.
• Ability to open several code windows (to perform
code comparisons for example).

• Zoom in the code editor.
• Interaction between the different panes and the
editor elements.
For more details, see the online help about the
code editor.

2.8 Help editor
The help editor is used to create a set of help pages
("CHM" file) that documents your project.
A help page is created for each window found in
your project. These pages are used to describe the
different operations that can be performed by the
users.
Let’s see some characteristics of help editor:
• WYSIWYG editor ("What You See Is What You
Get"). Ability to directly view the help pages of
your project.
• Compilation of help pages and creation of a
CHM.
• Creation of index and summary.
• Insertion of images.
• Insertion of links between the help pages.
• Ability to display the titles of pages in a bar.
• Zoom in the help editor.

Project
dashboard

Contenu

The project dashboard is an essential element for managing WINDEV Mobile projects. The project
dashboard gives an overall view of the progress of a project.
The project dashboard includes several indicators about the project content:
• statistics about the project,
• incidents,
• tasks,
• status of automated tests,
• result of different audits,
• list of elements checked out from the SCM (Source Code Manager),
• result of action planes (continuous integration), ...

2.9 Image editor
The image editor allows you to edit the images and
icons of the project and its elements.
Let’s see some characteristics of the image editor:
• Crop.
• Resize.
• Symmetry, rotation.
• Text.
• Layers.
• Access to image catalog.
• Transparency.

The elements found in this dashboard are presented in widget format. These widgets can be
configured, moved, enabled, disabled, ... You have the ability to add new indicators.
The dashboard configuration is saved for each user. The dashboard configuration is the same for
all projects that belong to the same user.
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WINDEV/WEBDEV/WINDEV
Mobile: 100% compatible

Project
configuration

Contenu

Contenu

The created projects are often multi-target projects.
For example, for an ERP system intended to operate in Windows, it is very likely that beside the
main application, which will be the backbone of the solution, there will be sales people equipped
with PDAs or Smartphones, stores that will use mobile devices to manage inventories and that
Intranet and Internet sites will be implemented.

Project configurations are used to create several "targets" from the same project.
From the same project, you can create:
• executables with different elements, names, etc.
• different components.
• Webservices.
• .Net assemblies.

All elements, excluding the UI (pages and windows), are 100% compatible and sharable between
WINDEV, WEBDEV and WINDEV Mobile projects.

WINDEV project

It is thus possible to share sets of procedures or classes, for example, between several projects.
Regardless of the product used to create a project, it can be opened by the other products.
When a project is opened in a product other than the one
that was used to create it, a wizard is displayed, allowing
you to create a project configuration specific to the product
used.
For example, if a WINDEV project is opened by WEBDEV,
you will have the ability to create a project configuration
named "Site", used to group all the elements required by the
WEBDEV site.
You can now view the elements of each target from each
environment. A project in WINDEV displays the thumbnails of
WEBDEV pages and WINDEV Mobile windows, for example.
Clicking a WEBDEV page from the WINDEV project editor
opens the WEBDEV page (WEBDEV must be installed on the
computer).

Project configurations

Config 1.
WINDEV
executable

Config 2.
DotNet
assembly

Config 3.
Component

Config 4.
Java archive

Config 5.
Web service

The multiple generation allows you to generate all project configurations (or some of them) in a
single operation.

Remark: If you own WINDEV and WINDEV Mobile, you can handle WINDEV Mobile configurations
in WINDEV. You can open, modify and test mobile windows.
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Multiple
generation

Custom-Folders: Organize
your project
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Project configurations are used to easily define the different "Targets" of your project. Several
executables, several components and several libraries can be defined for the same project.

All elements included in a project are listed in the "Project explorer" pane. By default, the elements
are organized according to their type: windows, reports, classes, etc.
In large projects, it is often more practical to group the elements that relate to the same feature:
stock management or order management for example.
To do so, create the "Custom-Folders" in the tree structure of the "Project explorer" pane and drag
the different elements onto these folders.
Some elements can be common to several "Custom-Folders".
It makes it easier to work on part of the application.

To generate the result of each configuration, you can select each configuration one by one and
generate the corresponding program.
There is a faster method: the multiple generation. The configurations to generate are selected in
a single operation and the result is immediate.

To start a multiple generation, go to the "Project" tab, "Generation" group and click "Multiple
generation".

Remark: WINDEV also allows you to create internal components to organize your projects and
share sets of elements between different projects.
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Source Code Manager
(SCM)

Contenu

Operating mode of Source Code Manager
The following example presents the Source Code Manager:

Overview

Local Computer 1

To simplify teamwork, WINDEV includes a Source Code Manager.
This Source Code Manager allows several developers to work together on the same project at the
same time and to share elements between several projects.

Network
(intranet)

3

Project A
Version 1

Project A
Version 1

Modification
Project A
Version 2

Project A
Version 2

Check-in 10:41

4
5

Check-out 14:28

Project A
Version 2

Project A
Version 3

Repository

Mobile Computer
Check out Beta window from
Project A Version 1 at 9:13

Offline

Mobile Computer

SCM
The elements found in the SCM can be shared:
• via network,
• via Internet,
• via PCSCloud (paid turnkey solution, on a dedicated server),
• via SCMDrive (paid turnkey solution, on a shared server).
• in offline mode. In this case, the elements that require specific attention will be checked out
from SCM when the laptop is connected to the main system for example.

Check-out 9:57

Local Computer 2

ADSL
(internet)

A repository groups the project elements, each computer
has a local copy of elements required for development

2

6

Project A
Version 1

1

Check-out 9:57

Local Computer 2
Check out Alpha window from
Project A Version 2 at 14:28

Modification
for end users
Project A
Version 3

Local Computer 1
Check out Alpha window from
Project A Version 1 at 9:57
Check in modified Alpha window
into Project A Version 2 at 10:41

Check-in 18:32

7

Mobile Computer
Check in modified Beta window
into Project A Version 3 at 18:32

If a project element (window, report, ...) is checked out, this element cannot be checked out twice.
Once the checked out elements are modified, these elements must be checked back in so that
these modifications can be taken into account by the source project. The repository stores a
history of all the project elements since their creation.
Whenever an element is checked back in, the version number of the source project is incremented
by 1.
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Sharing a project in practice
The development of a large IS system requires
the participation of multiple developers. These
developers must work on a single WINDEV project
while sharing different resources (queries, classes,
etc.).

To share a project, you can use the Source Code
Manager.

To benefit from the modifications performed, the
other developers must synchronize their local
project with the reference project (found in the
repository).

1 Source Code Manager
1.1 Overview

1.2 Principle

WINDEV boasts innovative features for teamwork
management in the Source Code Manager (also
called SCM).
The Source Code Manager (SCM), which is fully
integrated in the environment, is used to:
• make teamwork easier and faster,
• store the history of modifications and versions,
• save the sources of the development team
automatically.
Designed for teams between 1 and 100
developers, the SCM promotes and standardizes
the collaboration between developers (even when
developing alone, the SCM is useful because it
contains the history of your applications).

Setup

The SCM uses a repository: procedures, classes,
pages, reports, components, analyses, etc.
You can choose between a repository:
• in HFSQL Client/Server mode:
• installed on a custom server,
• available via a PCSCloud (paid turnkey
solution, on a dedicated server) platform,
• available via SCMDrive (paid turnkey solution,
on a shared server).
• in HFSQL Classic mode (installed locally or in a
shared directory).
The SCM can be run locally or remotely, via Internet
or via an HTTP or HTTPS connection. This feature
enables you to work on a project from your office
or from a remote site without losing any changes.
The SCM can also be used in offline mode.
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Tips
The sources of your applications are essential.
These sources must be handled with great care!
Tips for configuring the server that will host your
sources:
• Use a dedicated server with a disk with enough
space (at least 200 GB)
• Use the Source Code Manager (SCM) in Client/
Server mode.
• The hard disks may encounter physical
problems: use a RAID I system on your server
(several disks that store the same information)
• Use a UPS to protect the power supply of your
server.
• Make backup copies of the repository on a
regular basis (at least once a week)
• Place the server in a "secure" area and use a
firewall.

2 Creating a repository for the SCM
All project elements are saved in the repository
(on the server). This operation is performed when
creating the project or when importing an existing
project into the Source Code Manager.
Each developer who uses the Source Code
Manager retrieves a local copy of the project.
Use
To work on a project element (window, page,
report, etc.), the developer must check out the
element from the repository, modify it and check
the element back in.
If the element is already checked out, the
developer can ask the person who performed the
check-out to check the element back in (via the
messaging software).

2.1 Overview
To share a project via the Source Code Manager, a
repository must be created. This repository must be
created once only on the server.
The operating system and file system on which the
repository is installed must support files exceeding
4 GB.
The repository can be created:
• via SCMDrive, a "turnkey" solution
(recommended). In this case, a shared server is
used. This paid solution simplifies all the SCM
server setup operations.
• via PCSCloud, a "turnkey" solution. In this case,
a dedicated server is used. This paid solution
simplifies all the SCM server setup operations.
You will use a platform adapted to your needs.
• on an HFSQL Client/Server server: the repository
will be in HFSQL Client/Server format. In this
case, you must specify:
• the server,
• the database,
• the port used,
• the name and password of an HFSQL
database administrator.

• locally, in a shared directory on the network:
all the SCM users must have full rights on this
directory. The repository will be in HFSQL Classic
format.
Simply specify the network directory where the
repository will be created.

2.2 When to create a repository?
The repository must be created only once.
WINDEV allows you to create this repository at
different times:
• when installing WINDEV.
• when creating a project that uses the SCM.
• when importing a project into the Source Code
Manager.
• in the SCM administrator directly.
Once the repository is created, all the WINDEV
projects to share can be imported into this
repository.

2.3 Backups
We advise you to make backup copies of the
repository on a regular basis. These backups can
be performed via the SCM administrator.

Part 2: Development environment

65

3 Configuring the project to work with the SCM
Some operations are required before an existing
project can be used by the Source Code Manager.

3.1 Adding a project to the SCM
To add a local project to the SCM:
1. Open your project in WINDEV.
2. On the "SCM" tab, in the "Add project" group,
click "Add project to SCM".
3. In the wizard, select the repository to be used:
• A new repository. In this case, select the type
of repository you want to create (SCMDrive or
PCSCloud, Client/Server or local repository).
Provide the required information according to
the chosen option.

• An existing repository. Simply select the
desired repository.
4. Validate the wizard. The project is added to the
SCM.

3.2 Sharing resources
A first project was imported into the Source Code
Manager. This project contains elements shared
with other projects (classes, windows, procedures,
style sheets, analysis, etc.).
Sharing is an important concept of the SCM. There
are several methods to share resources. For more
details, see the online help.

4 Working with the SCM
4.1 Project options related to the SCM
Several options are available to configure a project
handled by the Source Code Manager. These
options can be found in the "SCM" tab of the
project description ("Project" tab, "Description").
These options are checked by default.
• Propose to get the latest version of the
elements when the project is opened:
When opening a project located in the SCM, this
option prompts you to get the latest version of
the project elements.
By default, the latest version of the elements is
automatically retrieved.
• Propose to check in the elements when the
project is closed:
When the project is closed, this option displays a
list of the checked out elements to check some
or all of them back in.
By default, when the project is closed, the
checked out elements are not checked back in.
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• Check out/Check in the project automatically:
This option is used to automatically manage
the "project file". If this option is checked, the
project file is checked out only if the action
performed requires it. Once the actions have
been completed in the project, the project file is
automatically checked back in.
This option disables the "Master/Guest"
management on the project. This option can
also be enabled on the "SCM" tab, in the
"Project" group, by expanding "Master/Guest"
and selecting "Manage project check-out
automatically".

4.2 Checking out an element
The different check-out modes
The SCM includes two modes to check out the
project elements:
• the standard mode: if you open an element
that has not been checked out from the SCM,
a panel indicates that the element must be
checked out to modify it. The element can be
checked out immediately (check-out button
found in the dialog box).

• the automatic mode: if you try to modify an
element that has not yet been checked out, the
SCM automatically prompts you to check it out.
Once the check-out is validated, the element can
be modified.
Remark: this mode is not recommended when
using the SCM with a slow Internet connection.
To change the check-out mode:
1. On the "Home" tab, in the "Environment" group,
expand "Options" and select "General options of
WINDEV".
2. In the "General" tab, the "Check out elements
during the first modification" option allows you to
switch all subsequent projects to automatic mode.
Opening a project element to change
its characteristics
To change the characteristics of a project element
included in the SCM:
1. Check out the element from the Source Code
Manager.
2. Select the check-out mode for the element. The
check-out mode can be:
• exclusive: nobody can check out this element
until it is checked back in. The element can
be checked out for tests only.
• for test: the element can be modified but the
modifications will not be checked back in.
• multiple: the element can also be checked
out by other users. In this case, the
differences between the different element
versions can be viewed when the element is
checked back in.
3. Validate. The element is opened. The title bar
indicates that the element is checked out.

4.3 Checking an element back in
The elements checked out from the Source Code
Manager are bordered by a red line in the project
editor.
To check in an element, go to the "Project explorer"
pane and select "Check in" in the context menu of
the element.

A screen allows you to perform the following actions
before checking the element back in:
• view the changes made.
• compare the element in the repository with the
local (checked out) element.
• access the element history in the repository.
You can check in the changes made to the element
while keeping the element checked out ("Keep
element checked out" option).

4.4 Project management modes
Two management modes are available with the
SCM:
• Managing the project in Master/Guest mode.
• Managing the project in automatic mode (by
default).
Master and guest
The Source Code Manager distinguishes between
2 types of users:
• the master: the master is the user who initially
stored the project in the Source Code Manager.
• the guests: the guests are the developers
who handle the project from the Source Code
Manager.
There is no need to be connected in master mode
on a project. The "Master" mode is only required to:
• change the project characteristics and check
these changes back into the repository.
• check in all the elements to create the
executable and the setup program of the
application.
To switch from master mode to guest mode, go
to the "SCM" tab, "Project" group, expand "Master/
Guest" and select "Become guest on the project
(and check all in)".
In this case, the Source Code Manager allows
you to check in all the elements of the project
(including the .WDP file).
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To switch from guest mode to master mode, go
to the "SCM" tab, "Project" group, expand "Master/
Guest" and select "Become master on the project".
Caution: Changing the project options:
All the users of the project (master or guests) can
change the project characteristics (first window of
the project, animations, code style, etc.). However,
only the project master will be able to check these
changes back into the Source Code Manager.
The changes made by a guest will be lost when the
project is updated from the repository.

Automatic mode
With the automatic mode, the project file is
checked out only if the action performed requires
it (regardless of the user). Once the actions have
been completed in the project, the project file is
automatically checked back in.
With the automatic mode, you do not need to
manage the "Master/Guest" mode in the project.

Internal
component

Contenu

An internal component is a set of elements from a project. This set is used to:
• Organize a project: you have the ability to create internal components in order to group the
project elements, by feature for example.
• Share the elements between several projects, via the SCM.

SCM

5 Working in offline mode with the SCM
The Source Code Manager allows you to easily
work in offline mode.
For example, this mode allows a developer who
works on a laptop to continue working on a project
located in the repository while offline.
The principle is simple:
• before disconnecting, go to the "SCM" tab,
"Other actions" group, expand "Remote work"
and select "Disconnect to work offline". Before
working offline, it is recommended to check out

the different elements you will work on (these
elements will appear as "already checked out"
for the other users). Then, you can work on your
project locally. You can handle the different
elements in the project directly.
• on reconnection, on the "SCM" tab, in the
"Other actions" group, expand "Remote work"
and select "Reconnect and synchronize". Then,
simply check the modified elements back in.
For more details, see the online help.

Project 1

1

Create the
internal component
Windows
Classes

6 SCM administrator
The SCM administrator is used to directly handle
the different projects included in the source code
manager.
It allows you to:
• manage repositories (create or connect to a
repository).
• manage branches.
• manage files and directories located in a project
in the repository (add, delete, rename files and
directories).

• manage the different files of the repository
(check-out, check-in, share, etc.).
• start some tools (options, maintenance, etc.).
• restore a project version.
• see the history and differences in the versions.
• undo check-outs (in administrator mode).
• clear, save, restore a repository, etc.
• add different types of files to the repository
(.doc, .xls, .pdf, etc.).

Project 2

2

Share the
internal component
via the SCM

Queries

Subdirectory of
<MyComponent>
project

WCI file
(List of elements)

The elements found in an internal component can be private or public:
• Private elements can be handled by the other elements of the component.
• Public elements can be handled by the elements of the project that uses the internal
component.
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Internal component in practice
1 Overview
An internal component is a set of elements from a
project. This set is used to:
• Organize a project: the internal components
can be used to group the project elements, by
feature for example.
• Share the elements among several projects:
The elements found in an internal component
can be shared between several projects via the
SCM.
One of the advantages of an internal component
compared to an external component is that it can
be debugged directly from the project that uses it.

Difference with an external component: An internal
component allows you to include all the component
elements in the interface of the project containing
the internal component. All the "public" elements
of the internal component can be handled in the
editor directly.
When using an external component, the "public"
elements of component cannot be handled
directly. To modify the external component, the
corresponding project must be opened.

• Use a specific analysis: The internal
component accesses its own data files. The
internal component and the project use
different runtime contexts.
This mode corresponds to the default mode if
the component uses an analysis.
In this case, the analysis used by the internal
component must be specified. You also have
the ability to create a new analysis directly.
This analysis will be associated with the
internal component.
6. Validate the creation of internal component. At
any moment, it is possible to:
• Modify the characteristics of the internal
component via its description window.
• Handle the internal component and its
elements.
Tip: An internal component contains no code for
declaring the global variables. A set of procedures
can be used to initialize the internal component.

2.2 Internal component and analysis: case
of total autonomy
An internal component can be linked to its own
analysis. In this case, the project that is hosting the
internal component can have several analyses:
• the analysis of the project.
• the analysis of internal components. This
analysis is defined when creating the internal
component. It can also be selected from the
internal component description window.
The elements generated by RAD for the internal
component will be generated in the directory of
internal component. If the analysis of the internal
component is modified, a new generation by RAD
will automatically propose to generate the elements
corresponding to the modifications.

2 Creating an internal component
2.1 The different steps
To create an internal component:
1. On the "Project" tab, in the "Project
configuration" group, expand "New configuration"
and select "Internal component". The internal
component creation wizard starts.
2. Specify the characteristics of the internal
component:
• its name. The name of the internal
component will be used for the WCI file
corresponding to the internal component
description. This name will also be used
to create a subdirectory in your project
containing all the elements of internal
component.
• its caption.
• its description.
3. Indicate the elements that will be included in
the internal component. An internal component
can contain all types of elements found in a
project: windows, reports, templates, sets of
procedures, ...
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3 Sharing internal components (via SCM)
4. Specify the elements of internal component
that will be directly accessible in the code and in
the preset actions of project that is hosting the
internal component.
Remark: The accessible elements (or "public"
elements) will be automatically proposed by the
completion. They can be used by the elements
found in the project or from another internal
component. The inaccessible elements (or
"private" elements) can only be used by another
element of internal component (the completion
will propose these "private" elements only from
the elements of an internal component).
5. Specify the management mode of data and
runtime contexts. Three modes are available to
manage data and runtime contexts:
• Use the project analysis or no analysis (full
share): The internal component accesses
the data files of the project. The internal
component and the project use the same
runtime contexts.
This is the default mode if the internal
component does not use an analysis.
• Use the project analysis with different
runtime context (advanced mode): The
internal component accesses the data files of
the project. The internal component and the
project use different runtime contexts.
This mode is reserved to specific cases.

The internal components can be shared between
projects via the SCM.
To share an internal component via the SCM, the
project containing the internal component must be
found in the SCM.

You can:
• create the internal component from a project
found in SCM. The internal component will be
automatically found in the SCM.
• import a project containing one or more internal
components into SCM. The internal components
will be automatically included in the SCM.
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component

External component in practice

Contenu

An external component is a set of WINDEV elements: windows, reports, analysis... This set of
elements performs a specific operation. For example, an external component can correspond to
one of the following features:
• Sending SMSs,
• Sending emails,
• ...
A WINDEV external component can be distributed to other WINDEV developers (freely or not).
These developers will be able to easily include the feature proposed by the external component in
their application. The external component will be included in the application and distributed with
the application.

WINDEV project

1

Develop the
component

2

Generate the
component

.WDK file
Created in the EXE directory

3
WINDEV project

4
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Import the
component

WINDEV project

4

Use the
component

WINDEV project

4

Use the
component

1 Overview
1.1 Definition
An external component is a set of WINDEV
elements: windows, reports, analysis, ... This set
of elements performs a specific operation. For
example, an external component can correspond
to one of the following features:
• Sending faxes
• Sending emails, ...
Remarks:
• To optimize the organization of your projects,
you have the ability to use internal components.
For more details, see "Internal component in
practice", page 70.
• In this chapter, we will refer to "external
component" as "component".
An external component can be distributed to
other WINDEV developers (freely or not). These
developers will be able to easily include the feature
proposed by the component in their application.
The component will be included in the application
and distributed with the application.
When creating the component, the author
specifies:
• the origin of the component elements. The
developer can build a component from a
WINDEV project linked to a WEBDEV project
and/or to a WINDEV Mobile project.
• the component elements visible (or not) to
the component user. Visible elements will be
accessible in the "Project explorer" pane or
through programming.
• the mode for using the component (how to
use the component, the parameters used
to access the component features, ...). A
short documentation (to be completed) is
automatically generated and associated with the
component.
Remark: Several examples of components are
supplied with WINDEV. These components are
accessible from the WINDEV home page ("Open an
example" option).

1.2 What is an external component made
of?
A component is defined and generated from an
existing WINDEV project. Then, it can be included
in other WINDEV projects.
All component elements are independent of the
project in which the component is included. The
component can have its own analysis, windows,
reports, data files, ... When creating the component
generation, all you have to do is specify whether
these elements can be handled (or not) in the
WINDEV project that includes this component.
The component includes three files:
• <ComponentName>.WDK:
Component file. Contains all component
elements.
This file is required to include the component in
a project.
This file must also be provided in the setup
procedure of the application that uses the
component.
• <ComponentName>.WDI:
Component description (when developing
applications only).
This file is required to include the component in
a project.
This file must not be provided in the setup
procedure of the application that uses the
component.
• <Component Name>.WDO (optional file):
Optional file
Text file containing the list of additional
elements provided with the component (data
files, .INI files, etc.). See "WDO file", page 78.
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1.3 What is an external component made
of?
A component contains:
• the elements to be distributed (windows,
reports, etc.). These elements can be accessible
(or not) when importing the component into a
WINDEV project.
• a short component description.
• a help allowing this component to be reused.
This help is generated from the code comments.

Remark: By default, if a component uses an
analysis, data files, ... the WLanguage functions for
HFSQL management will handle these elements in
an independent context. These parameters can be
modified in the advanced component options. For
more details, see the online help.

2 Creating and generating an external component
A component must be created from a project
containing all elements required for the component
to operate. Therefore, we recommend that you use
a specific project to create each component.

The component creation is performed in several
steps:
1. Developing the component elements.
2. Creating the component.
3. Defining the advanced component options.
4. Generating the component.
The component can then be distributed and
reused.

3 Distributing an external component
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3.1 Overview

3.2 Direct use of component

Once the component was created, checked
and generated, it can be made available to the
developers. Several methods are available:
• direct use of the component
Example: the component is directly used on the
computer of the developer who created it.
• simple distribution, by providing the necessary
files.
Example: the component is intended to be used
within the same company, by several developers.
In this case, the necessary files can be copied
onto a network drive.
• setup procedure of component (with a setup
procedure of component identical to the one
used for the applications).
Example: This distribution mode is
recommended if the component is intended
to be sold or distributed on a large scale, with
regular updates.

The component is created and used on the same
computer.
When importing the component into a WINDEV
project, all you have to do is select the WDI file
corresponding to the component. This file is located
in the EXE directory of component project.
Caution: If the component uses specific files (data
files, text files, ...), a <ComponentName>.WDO file
must be created once the component is generated.
This file contains the list of external files (data files,
text files, ...) used by the component.
These files referenced in <ComponentName>.WDO
will be automatically copied into the EXE directory
of the project that uses the WINDEV component.
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3.3 Simple distribution of component
The simple distribution of a component consists in
providing via simple copy the files required for the
component to operate. The files are copied into a
specific directory. This directory can be found on a
network server for example.
When importing the component into a WINDEV
project, all you have to do is select the WDI file
corresponding to the component in the distribution
directory.
To distribute a component, you must supply:
• The files automatically generated by
WINDEV (<ComponentName>.WDK file and
<ComponentName>.WDI file).
• If necessary, the specific files handled by the
component (data files, initialization files, etc.) as
well as <ComponentName>.WDO.
The <ComponentName>.WDO file contains the list
of files that must be supplied with the component.
For more details on this file, see "WDO file", page
78.

3.4 Distribution via a setup procedure
The distribution of components via a setup
procedure consists in supplying a setup program
to the users of WINDEV component. This program
installs all the files required for using the
component in the directory specified by the user.

This setup mode is used to automatically manage:
• the WDO file and the setup of specific files (data
files, ...) used by the component.
• the setup of specific tools (MDAC, ODBC driver
for HFSQL, ...).
• the automatic update of data files used by the
component (if necessary).
• the component uninstall process.
To propose a setup procedure for a component:
1. Create the setup procedure of the component:
on the "Project" tab, click "Setup procedure".
2. In the different steps of the wizard, specify:
• the setup media of component.
• the languages proposed in the setup
procedure.
• the default component setup directory.
• the optional modules to install. You have the
ability to modify the list of files that will be
distributed with the component. The WDO file
will be automatically created from this list.
• ...
By default, the files required for installing a
component are created in the INSTALL COMPO
subdirectory of the project.
Reminder: When creating the setup program of an
application, the necessary files are created in the
INSTALL directory of the project.

4 Using an external component in an application
A component can be reused at any time in any
WINDEV application: you just have to know the
directory of component files and import it into the
project. The component can also be imported via
the SCM.
When a new version of a component is available,
all you have to do is install the new files of this
update in the setup directory of component
(according to the setup mode used). For more
details, see "Distributing an external component",
page 74.

If the component was published and imported via
the SCM, the updates are proposed when opening
the project that uses the component.
The executable (that uses the component) is
created using the same method as for a WINDEV
application. The DLLs required for the component
to operate are automatically detected.
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5 Deploying an application that uses an external component
5.1 Overview
An application that uses one or more components
is deployed in the same way as a standard
application ("Setup procedure" on the "Project"
tab).
When deploying an application that contains a
component, the following files are automatically
installed on the user computer:
• <ComponentName>.WDK,
• <ApplicationName>.EXE,
• the files required for the component and for the
application to operate.

5.2 Updating components and deployed
executables
When updating a component and/or a deployed
executable, you have the ability to install on the
end-user computer:
• the application executable, the component and
the files required for them to operate.
• the application executable and the files required
for the application to operate.
• the component and the files required for the
component to operate.
For more details, see the online help.

Two methods can be used to update a component
on the end-user computers:
1. Recompiling the host project
Recompile the application that uses the
component and redistribute the application
with the component. In this case, no version
problem or compatibility problem will occur. The
recompilation is required in the following cases:
• New features have been added into the
component and they must be taken into
account.
• The parameters of some procedures have
been modified.
• Incompatibility between the new version and
the earlier component versions.
• ...
2. Distributing the .WDK file directly
Provide an upgraded version of component (.WDK
file) to the end users without recompiling the
project.
In most cases, this possibility applies when:
• The new version is used to correct the
problems of an earlier version.
• New features have been added into the
component but they are not required to run
the application.

6 Modifying an external component
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6.1 Overview

6.2 Different types of compatibility

A component that was created and generated can
be modified at any time. This modification can
correspond to:
• the addition of elements into the component.
• the deletion of elements from the component.
• the modification of rights on the component
elements.
• the modification of one of the component
elements.
In any case, after this modification, the component
must be regenerated in order to take the
modifications into account.

The management of compatibility is linked to the
component versions. Indeed, if modifications have
been made to the component, the applications
that use the component in deployment may
encounter runtime problems if they are not
synchronized with this component.
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The management of compatibility is an important
step in the modification of a component. Two types
of compatibility are available:
• the backward compatibility: the component
version (.WDK file) used to compile the
applications that use this component must
always be greater than or equal to the version
currently used in deployment.
This compatibility is automatically supported. If

the version of the component installed with the
application is less than the version used by the
application, the application will not operate.
• the forward compatibility: using a new
component version with the projects compiled
with an earlier version may not be allowed.
Therefore, the projects must be recompiled in
order to use the new component version.

7 Advanced component characteristics
7.1 Automatic documentation
A component must be supplied with a
documentation in order to be reused.
WINDEV simplifies the creation of this
documentation by proposing:
• a general overview of component. This
general overview is typed when generating the
component. When the component is used in a
WINDEV application, this overview will be visible
when choosing the component to import into the
project .
• an automatic generation of technical
documentation from the comments inserted
into the code of component elements.
Which code comments are taken into account?
The following comments are automatically taken
into account for the component documentation:
• Comments at the beginning of WLanguage
procedures

• Comments at the beginning of the following
WLanguage events/processes:
• "Global declarations" event of windows,
• "Opening" event of reports,
• "Declaration" event of classes,
• "Declaration" event of sets of procedures.

When is the documentation
generated?
The component documentation is generated when
the component is generated for the first time
("Project" tab, "Generate").
When generating the documentation:
• the comments found in the code are used to
create the documentation.
• if no comment exists, WINDEV will automatically
document the accessible elements of the
component by specifying the input/output
parameters expected by each element. The
corresponding comments are automatically
created in the different elements.
Remark: Each time you regenerate the component,
you can regenerate the documentation associated
with it ("Regenerate" button in the "History of
component" window).
Caution: The changes made in the generation
wizard will be deleted if you click "Regenerate".
How to access the component
documentation?
The general component overview and the technical
component documentation are available:
• when a component is included in a project: on
the "Project" tab, in the "Project" group, expand
"Import" and select "An External component".
• at any time, by double-clicking the icon of the
component in the "Project explorer" pane, or via
the "Description" option in the context menu of
the component.
To get the documentation specific to a component
element, double-click on it ("Project explorer" pane)
or press F2 from its code.
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7.2 Component element visibility
When creating a component, you have the ability
to define the component elements that will be
accessible (or not) by the component user.
• If the element is accessible, the component
user will see this element in the list of project
elements. The component user will be able to
handle these elements through programming
(like any other project element).
Remark: However, the code of this element is
not visible.
• If the element is not accessible, the user will not
even know that this element exists.
Caution: Depending on the declaration mode the of
the project elements (classes, sets of procedures,
etc.), the accessible elements may change.

7.3 WDO file
When generating the component, two files are
automatically created in the EXE directory of the
current project:
• <ComponentName>.WDK :
Contains all elements that will be redistributed
(windows, reports, ...) with the component.
• <ComponentName>.WDI :
Interface of component. This file contains:
• a help for using the component when it is
checked back in.
• the elements required for using the
component in the project (compilation
information...).
These two files must be distributed along with the
component.
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If the component uses additional elements (data
files, etc.), the following elements must be added
into the project EXE directory:
• a <ComponentName>.WDO file: This file
contains the list of external files (data files,
text files, .etc.) used by the component. These
files must be supplied and installed with the
component.
• the files that must be distributed with the
component. These files can be placed in
a specific tree structure. In this case, the
component code must manage the access to
these files in this tree structure.
What is this WDO file?
The <ComponentName>.WDO file is a file in TXT
format that can be created and modified at any
time. This file can be created and modified with
Notepad, the standard text editor of Windows.
This file contains the list of external files (data
files, text files, etc.) used by the component and
that must be supplied and installed with the
component. These files must be copied to the EXE
directory of the projects that use the component.
This ".WDO" file can contain:
• the full name of file.
For example: C:\Components\
PickerComponent\InitialStatus.INI
• the name of file. This file will be searched in the
current directory of the component.
For example: InitialStatus.INI
• a file name that uses a relative path.
The possible syntaxes are:
• Directory\FileName.xxx to specify a
subdirectory of the current directory
• .\FileName.xxx to specify the current directory
• ..\FileName.xxx to specify the parent directory.
For example: \PickerComponent\InitialStatus.
INI
This file will be used when the component is
included in the project. The paths specified in the
WDO file must correspond to the path where the
files are installed on the development computer of
component.

When the component is integrated, the tree
structure specified in the WDO file will be kept and
reproduced in the EXE directory of the project. For
more details, see "Using an external component in
an application", page 75.
Example: The "Zip Code" component uses a
"Cedex" data file (Cedex.fic and Cedex.ndx files).
This data file is located in the EXE directory of the
component creation project.
To provide and install the component with the
data file, the WDO file must be created in the EXE
directory of the component creation project. This
file must contain the following lines:
.\CEDEX.Fic
.\CEDEX.NDX

Distributing a component with WDO
To distribute a component that uses a WDO file:
• If no setup procedure is used for the component,
you must supply:
• the WDK file,
• the WDI file,
• the WDO file,
• all the necessary files referenced in the WDO
file.
• If you are using a setup procedure for the
component, the WDO file will be automatically
created when creating the setup procedure of
the component.
In the wizard, you must:
1. Ask to modify the files to install ("Modify the
list of files to install" in the "Additional modules").
2. Select the additional files to install.
The WDO file will be automatically created and
installed with the component.
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modes
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In addition to Windows applications, WINDEV allows you to generate other types of projects.
Applications
Applications are the most common generation mode. The applications
developed with WINDEV can target the following runtime platforms: Windows
(32 or 64-bit) and Linux.

Services
WINDEV allows you to generate services for Windows (32 or 64-bit) and
Linux (in Linux, services are usually called daemons). A service is a specific
type of application, started at the same time as the operating system and
without an interface.

Applications and .Net assembly DLLs
WINDEV allows you to generate applications and assemblies for the .Net
platform of Microsoft. A .Net assembly generated by WINDEV can be
imported into a .Net application developed in another language in a way
similar to an external component between two WINDEV applications.
Java applications
WINDEV allows you to generate Java applications. The Java applications can
be run on any computer equipped with a Java virtual machine, regardless
of its operating system. This allows you to build applications that operate in
Windows, Mac OS or even Solaris for example.
Universal Windows Platform applications
WINDEV allows you to generate Universal Windows Platform applications.
These applications can be used in tile mode or they can be distributed via
Windows Store.

Libraries and patches
A library is a unique file that groups several elements of a WINDEV project:
windows, reports, etc. You have the ability to generate stand-alone libraries
that can be used by other applications as well as corrective patches for an
application that is already deployed ; this allows you not to have to reinstall
the full application for a minor correction.
External components
The external components are application bricks allowing you to share one or
more specific features between several applications. An external component
generated by WINDEV can also be used in a WEBDEV or WINDEV Mobile
project.
SOAP or REST Webservices
A Webservice (also called XML Web service) can be generated from a
WINDEV project. A Webservice exposes a set of functions (one or more sets
of procedures) and makes them accessible via the Web (or via a private
network) by using the standard HTTP, SOAP and REST communication
protocols.
Remark: A Webservice must be deployed on a WEBDEV Application Server
in order to be used.
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Creating the executable in practice
When your application is complete (windows,
reports, etc.), you must create the corresponding
executable program.
The executable program (".EXE" file) can be run
directly : there is no need to start the application
from WINDEV.

When the executable program is created, the
application can be deployed on the end-user
computers by creating the setup program.

1 Creating the executable program of a WINDEV application
To create an executable program:
1. Select (if necessary) the project configuration
corresponding to the executable to create:
• Project configuration for a Windows 32-bit
executable.
• Project configuration for a Windows 64-bit
executable.
• Project configuration for a Linux executable.
2. On the "Project" tab, click "Generate".
3. The executable creation wizard starts.
4. Specify:
• the general executable options (executable
name, icon of the executable program, splash
screen, etc.).
• the operating mode of the executable:
• Multi-instance: This program can be started
several times from the same computer:
several instances will be opened at the
same time.
• Single-instance: This program can be
started once only from the same computer:
a single instance will be opened at a time.
If the user tries to run another program
instance, the current instance will be
enabled.
• how the library will be used. The library is
optional. It can be created in a separate
file (".WDL" extension) or included in the
executable.
Including the library in the executable
program presents the benefit of having a
single file to install or update but it increases
the size of created ".EXE" file.
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• the error message that will be displayed if a
programming error occurs.
• if the telemetry will be enabled. Telemetry
allows you to get information on how your
application is being used.
• the use of patches for updates. In this
case, all you have to do is copy the file
corresponding to the patch into the
executable directory.
• the languages supported by the executable.
• the files found in the library (if it is used).
• whether the components used in the project
are included in the executable.
• the location of the user groupware data files
(if the application uses the user groupware)
• the location of the data files that will be used
by the executable.
• the version information. This information
will be available in the "Version" tab of the
executable properties window (accessible in
the Windows explorer). The version number
can be automatically incremented each time
the executable is created.
• the mode for using the WINDEV framework
(using a framework specific to the application
or a framework common to all WINDEV
applications installed on the computer)
• the manifest to use (for an execution on
Windows Vista and later only).
• whether a project backup must be created.
5. Validate the executable description. The
executable is automatically generated according
to this information. The executable can be directly
run once it has been created.

Java application in practice
1 Overview
WINDEV allows you to generate Java applications
without even knowing the Java language. As for all
WINDEV applications, the application is developed
in WLanguage.

1.1 What is a Java application?
A Java application is entirely compiled in JAVA. If
this application uses a database, this database
must have a JDBC driver (MySQL, Oracle, etc.).
This driver is specific to each database (it can be
downloaded from the Web site of the database
publisher).
HFSQL databases are accessed natively (in
Windows and Linux only) via the SQL WLanguage
functions. No additional driver is required.
A Java application corresponds to a ".jar" file and it
requires the Java runtime in order to be run.
To compile (in Java) a Java project created with
WINDEV, the Oracle J2SDK (version 1.4.2 or later)
must be installed on the development computer.
A version is available on the WINDEV setup media.
This program can also be downloaded from the
Oracle site.

1.2 Why develop a Java application with
WINDEV?
You’ve developed a WINDEV application for
Windows and you want to make this application
accessible independently of the operating system?
Generate a Java application so that the users
working with Mac OS X for example will also be
able to use your application.
This gives you the ability to share your network
applications.

1.3 Principle for generating a Java application with WINDEV
As mentioned above, there is no need to know
the Java language to develop a Java application
with WINDEV. You develop your application in
WLanguage like any other WINDEV application and,
when compiling the project, the windows and the
WLanguage functions are automatically converted
into Java.
Remark: the number of WLanguage functions
that can be used in a Java project is limited in this
version. This number of functions will increase in
the forthcoming versions.

2 Features for a Java project
2.1 Creating a Java project
The method for creating a Java project is the same
as the method for creating any WINDEV project:
1. Click
in the WINDEV quick access buttons.
The element creation window appears: click
"Project".
2. The project creation wizard starts.
3. In one of the first steps, the wizard allows you
to choose the generation mode of your project. To
do so, select "Java archive" and continue.

By default, a WINDEV project for Java corresponds
to a specific project configuration. The type of
project generation can be modified at any time. All
you have to do is create a new project configuration.
As soon as the project is configured as a Java
project, all the tools available in WINDEV are
automatically configured for the Java project:
• The window RAD or the full application RAD
is specific to a database handled by a Java
application.
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• The compiler indicates whether the project
contains functions or controls that cannot be
used in Java. A purple message is displayed in
the "Compilation errors" pane.
• The creation of the archive makes it possible
to generate a ".jar" file in the EXE directory of
the project.
• The setup module only handles the files
required to deploy the Java application.
Remark: we advise you create a new WINDEV
project to develop a Java application rather than
transform a WINDEV application into Java.

2.2 JAVA RAD
Like for any project associated with an analysis,
the RAD can be used to generate the windows of
your application.
The RAD takes into account all the specific
features of Java generation (controls, processes,
functions that can be used in a WINDEV
application generated in Java).
Regardless of the type of window to generate, the
first screen of the wizard is used to specify the type
of connection to the database:
• HFSQL (in Windows or Linux): the standard
window creation wizard is proposed.
• JDBC: you can then specify the parameters for
connecting to the database that uses the JDBC
driver.

2.3 Test of Java project in the editor
During the test of a Java project (
), the project
is compiled and run in Windows. The project is not
compiled in Java.
To run the Java application, you must start the
".Jar" file found in the EXE directory of your project.

2.4 Compiling a Java project in WINDEV
The compilation of a Java project is used to:
• identify the programming errors found in the
WLanguage code
• see the controls, events, WLanguage functions
not available in Java. These errors appear in
purple in the "Compilation errors" pane.
For more details, see the online help.
Remark: as mentioned in the What is a Java
application? section, the Sun J2SDK must be
installed on the development computer to compile
your project in Java.

Project Monitoring
Center

Contenu

To optimize the management of your development projects, WINDEV gives you the ability to use
the Project Monitoring Center. The Project Monitoring Center is used to:
• Manage the project requirements,
• Manage the project monitoring (schedule of tasks to perform),
• Manage the bugs and evolutions signaled on a project.
The Project Monitoring Center uses an HFSQL Classic or Client/Server database: the database of
Control Centers. This database is shared between the different tools available in WINDEV:

2.5 Creating a Java archive

- Tasks
- Requirements
- Quality

WINDEV allows you to:
• create and compile in a Java compiler the
different Java files required by the application.
• create a Java archive that can be run directly:
• a standard Java application,
• a Java Web Start application.
To create the Java archive, all you have to do is
create the executable: on the "Project" tab, in the
"Generation" group, click "Generate". A wizard
helps you create the Java archive.

Project
Monitoring Center

2.6 Deploying a Java application
Like for any application, WINDEV allows you to
create a setup program for a Java application. This
setup procedure is available for Windows only. The
setup program will be an executable and it will be
used to install the necessary files as well as the
Java runtime (JRE). For the other platforms, your
files will have to be deployed manually.
To start the setup creation wizard, go to the
"Project" tab, "Generation" group and click "Setup
procedure".
For more details, see the online help (keyword:
"Java").

WINDEV login window
Database of
Control Centers

Business Rules

Stand-alone
messaging (WDBAL)

Automatic tests

Image catalog
(custom images)

Remark: When installing WINDEV, the setup program proposes to:
• create the database of Control Centers (database of Project Monitoring Center). This database
will be automatically created in HFSQL Classic format in the specified directory.
• share an existing database of Control Centers.
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Managing
requirements

Managing
tasks

Contenu

Contenu

The Project Monitoring Center allows the project manager to manage a development project. To do
so, you must:
• define the different project contributors.
• define the requirements (with the different elements associated with them).
Each developer performs the different tasks assigned to them.
The project manager can follow the progress status of the project at any time.

The Project Monitoring Center allows the project contributors to manage their task schedule.
These tasks can be linked to requirements and they can correspond to several projects.

Project Manager

1

Create requirements
composed of:

Tasks

Developer

2

Fulfill
requirements:

Project Monitoring
Center

Incidents

Business Rules

3

Once all the project tasks have been defined, the Project Monitoring Center takes care of
everything. Entering the time spent on a task is almost automatic, it requires no specific action
and it generates no particular constraint.

Pane of
Business Rules

Monitor requirements (Project Monitoring Center):

When the relevant project is opened, the Project Monitoring Center requests or indicates the
current task. As soon as a task is completed, simply indicate that the task is finished and specify
the new task.
A task can be linked to a project element (window, report, ...). Whenever the relevant element is
opened, the time spent on this element is counted and stored in the Project Monitoring Center.
Conversely, the element corresponding to the task that you want to perform can be automatically
opened from the task list.
Each developer can also see their own task list in the "Project Monitoring Center" pane found in
the editor.

Manage
requirements
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Managing suggestions and
incidents

Managing business
rules

Contenu

Contenu

The Control Centers also allows you to manage the user feedback regarding your applications.
If your application contains an automatic help menu (’?’ menu with "Send suggestions..."), the
users of your application will be able to easily send suggestions, incidents or business rules.

WINDEV allows you to manage the business rules. A business rule is used to define a specific
operating mode or to specify a particular process. For example: the calculation of a specific VAT
rate, the rules for changing the status of a customer, the formula for calculating shipping costs, a
commercial commission, a discount rate, a decay coefficient, etc.
A business rule can be simple or complex.
Business rules can come from:
• specifications (corresponding to requirements).
• suggestions made by users of the application.

End user

Use the Feedback component
(connected mode or by emails)
Business Rules

Define requirements
Suggestions or bugs

Spool for user feedback

Define Business Rules

Bugs linked to
the application project

Tasks linked to
the application project

Apply Business
Rules to the project

Pane for managing
Business Rules

Business Rules
suggested by the users
(“?” menu and Feedback
component)

Project Monitoring
Center

Use application

Developers

During the development, the business rules defined for the project are directly displayed in the
"Business rules" pane of the development environment. This pane displays the number of project
elements to which the business rules apply and the percentage of rules currently implemented.

Remark: if a fatal error occurs when running the application, an error report can be automatically
generated and sent to the developer via the "Feedback" component supplied with WINDEV.
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Analysis: Database
structure

Contenu

When a WINDEV, WEBDEV or WINDEV Mobile project uses data files, it must be associated with an
analysis. An analysis is used to describe the data structures (data files, items, etc.) used in your
project.
The data model editor allows you to easily create an analysis.

Supplier
Full name, ...

Product
Description, Price, ...

Order
Date, ...

Customer
Full name, ...

System studied

Corresponding analysis

The analysis of a WINDEV, WEBDEV or WINDEV Mobile project corresponds to the LDM (Logical
Data Model). The entire structure and data organization are described: the data is grouped by file
(called data file). Each data file contains several data called items.
In the analysis, the description of a data file can be linked to a type of file (HFSQL Classic, HFSQL
Client/Server, SQLite, etc.).
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Analysis in practice
1 Overview
When a project uses data files, it must be
associated with an analysis. An analysis is used to
describe the data structures (data files, items, etc.)
used in your project.
Two methods can be used to describe an analysis:
• 1st method: Creating the analysis directly (which
means a Logical Data Model (LDM)).

• 2nd method: Creating the Conceptual Data
Model (CDM), then automatically creating the
analysis from the CDM. For more details, see the
online help.
This chapter presents the first method.

2 Creating an LDM (Logical Data Model)
In WINDEV, the terms "LDM" and "Analysis" are
interchangeably used to define the structure of the
database associated with a project.

2.1 Creating an analysis (or LDM)
To create a LDM:
1. Click
in the quick access buttons. The
creation window appears: click "Data" then
"Analysis". The analysis creation wizard starts.
2. Specify:
• the analysis name and directory. The analysis
corresponds to a ".WDA" file. By default,
this file will be created in the directory of
the project analysis (<Project name>.ANA
directory). This directory must be accessible in
read/write mode.
• the analysis caption that briefly describes the
analysis subject.
• whether the analysis must be associated with
the current project.
• the type of database used by the project.
3. The creation of the first data file is
automatically proposed.
4. Create all elements (data files, items and links)
of your analysis.
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2.2 Adding a data file to an analysis
The analysis is used to define the structure of the
data files used by the project. A data file found in
the analysis can be:
• A new data file.
• A preset data file, supplied with WINDEV.
• A data file imported from an existing database
(using a specific format for example).
The following paragraphs explain how to create a
data file.
To create a new data file:
1. On the "Analysis" tab, in the "Creation" group,
click "New file". The data file creation wizard
starts.
2. Select "Create a new data file description".
3. Specify:
• the name of the data file. This name is the
logical name of the data file. It will be used to
handle the data file.
• the caption of the data file that briefly
describes the file subject.
• the representation of a record in the data file.
This representation improves the legibility of
questions asked when describing links. This
option must be preceded by an indefinite
article (A or AN).

• whether the data file includes an "Automatic
identifier" item. The value of this item is
unique for each record and it is automatically
calculated by WINDEV.
• the type of database associated with the
data file. Depending on the type selected, this
data file will be handled by the HFSQL engine,
an OLE DB driver or one of WINDEV’s Native
Connectors (SQL Server, Oracle, etc.).
4. The created data file becomes the current
data file. The file items description window opens
automatically. It allows you to describe the file
items.
To import a preset data file description:
1. On the "Analysis" tab, in the "Creation" group,
click "New file". The data file creation wizard
starts.
2. Select the option "Select a description among
the preset data files".
3. Choose the preset data file to create (you have
the ability to select several ones). This data file
will be imported into the current analysis. This
data file can be modified later.
4. Select the file items to store. These items can
be modified later.
5. The imported data file is automatically inserted
into the current analysis.
Remark: To modify a data file or the items in a data
file:
1. Select the data file.
2. Select "Description of data file" or "Description
of items" in the context menu.

3. Specify the source database containing the
descriptions to import and the type of this source
database. Depending on the selected type, specify
the requested information.
4. Select the tables or the data files whose
description must be imported and validate.
5. The imported data file is automatically inserted
into the current analysis.
Solution 2: From the Windows explorer
Drop the file description from the Windows explorer
to the data model editor.
For example:

Here, an Oracle database, on the server. All you
have to do is drag the person name to transfer the
description into the data model editor.

Two solutions can be used to import an existing
data file description:
Solution 1: From the data model editor
1. On the "Analysis" tab, in the "Creation" group,
click "New file". The data file creation wizard
starts.
2. Select "Use the data files from an existing
database" and select the type of database.
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2.3 Creating an item
To create an item:
1. Double-click the data file where the item will
be created. The description window of file items
is opened.
2. Click the first empty row in the table of items.
3. Specify the name, the caption and the type of
item in the table.
4. In the right section of the screen, specify the
details of the new item (type, size, default value,
search direction, etc).
5. Specify the details about the shared
information: click "Parameters of the control
linked to the selected item (shared information)".
6. Validate the item description.
Remark: you also have the ability to create an item
from the meta-types proposed by WINDEV. To do so,
click the "+ M" button on the right of the table. The
list of available meta-types is displayed.

2.4 Creating a link
Different types of links can be created between
data files. For more details, see "Characteristics of
links defined in an analysis", page 96.

To create a link:
1. On the "Analysis" tab, in the "Creation" group,
click "New link". The mouse cursor turns into a
pen.
2. Select the two data files to link. The link
description window opens automatically.
3. To define the cardinality between the two data
files:
• select the cardinalities among the proposed
ones (0, 1; 1, 1; 0, N; 1, N).
• answer the questions asked. The cardinalities
will be automatically updated.
4. To describe the advanced cardinalities, check
"Display the advanced cardinalities" and answer
the questions asked.
5. Type the link caption by briefly describing the
link purpose.
6. Specify the keys to link.
7. Define the integrity rules. These rules are used
to ensure the data integrity when one of the
relation keys is modified or deleted.
8. Validate. The link is automatically created.

3 Characteristics of links defined in an analysis
3.1 Owner file and member file
When a link is defined between two data files, there
is an owner data file and a member data file:
• the owner data file is the owner of the key.
• the member data file is a member of the
analysis data files containing a copy of the key.
To set the link between two data files, the key of the
owner data file is copied to the member data file.

For example, the key of the Supplier data file is
copied to each record of the Product data file.
Several records of the Product data file can have
the same key of the Supplier data file:
• Supplier is the owner data file,
• Product is the member data file.
This type of link is represented as follows:

3.2 Cardinalities
The cardinalities are used to count the links
between the data files.
The cardinality is defined according to the answers
to the two following questions:
1. For each record of the data file, what is the
minimum number of records in the other data file
this record is linked to?
The answer provides the first part of the
cardinality (minimum cardinality):
• if the answer is "none", the cardinality is 0,X.
• if the answer is "a single one", the cardinality
is 1,X.
2. For each record of the data file, what is the
maximum number of records in the other data file
this record is linked to?
The answer provides the second part of the
cardinality (maximum cardinality):
• if the answer is "a single one", the cardinality
is X,1.
• if the answer is "several", the cardinality is
X, N.
The answer to these two questions defines the
cardinality that can be: 0,1 ; 0,N ; 1,1 ; 1,N
The description of cardinalities is fundamental: it is
the basis for respecting the referential integrity of
the database.
To put it simply, these two questions can be broken
down into four questions. For example, to describe
a link between the Club data file and the Person
data file:

•
•
•
•
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Example of cardinalities:
This example presents two different cardinalities:

• 0,1 cardinality: A person can be a member of a
single sport club. This person does not have to
belong to a sport club.
• 0,N cardinality: A club can have no member or
several members.

3.3 Advanced cardinalities
The cardinalities can be defined more precisely.
This is referred to as advanced cardinalities.
These cardinalities are used to exactly specify the
minimum cardinality and the maximum cardinality.
To define the advanced cardinalities, check "Display
advanced cardinalities" in the link description.
Example of advanced cardinalities:
This example presents two different cardinalities:

• 0,1 cardinality: A person can be a member of a
single sport club. This person does not have to
belong to a sport club.
• 0,10 cardinality: A club can have nobody or up
to 10 people as members.

each "Club" has at least one "Person": Yes/No?
each "Club" can have several "Person": Yes/No?
each "Person" has at least one "Club": Yes/No?
each "Person" can have several "Club": Yes/No?
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3.4 Referential integrity
The referential integrity of a database corresponds
to the respect of constraints implied by the links
between the data files.
The referential integrity consists in checking that:
• if a record is deleted from the owner file, the
corresponding records are also deleted from the
member files,
• if a record is added to a member file, a
corresponding record exists in the owner file,
• if a record is modified in the owner file, the
unique key is not modified, ...The check of
referential integrity depends on the nature of the
link between the data files.
For more details on referential integrity, see the
online help.

simultaneously on the two data files:
• creation of a record.
• deletion of a record.
• reindexing with compression.
Optional link
For an optional link:
• Each record of a data file (Category) has no
associated record or a single associated record
in the other data file (Group).
• Each record of the other data file (Group) is
associated with no record or with a single
record in the first data file (Category).

3.5 Different types of links
Several types of links can exist between the data
files:
• parallel
• optional
• complement
• shared
• complex
Parallel link
In a parallel link, each record found in a data file
(Product) is linked to a record in another data file
(Information), and conversely.

Shared link
For a shared link, the same record in a data file
(Supplier) can be shared by several records in
another data file (Product).
In a shared link, the key of the Supplier data file
is copied to the Product data file. It becomes a
multiple key to increase the speed of integrity
check.
The owner data file is Supplier, the member data
file is Product.
Depending on the cardinality, we can distinguish
between four types of shared links:
• Shared link with a 0,n - 0,1. cardinality
• Shared link with a 0, n - 1, 1. cardinality.
• Shared link with a 1,n - 0,1. cardinality
• Shared link with a 1, n - 1, 1. cardinality.
Shared link with a 0,n - 0,1 cardinality

98

Part 3: Databases

Shared link with a 1,N - 1,1 cardinality
With this type of link:
• each owner has at least one member (each
supplier has at least one product).
• each member has a single owner (each product
has a single supplier).

An optional link is performed by copying the
identifier of each data file into the other data file.
Complement link
For a complement link:
• Each record found in a data file (Product) has no
associated record or a single associated record
in another data file (Details).
• Each record found in the other data file (Details)
necessarily has an associated record in the first
data file (Product).

With this type of link:
• an owner may have no member (a supplier does
not necessarily have a product).
• a member may have no owner (a product does
not necessarily have a supplier).
Shared link with a 0,n - 1,1 cardinality

In a parallel link, the identifier of the Product data
file is copied to the Info data file. This identifier is
also a unique key in the Info data file.
The owner data file is Product and the member
data file is Info.
Remark: This type of link is rare because the two
data files can be grouped into a single file.
The parallelism of records in the data file is
respected if the following operations are run

Shared link with a 1,n - 0,1 cardinality
With this type of link:
• each owner has at least one member (a supplier
has at least one product).
• a member may have no owner (a product may
have no supplier).

Complement links are quite common. They are
used when a record can have additional optional
information.
In a complement link, the key of the Product data
file is copied to the Detail data file. To ensure the
maximum cardinality of 1, it remains a unique key.
Since this key is unique, it is not possible to insert
more than one record in the Detail data file for a
record in Product.
The owner data file is Product, the member data file
is Details.

With this type of link:
• an owner may have no member (a supplier may
have no product).
• each member has a single owner (each product
has a single supplier).
Remark: This type of link is quite common. WINDEV
allows you to automatically create the windows
used to manage the data files linked by a 0,N - 1,1
link.

Complex link
For a "complex" link, you must manage a link file,
called relation file.
The relation file will be automatically created. It will
contain a unique key that includes the two keys of
linked data files.
The relation file can also contain information
specific to the link.
A complex link includes two shared links.
Example of complex link
An order ("Orders" data file) can contain one or
more products. A product (Product data file) can be
used in several orders.
In this case, a link file is required (OrderLine data
file).
The OrderLine data file contains:
• a unique key containing the keys of Product and
Orders.
• the number of products ordered.
The links between the data files are as follows:
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4 Operations that can be performed on an analysis
WINDEV allows you to perform the following
operations on an analysis:
• Duplicate/Copy an LDM: Duplicating an LDM
allows you to have two identical LDMs with
different names.
• Delete an LDM.
• Rename an LDM.
• Associate an LDM with a project.
• Enlarge or reduce the display of LDM in the
editor.
• Move the display of LDM in the editor.

WINDEV allows you to perform the following
operations on an item of a data file found in the
data model editor:
• Duplicate/Copy an item.
• Delete an item.
• Rename an item.
For more details, see the online help.

WINDEV allows you to perform the following
operations on a data file found in the data model
editor:
• Duplicate/Copy a data file.
• Delete a data file.
• Rename a data file.

5 Generating the analysis (LDM)
The analysis generation is performed before the
programming step and after the description of data
files. This generation is used to:
• validate the modifications performed on the
analysis (LDM).
• create the modules required for programming.
• automatically update the data files if necessary.
As long as the analysis (the LDM) is not generated,
the analysis description (the data files) cannot be
used in the project.
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To generate the analysis, go to the "Analysis" tab,
"Analysis" group and click "Generation".
The generation includes three steps:
• Verification of modifications and generation
of physical files corresponding to the analysis
description.
• Automatic modification of accessible data files
(files in the project "EXE" directory).
• Synchronizing the project.

6 Managing the analysis versions
WINDEV allows you to manage the different
analysis versions:
1. On the "Analysis" tab, in the "Analysis" group,
click "Generation".
2. Select "Manage versions".
3. In the wizard, specify whether you want to work
on the current analysis or on a specific analysis.
Remark: when an analysis is damaged, you have
the ability to select the damaged analysis to restore
one of the earlier versions for example.
All the analysis versions are viewed in a graph.
The yellow rectangle indicates the version number
of analysis, the caption on the right indicates the
generation date.
The "small rectangles" displayed between two
versions indicate:
• one rectangle: few modifications have been
made between the two versions.
• several rectangles: several modifications have
been made between the two versions.
To see the details of the changes between two
versions: Double-click the row containing the
"small rectangles" or click [Modifications].
The options available in the version manager are:
• Restoring an analysis.
• Canceling the last generation.
• Resetting the version number to 1.

6.1 Restoring an analysis
To restore an analysis from the version manager:
1. Select the version to restore.
2. You can:
• restore the version in the specified directory.
An independent analysis corresponding to
the selected version is created. This option is
selected by default.
• overwrite the current analysis.
3. Validate. The restore operation is performed.
Caution: The data files corresponding to an analysis
whose version number is greater than the restored
version cannot be opened anymore. In this case,
you must also restore the data files corresponding
to the restored analysis version or delete the
existing data files in order to recreate them.

6.2 Undoing the last generation
Canceling the last generation of the analysis
restores the analysis to its status before the last
generation. The modifications performed since
then are not applied.

6.3 Resetting the version number to 1
The analysis generation number can be reset to
"1": on the "Analysis" tab, in the "Analysis" group,
click "Generation" and select "Reset analysis
version to 1".
In this case, the analysis version number is reset
to one. No specific action is performed on the data
files.
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Different types of
accessible files

Contenu

WEBDEV, WINDEV and WINDEV Mobile offer simple access to the majority of databases on the
market.
APPLIC ATIONS

SITES
APPLIC ATIONS

APPLIC
SITES ATIONS

APPLIC ATIONS

NATIVE APPLICATIVE NATIVE APPLICATIVE
CONNECTOR
CONNECTOR

UNIVERSAL DATA CONNEC
TOR DATA CONNEC TOR
UNIVERSAL
(HReadSeek, HExecuteQuery, File, Item, (HReadSeek, HExecuteQuery, File, Item,
Automatic File Link, Databinding, Replication,
SQLExec...)
Automatic
File Link, Databinding, Replication, SQLExec...)

NATIVE CONNEC TORNATIVE CONNEC TOR
SQL Server

MySQL SQL Server

Oracle

MariaDBOracle

AS/400

DB2

Progress

Sybase Progress

AS/400

PostgreSQL

Informix PostgreSQL

SQLite

Azure

SQLite

NATIVE HFSQL
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NATIVE HFSQL

Unlimited deployment,
free
Powerful SQL database: Windows - Linux - Android - iOS
Powerful SQL database: Windows - Linux - Android - iOS

- Outlook
- XML
- SalesForce - ...
- SAP R/3
- RSS
- Webservice
SOAP/REST
- XLS/XLSX

BIG DATA

MySQL
Classic/Embedded

Classic/Embedded
Mobile

Local, network,iOS (iPhone, iPad), Android,
32 & 64 bits Windows IoT, UWP,...

Local, network,
32 & 64 bits

MariaDB

- Redis
- Hadoop - Hive
- HBase
iOS (iPhone, iPad),
Android, - Memcached - Riak
- ...
HDFS
MongoDB
Windows IoT, UWP,...

Mobile

ODBC

DB2

S

Client/Server
Linux, Docker,
SybaseWindows,
Spare, 32 & 64 bits

S

32 & 64 bits
Windows et Linux

Client/Server
Windows, Linux,PCSCLOUD
Docker,

Spare, 32 & 64 for
bitsPC SOFT applications

- Google
- iCalendar
- JSON
- LDAP
- Lotus Notes
- MATLAB
- MQTT

- Outlook
- XML
- SalesForce - ...
- SAP R/3
- RSS
- Webservice
SOAP/REST
- XLS/XLSX

BIG DATA
- Hadoop
- HBase
- HDFS

- Redis
- Hive
- Memcached - Riak
- ...
- MongoDB

ODBC

32 & 64 bits
Windows et Linux

PCSCLOUD

for PC SOFT applications

OLE DB
32 & 64 bits

OLE DB
32 & 64 bits

Informix

Azure Cluster
Windows, 32 & 64 bits

Full compatibility

102

- Google
- iCalendar
- JSON
- LDAP
- Lotus Notes
- MATLAB
Unlimited deployment,
- MQTT free

Cluster

Windows, 32 & 64 bits

HFSQLDrive

HFSQLDrive

Full compatibility
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HFSQL
Classic

HFSQL Client/
Server
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HFSQL Classic is a powerful system for managing relational databases (RDBMS) that can be used
on a single computer or in local network. HFSQL Classic does not require the setup of a database
server.
The characteristics of HFSQL Classic are as follows:
• An HFSQL Classic application can be run on different user computers distributed in a local
network.
• The data files are found in a directory that can be accessed by the user computers (a shared
directory on the network for example). Each user computer physically accesses the data files.
• The processes (query, read/add in a data file, ...) are performed on each user computer.

HFSQL Client/Server is a powerful system for managing relational databases (RDBMS) in Client/
Server mode.
The characteristics of HFSQL Client/Server are as follows:
• An HFSQL Client/Server application can be run on different user computers (called client
computers) that communicate with the database server via the network.
• The data files are found on a server. Only the server physically accesses the data files.
• All processes (query, read/write operation in a data file, ...) are performed on the server.

Client computer 1

User 1

WINDEV application

WINDEV application

Client computer 2

User 2

Windows or Linux
HFSQL server
Manta server

Network HFSQL
Classic database
WINDEV application

WINDEV application

(shared directory)

Client computer n

User n

HFSQL
Client/Server
databases

WINDEV application

WINDEV application
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HFSQL Client/Server
cluster

HFSQL: files physically
created

Contenu
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HFSQL Cluster is an extension of the HFSQL Client/Server database model. In a database cluster,
all HFSQL servers contain a copy of the databases and are synchronized in real time.
• The read load can be balanced among the different servers.
• The physical configuration can evolve without any interruption for the client computers.
• If one of the servers crashes, the client is automatically redirected to an operating server.

The data model editor is used to describe the structure of data files.
Depending on the information typed in the data model editor, different files are physically created.

Client computer
WINDEV application

Access data

Cluster

HFSQL Client/Server
server

Characteristics
of the file (Analysis)

Files physically
created

HFSQL Classic or Client/Server file

".fic" file
Data file

One or more search keys (unique
or with duplicates)

".ndx" file
Index file

One or more full-text indexes

".ftx" file
Full-text index file

One or more "Memo" items

".mmo" file
Memo file

Remark: This diagram only presents the main created files. Other specific files can be created if
the data file uses logs, transactions or replication.

HFSQL Client/Server
server

Apply modifications

HFSQL Client/Server
server
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HFSQL Client/Server
server
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Associating controls with
data

Contenu

Control - variable binding

A window can display information coming from:
• a database: the controls are directly bound to the items in the data files or queries available in
the database.
• variables in the application’s WLanguage code (variables global to the window or to the project
or parameters passed to the window).
To display this information in a window, the controls of this window must be bound to:
• the different database items.
• the available WLanguage variables.

ScreenToFile

Linked variable

FileToScreen

Simple control

The method for displaying and retrieving the information is straightforward:
• The binding between a control and an item or variable can be defined in the window editor, in
the control description ("Binding" tab).
• ScreenToFile is used to update the record or the variable with the data displayed on the screen.
• FileToScreen is used to update the data displayed on the screen with the information saved in
the data file or with the information saved in the variable.

Link with:
- Simple variable
- Instance of class or structure member
- Property of dynamic object

Control - item binding

ScreenToFile

FileToScreen

Database
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Queries:
concepts

Embedded
queries

Contenu

Contenu

A query is used to interrogate a database in order to view, insert, modify or delete data. The query
structure defines the data used.
A query can interrogate one or more data files.

The controls from a window can be linked to a data file or to an existing query, ... These controls
can also be linked to a query created when building the control.

The query editor allows you to easily create queries without programming.

Sources

Possible uses
Windows and controls
of a window

Data coming from
one or more files
(HFSQL, Oracle, ...)

The result of a
query can be used
like a file

Embedded query:
MyWindow_1$Query

Reports
Programming
(use in the
WLanguage functions)
Queries

Remark: In programming, a query can be handled like a data file. Especially, it can be associated
with a display control (a Table control for example) that will present the data returned by the query.
Embedded query:
MyWindow_2$Query

In this case, the query is integrated in the window. It is located in the WDW file that corresponds
to the window. If the WDW file is copied (into another project for example), the embedded queries
used by this window will also be copied.
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Table/Looper
controls

Contenu

Table/Looper controls can be used to display a set of information (e.g., the content of a data file).
The content of these controls can come from three different sources:
• Browsing Table/Looper controls with direct access,
• Memory Table/Looper controls,
• Browsing Table/Looper controls loaded in memory.
Remark: These three fill modes will be presented in this page for the Table control. The same
concepts apply to the Looper control.

Browsing Table control with direct access
A browsing Table control with direct access is used to directly display the data coming from a data
file or from a query. The structure of data file was described in the data model editor and the data
was typed in the application for example. Browsing the data file allows you to display data in the
Table control. The data file is read for each row displayed: the record read is displayed in a row of
Table control.

Customer
file
The displayed data that is not linked to the data file is not kept when refreshing the display of
Table control (when scrolling for example).
The number of records displayed in the control can be limited by a filter (HFilter used in the
initialization code of control).
Several WLanguage functions can be used to handle the browsing Table controls. These functions
start with "Table".
To add a record into the Table control, add the record into the corresponding HFSQL data file
(HAdd) and redisplay the Table control with TableDisplay.
To delete a record from the Table control, delete the record from the corresponding HFSQL data
file (HDelete) and redisplay the Table control with TableDisplay.

Memory Table control
A memory Table control is used to directly display the data loaded in memory. The data is added
into the Table control by programming (by TableAddLine for example).
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Data in
memory

The data being found in memory, the Table control allows you to perform all operations on the
data (sort on any column, search in the columns, ...).

Browsing Table control loaded in memory
The browsing Table controls loaded in memory combine the benefits of browsing Table controls
with direct access with the benefits of memory Table controls.
The Table control is bound to the data file but all the contents of the data file are loaded in
memory. Sort and the search features are available for all columns.
The data not linked to the data file is kept when handling the scrollbar (Check Box column for
example).
Since the data file records are loaded in memory, this type of control is recommended for data
files with less than 100 000 records (to avoid memory overflow).

Customer
file
File loaded
in memory

Remark: The different fill modes (memory, browsing, browsing loaded in memory) are available for
the List Box controls, Combo Box controls, Table controls, Looper controls, ...
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Universal
replication

Contenu

3-tier
architecture

The universal replication is used to keep databases of identical or different formats updated
(HFSQL, Oracle, SQL Server, ...). For example, you can synchronize an HFSQL Classic database
with an Oracle database.
Universal replication uses a centralized model: all databases are synchronized with a master
database. Then, the master database applies the modifications to the other databases.

3-tier architecture is an application architecture model.
Its basic principle consists in dividing an application into 3 layers:
• the presentation layer: corresponding to the display,
• the process or application layer: corresponding to the business processes of application,
• the layer for accessing persistent data.
The objective with this separation is to make each layer independent, in order to facilitate
maintenance and future developments of the application. This provides better security because
the access to the database is allowed via the Processes layer only. It also optimizes teamwork and
multi-target development.

Mobile

Windows

Browser

Webservices

WEBDEV application
server

Presentation layer

Universal
replication
Components
Application layer

The synchronization can be adapted to special cases. For example, you can retrieve the records
related to a specified product or the records created at a given date, manage conflicts, display a
configuration window, ...
These adaptations must be done by programming with HRplFilterProcedure.
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HFSQL
Classic, Client/Server

External databases
Oracle, AS/400, SQL Server...

Data layer

3-tier architecture is fully compatible with the development of applications with WINDEV.
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RAD
RID

Contenu

The RAD (Rapid Application Development) and the RID (Rapid graphical Interface Design) are used
to create windows from:
• the analysis linked to the project,
• standard or custom RAD patterns,
• skin templates.
In RAD generation, the generated windows contain the entire code required for them to operate.
The test of these windows can be immediately run with the data found on the development
computer.
In RID generation, the generated windows only contain the controls linked to the analysis items.
The code required for these windows to operate must be written by the developer. Only the code
required for the additional pattern elements to operate is added. Your custom code can be typed
directly.

Project
analysis

RAD
pattern

Skin template

Full Application RAD
Window RAD or RID

Example of window generated
by RAD or RID
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UML
models

Contenu

WINDEV allows you to create nine types of UML models:
• Class diagram: describes the overall structure of a system.
• Use case diagram: represents the system features from the user’s point of view.
• Object diagram: represents a set of objects and their relationships at a given time.
• Component diagram: describes the physical and static architecture of a computer application.
• Activity diagram: represents the behavior of a method or the progress of a use case.
• Sequence diagram: represents the chronological order of messages sent and received by a set
of objects.
• Collaboration diagram: represents the structural organization of objects that send and receive
messages.
• State-transition diagram: represents a sequence of states.
• Deployment diagram: shows the redistribution of the devices (nodes) used in a system as well
as the association between the executable programs and these devices.

UML models in practice
1 Overview
The main objective of a development team is to
create optimized applications, capable of satisfying
the ever-changing needs of their users.
The modeling of an application is used to specify
the structure and the expected behavior of a
system. It helps understand its organization and
detect simplification and reuse opportunities as
well as manage potential risks.
A model is a simplification of reality. It allows you to
better understand the system to develop.
A diagram is the graphical representation of a set
of elements that constitute the system. To view
the system under different perspectives, the UML
language (Unified Modeling Language) proposes
nine diagrams, each one representing a system
state.

WINDEV allows you to create these nine types of
UML model:
• Class diagram,
• Use case diagram,
• Object diagram,
• Component diagram,
• Activity diagram,
• Sequence diagram,
• Collaboration diagram,
• State-transition diagram,
• Deployment diagram.
This chapter only provides an overview of UML. For
more details, see a specific documentation about
the UML language.

2 The different UML diagrams
2.1 Class diagram
A class diagram is used for modeling the structure
of a system via classes and via relationships
between these classes.
The class diagrams are the most common
diagrams in the modeling of object-oriented
systems.
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For example, the following diagram presents the
management of stocks:
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A class diagram includes the following elements:
• Class: represents the application structures.
Each class is divided into three compartments:
• the name of the class indicates what the
class is, not what it does.
• the class attributes give the class
characteristics.
• the class operations represent the possible
actions on the class.
For example, the Stocks class contains the
ListProducts attribute. This class also groups the
AddProduct and RemoveProduct operations. These
operations can be applied to the class instances.
Remark: The UML language defines three visibility
levels for the attributes and the operations:
• Public: the element is visible to all other
classes.
• Protected: the element is visible to the class
itself and to its sub-classes.
• Private: the element is visible to the class
only.
• Relationship: describes the behavior of
classes between themselves. Three types of
relationships are available:
• Association: Structural relationship between
classes. For example, the Orders class is
linked to the Product and Customer classes. A
Customer can place several Orders. An order
contains several products. An order must
necessarily contain at least one product.
• Dependency: Use relationship that
establishes that the instances of a class are
linked to the instances of another element.
For example, the Orders class uses the Stocks
class: before adding a product into an order,
you must make sure this product is available
in stock.
• Generalization: Relationship between a
general class (parent) and a specific class
(child) that derives from it. For example, the
Sail Boat class and Speed Boat class are
derived from the Boat class.

• Package: used to divide and organize the
diagram representation (how the directories
organizes the files). Each package can contain
classes and relationships.
Via the generation of a class diagram, you have the
ability to create the structure of WINDEV classes
used in your application.

2.2 Use case diagram
A use case diagram is used to view the behavior of
a system in such way that:
• the user can understand how to use each
element.
• the developer can implement these elements.
For example, the behavior of a cell phone can be
described via a use case diagram.

A use case diagram includes the following
elements:
• Actor: represents the role of application users.
For example, a person who works in a bank
will be the loan manager. If this person has an
account in this bank, he will also play the role of
Customer.
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• Use case: describes a sequence of actions
run by the application. For example, Place an
order, Enter an invoice, Create a new Customer
entry, ...
A use case describes the actions performed by
an application but it does not specify how the
application performs these actions.
• Relationship: describes the behavior of actors
in relation to the use cases. Three types of
relationships are available:
• Association: Structural relationship between
two linked elements.
• Dependency: Relationship establishing that
an element uses another one. For example, a
bank customer may get cash from an ATM. In
this case, the Get Cash action depends on the
Customer.
In order to get cash, the Customer must enter
his PIN number. In this case, the Get Cash
action depends on the Password Input.

• Generalization: Relationship used to organize
the elements according to a hierarchy.
For example:
• two types of Customer actor are available:
Individual customer or Company customer.
• the identity check can be performed
according to two methods: typing a
password or checking a fingerprint.

2.3 Object diagram
An object diagram presents a set of objects and
their relationships at a given time.
An object diagram is used to show a context
(before or after an interaction between objects for
example).
For example, the diagram below presents a section
of the general structure of motorcycles:

An object diagram includes the following elements:
• object: represents a class instance.
Remark: If a class diagram is opened, you have
the ability create an object from a class found
in this diagram (Drag and Drop from the "UML
analysis" pane).
• composite object: visually represents an object
made of other objects. For example: a window
that contains scrollbars, buttons, ...
• link: presents the relationships between the
different objects.

2.4 Component diagram
A component diagram describes the physical and
static architecture of a computer application. For
example: source files, libraries, executables, ...
For example, the diagram below presents the
operating mode of a program allowing you to log in
text mode in Unix.

• Package: divides and organizes the diagram
representation (like the directories organize the
files). Each package can contain actors and use
cases.
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A component diagram includes the following
elements:
• module: represents the different physical
elements that constitute a computer application.
For example: a file, a library, ...
A module can be represented:
• by a specification that shows the module
interface. This specification can be generic for
the customizable classes.
• by its body that presents the module
implementation.
• task: represents a component that includes its
own control flow (thread).
• main programs of the application.
• sub-programs: groups the procedures and the
functions that do not belong to classes.

• sending signal: represents the sending of a
signal toward an object.
• waiting for signal: represents the wait for a
signal coming from an object.
• transition: represents the move from an activity
that is ended to another one. For example: "Too
much water", "Enough money", ...

2.7 Collaboration diagram
A collaboration diagram presents the structural
organization of objects that send and receive
messages.
For example, the diagram below presents the use
of an elevator by a person:

2.6 Sequence diagram
A sequence diagram represents the chronological
order of messages sent and received by a set of
objects.
For example, the following diagram represents the
beginning of a phone call:

2.5 Activity diagram
A collaboration diagram includes the following
elements:
• object: represents the different objects used.
• actor: presents an element external to the
system. A person for example.
• message: represents the messages exchanged
between different objects.

An activity diagram represents the behavior of a
method or the flow of a use case.
For example, the following diagram presents the
flow of a dam:

An activity diagram includes the following elements:
• activity: presents a specific step in a the
execution of a mechanism. For example: "Print
an estimate", "Open the window", ...
• synchronization bar: used to synchronize the
different activities:
• by indicating the activities that must be
performed before a given activity. For
example: "Press clutch" and "Change gear"
before "Release clutch".
• by indicating the activities that will be
performed in parallel.
• object: used to attach activities to the object
that performs these activities. For example,
the "Order" and "Pay" activities are attached to
the "Customer" object; the "Teach" and "Check
knowledge" activities are attached to the
"Teacher" object.
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For example, the diagram below presents the
different steps of a car wash:

A sequence diagram includes the following
elements:
• object: represents the different objects used.
Each object is represented by a square at the
top of a dotted line. This line represents the
object lifespan. For example: "Caller", "Callee", ...
• activation period of an object: activation periods
can be inserted into the line representing the
object lifespan. These periods represent the
times when the object is active.
• message: represents, via horizontal arrows,
the message exchanged between the different
objects. These arrows are oriented from the
message issuer to the recipient. The order in
which the messages are sent is given by the
position of the arrows on the vertical axis.
For example: "Hang up", "Ring", ...

2.8 State-transition diagram
A state-transition diagram presents a sequence
of states that an object goes through during its
lifecycle. It is used to describe the changes of
states for an object or for a component.
A state is defined by its duration and by its stability.
A transition represents the instantaneous change
from one state to another one.
A transition is triggered:
• by an event.
• automatically when no triggering event is
specified.

a state-transition diagram includes the following
elements:
• state: represents the value of object attributes
at a given time.
• initial state: represents the state when the
system is started.
• final state: represents the status of system at
the end of operation.
• super-state: used to structure the diagram by
specifying several distinction levels between the
states.
• history: represent the last active state of a
super-state.
• stump: used to symbolize the states found in a
super-state. This allows you to link these states
to other states that do not belong to the superstate.
• transition: represents the switch from one state
to another one.
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2.9 Deployment diagram
A deployment diagram presents the physical layout
of hardware devices (nodes) used in a system as
well as the association between the executable
programs and these devices.
For example, the diagram below presents the
different hardware devices used in a company:

A deployment diagram includes the following
elements:
• node class: represents a class of hardware
resource. For example: a server, a PC, a printer,
...
• node instance: represents a hardware resource.
For example: the server #3, the printer #7, ...
• connection: describes the communication
support between two nodes. For example: RNIS
or TCP/IP link.

User
groupware

Contenu

The User Groupware allows easily including user and rights management in a WINDEV application.
Two types of users are taken into account:
• simple user, who is using the application directly.
• supervisor, who can configure the users and their rights.

1

User
Start application

2

3

Use
the application

Identification
Use
rights

Check
rights

Supervisor
HFSQL Classic,
Client/Server,
Native Access,
LDAP

User Groupware Database

Configuration of
rights and users

4

Supervisor
menu

History
of connections
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User groupware in practice

3.1 Adding the user groupware to an application

1 Overview
An application must define the role of different
contributors. Several access levels can be defined
according to the user.
All users have different responsibilities and
requirements. Their field of action must therefore
be more or less limited.
Let’s take a simple example: a sales management
application that offers the following features:
• View prices,
• Modify prices,
• Enter orders,
• Entering customers.

3 Implementing the user groupware

Access may vary according to the user. For example:
• administrative assistants can see the price list
and create orders.
• sales representatives can see the price list,
place orders and create new customers.
• sales directors have access to all options.
To manage these access levels in your WINDEV
applications, simply integrate the User Groupware.
In just a few clicks, a standard application can be
transformed into an application that manages
several access levels. This feature can be easily
implemented.
When starting the application, the manager will be
able to create users (identified by their username
and password) and give them access to some
application features.

To implement the User Groupware in a WINDEV
application:
1. On the "Project" tab, in the "Project" group, click
"User groupware".
2. In the description window of the current project
configuration, in "User Groupware: Disabled", click
"Change".
3. The User Groupware settings window allows you
to enable the User Groupware and define:

2 How does the user groupware work?
An application that uses the User Groupware has
two levels:
• user level.
• supervisor level.

2.1 User level
The user logs in to the application and accesses
the available features.
Remark: You can also log in using an LDAP
directory.

2.2 Supervisor level
The supervisor logs in to the application and
accesses an advanced menu to configure users
and their rights, or to start the application.
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The configuration window allows the supervisor to:
• start the application.
• configure the groupware.
Configuring the groupware consists in creating
and associating users and groups, and managing
the rights granted to each user (or group) on each
window of the application. Rights can be defined
for menu options, groups of controls and controls.
The supervisor can gray out these elements, make
them inactive or invisible. These configurations
take precedence over any configuration defined in
the program.
For more information on the groupware
configuration defined by the supervisor, see
Configuring the application that uses the User
Groupware.
Remark: The information regarding the users and
their rights is stored in data files in HFSQL format
(Classic or Client/Server).

• The type and start mode of the User Groupware.
• The type of customization.
• The type of database and the location of the
User Groupware data files (Standard User
Groupware).
• The user authentication mode (Standard User
Groupware).
• The use of a specific connection service
(Standard User Groupware).
• The BaaS mode settings.
Type of User Groupware
There are various types of groupware:

• Standard User Groupware: The User Groupware
will be integrated in its "Standard" version: the
User Groupware will be associated only to your
application, and the rights will be defined from
the application.
If this option is selected, two specific tabs are
displayed:

• the "Files" tab, which allows you to specify the
type of database and authentication used.
• the "OAuth" tab, which allows you to specify
the connection services available to users.
• BaaS User Groupware: This option allows you to
integrate a BaaS (Backend as a Service) User
Groupware, and to manage rights via a server.
If this option is selected, two specific tabs are
displayed:
• the "BaaS" tab, which allows you specify the
characteristics of the BaaS server, the user
accounts and the URLs of the administration
sites.
• the "Email" tab, which allows you to customize
the messages to be sent to users (registration
validation or password reset emails).
BaaS User Groupware: Required configuration:
Two cases may occur:
• You are using a PCSCloud platform: the
required elements are installed by default on
your platform.
Reminder: PCSCloud is a paid, turnkey solution.
• You are not using a PCSCloud platform: install
the following elements:
• an HFSQL server,
• the reserved server, including the modules for
the Mobile User Groupware (WDBaaS).
For more details, see the online help.
Starting the User Groupware
Several start modes are available:

• The "Automatic start" option indicates that the
User Groupware is started at the same time as
the application.
The User Groupware login window is started
before any other window of the application. The
project initialization code is executed once the
login window is opened and validated.
• The "Manual start (through programming)"
option allows you to define when the User
Groupware should be started.
The login window will only be opened if
gpwOpen (or gpwLogin) is used. This option
can be used to execute the project initialization
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code before opening the login window. This
option is useful for a multilingual application for
example: a window can be displayed to ask for
the application runtime language.

3.2 User groupware options (standard and
BaaS mode)
There are multiple User Groupware customization
modes:

• No customization:
WINDEV takes care of everything. Simply start
the application to configure user access.
The windows of the User Groupware can
automatically use the skin template of the
application. Simply check "Apply project
skin template to non-customized windows at
runtime".
To get the same appearance for all the windows
of the application, it is recommended to always
check this option if you use the User Groupware
in non-custom mode.
• Customize the login UI:
The login/register window is automatically
integrated into your application. The internal
component named WDGPU is included in
your project. This component contains the
login window and the associated procedure.
You can customize the connection to the User
Groupware.
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• Full customization (expert mode) - Standard
User Groupware only:
The programming of the User Groupware is
automatically included in your application. The
internal component named WDGPU is included
in your project. This component contains an
analysis as well as all the windows, queries,
classes and procedures required to manage the
User Groupware. This allows you to customize all
the windows used by the User Groupware.
The option "Apply project skin template to noncustomized windows at runtime" applies the skin
template of your project to the windows specific
to the User Groupware if they have not been
customized.
The security options are as follows:
• Allow opening windows and reports by default:
This option allows all users to open windows and
reports by default. In this case, simply specify
which elements will not be accessible when
configuring the rights.
• Allow editing reports and queries in "Reports
& Queries": If this option is checked, the
application will use "Reports & Queries" for all
the reports and queries.
Remark: This option is identical to "Enable
"Reports & Queries"", in the "Advanced" tab of
the project description.
The option "Automatic login for test mode"
allows you to specify the username and password
to be used in the "Automated test" mode. This
information will be used if an automated test is run
on the application.
By default:
• data files are in English. To use data in French,
simply check "Data files in French".
• User Groupware data files have a specific
password. This password is: "PCSGPW2001".
To change this password, enter the new
password in the "Options" tab of the User
Groupware description window. Characters are
shown as bullets.
Remark: This password is used when re-indexing
or opening data files with WDMAP for example.
For more details, see the online help.

3.3 Options specific to the standard user
groupware
If you use the standard User Groupware, the "Files"
tab allows you to configure:
• the type of database used (these options are
available in "Automatic start" mode only).
• the type of authentication:
• Authentication managed by the WINDEV User
Groupware.
• Authentication from an LDAP directory.
• Windows authentication.
Database type
In "Standard User Groupware" mode, the User
Groupware uses several specific data files. These
data files are mainly used to manage users,
groups, rights and elements in the application. The
standard User Groupware can be used:
• with HFSQL Classic data files. In this case, you
can specify the location of the data files via the
"Default directory" link.
• with HFSQL Client/Server data files. In this case,
you can define the parameters for accessing the
HFSQL Client/Server database as well as the
file directory by selecting "Click here to enter the
server parameters".
Type of authentication
The standard User Groupware includes several
user authentication modes:
• Authentication entirely managed by the User
Groupware:
The username and password are saved in the
User Groupware data files.
• Authentication from an LDAP directory or Active
Directory:
If the company of your customer uses an LDAP
directory, you can enable the User Groupware
on this directory. Simply click the link "Click here
to enter the server parameters" to specify the
characteristics of the LDAP directory (server,
port, base DN, etc.). Therefore, the account
and the password in the LDAP directory will be
automatically requested to the user. For more
details, see the online help.

• Windows authentication:
In this case, the username and password
correspond to those defined for Windows.
Remark: You can also use a unique
authentication. In this case, the username
and password will be requested only once per
session.
Depending on the option chosen, additional options
may be available:
• Login window only (no management of
rights): This option is only available for LDAP
and Windows authentication. If this option is
checked, no groupware data file will be created.
If the application is started in automatic mode,
the user will need to log in. If the user is saved
in the LDAP directory, the application will start;
otherwise, it will be closed. A supervisor cannot
configure the rights on the windows. If this
option is not checked, only the users in the LDAP
directory will be able to log in. You can set the
rights on the windows.
• Single authentication (SSO): This option
allows you to enter the password only once per
Windows session.
The "OAuth" tab allows you to authorize the use
of a specific connection service. For the specified
service, it is necessary to specify the corresponding
identifiers (provided when registering the
application with the selected service).

3.4 Options specific to the BaaS user
groupware
When using a BaaS User Groupware, the "BaaS"
and "Email" tabs allow defining specific options.
The "BaaS" tab allows you to define:
• the location of the User Groupware application
server. You can select a PCSCloud platform or a
Network or Internet server,
• the user account management mode,
• the URLs of the administration sites.
The "Email" tab allows you to write the messages
for registration confirmation or password recovery.

Part 4: Advanced concepts

131

3.5 Testing the application

3.6 Creating the WINDEV executable

When an application that uses the standard User
Groupware is tested, the first window that appears
is the login window (regardless of the first window
defined in your application).
A single user is created by default: the supervisor.
To log in as supervisor, simply enter the following
information in the login window:
• Name : SUPERVISOR
• Password: SUPERVISOR
You can test your application, or configure the User
Groupware.

When creating an executable that uses the
standard User Groupware ("Generate" option on
the "Project" tab), the wizard will show a screen
specific to the standard User Groupware.
This allows you to define the location of the User
Groupware data files.

Remarks:
• To set a first window other than the login window
in your application, select "Manual start (through
programming)" in the "General" tab of the User
Groupware options. Simply use gpwOpen to
open the login window.
• The User Groupware management windows are
executed before the project initialization code.
• The window of your application defined in the
project will be opened after the login window (if
the user is not the supervisor).
• In the "Options" tab of the User Groupware
configuration window, you can define the
username and password to be used for the test
mode. The password will no longer be requested
when you click GO to test the window or project.

2. Select "Configure groupware".

3.7 Installing an application that uses the
user groupware
An application that uses the User Groupware is
installed like any other application: on the "Project"
tab, in the "Generation" group, click "Setup
procedure".
The wizard proposes a screen specific to the
standard user groupware to set the location of user
groupware data files.
Remarks:
• If the User Groupware data files have been
configured for your client, they must be selected
when preparing the setup. Therefore, the list of
setup files must be customized.
• If the groupware data files have not been
configured, the Supervisor will be the only user
in the application the first time it is started.
Tip: If you do not configure the different User
Groupware use levels for your clients, we
recommend that you provide them with a
document listing all the controls used in your
windows in order to get an optimized configuration.

3. The User Groupware management window
appears. This window is used to:
• manage users and groups,
• manage rights,
• display statistics,
• migrate data coming from a User Groupware
version 17 and earlier.

4.1 Managing users
The user management consists in:
• creating users,
• creating groups,
• associating users with groups.

4 Configuring the application that uses the standard user groupware
When the application is deployed, the standard
User Groupware is configured by the application
supervisor.
This configuration consists in creating users and
groups of users, and granting them specific rights
for each control in each window of the application.
These rights are used to gray controls, groups
of controls or menu options, and to make them
visible or invisible.
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To configure the standard User Groupware, simply:
1. Start the application (executable or test from
WINDEV) and log in as supervisor:
• Name : supervisor
• Password: supervisor

To create a new user, you must specify:
• the user’s last name.
• the user’s first name.
• the username (mandatory). This username is the
identifier used to log in to the application.
• the user’s password. This password is optional
and can be entered by the user the first time
they log in (check the corresponding option).

The user can be defined as supervisor of the
application.
You can also modify or delete users. When you
delete a user, you can delete the entire user or
their rights only.
Users can be grouped.
To associate a user with a group, simply drag the
user and drop it onto the selected group.
A user can be associated with several groups.
Remarks:
• It is recommended to change the supervisor’s
password the first time you use the application.
• If you use an LDAP directory, you can import the
users form the directory to manage their rights.

4.2 Managing rights
The supervisor can manage the rights granted to
each user (or group of users) on the elements of
the project windows.
A specific state can be defined for all the elements
of a window associated with a user.
The elements in the windows, internal windows
and window templates are as follows:
• controls.
• groups of controls.
• menu options.
The following states are available for each element:
• Default: the element behavior corresponds to
the default behavior, defined in the application.
• Inactive: the element is displayed but no input
can be performed.
• Grayed: the element is grayed. No input can be
performed.
• Invisible: the element is not displayed.

4.3 Displaying statistics
You can get application usage statistics by user for
a specific period.

4.4 Migrating data
From version 18, the User Groupware has been
optimized. The data files used by the User
Groupware have changed.
The User Groupware administrator can migrate
the existing data to the new format and therefore
automatically retrieve the data used in the
earlier versions. This migration can be performed
regardless of the data format: HFSQL Classic,
HFSQL Client/Server or Native Connector.
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5 Tips for an application that uses the user groupware
5.1 Using groups of controls

5.2 Visibility of controls

To simplify the configuration of the groupware
management according to the users, it is
recommended to use groups of controls.
You can create groups of controls in your windows
according to the controls to be displayed for a
specific user.
The ability to associate a control with several
groups of controls increases the number of
possible combinations.
These groups of controls can be created in your
application for managing the groupware, no
specific programming is required.

When developing your application, you can define
the visibility options of the elements in your
windows:
• in the element description (7-tab window).
• through programming (State or Visible
properties).
When configuring the User Groupware, the
supervisor can define different visibility options.
The options defined by the supervisor have priority.
For example, a button is used to make a control
active. This control was grayed out by the
supervisor. Your code will be ignored and the
control will not be active.

Multilingual
applications

Contenu

A multilingual application is an application that can be distributed in several languages. WINDEV
Mobile takes into account the different languages of the application during the entire development
of an application.
The main steps for developing a multilingual application are as follows:

5.3 Defining rights
To define the rights corresponding to the features
of your application, it is recommended to:
• set the rights according to the application
user’s requirements before creating the setup
procedure. Simply add the groupware data files
when you create the application setup.
• provide a technical documentation that includes
the names of controls, groups of controls and
options that must be configured according to the
usage level defined for the application.
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1

Choose the languages

2

Translate the project elements

- Project
- Analysis

- Direct translation
- Translation via WDMSG, WDINT,
WDTRAD, ...

3

Programming

Data files

- Choose the application language
(Nation function)
- Choose the character set
(ChangeCharset function)
- Choose the keyboard language
(ChangeKeyboard function)

- Choose the character set
(ChangeCharset function)
- Take the character set into account when
creating the files (HCreation* function)
- Take the character set into account when
reindexing (HIndex function)

4

Executable

5

Setup program

Choose the library languages

- Available languages
- Translate the setup program
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Multilingual applications in practice
1 Overview
A multilingual application is an application that can
be distributed in several languages. The different
application languages will be taken into account
during the different development steps.
The main steps for developing a multilingual
application are as follows:
1. Choosing the languages supported by the
project and the analysis.
2. Writing the different elements (window, code,
etc.) in the different languages of the project.
3. Defining the project language through
programming.
4. Managing specific character sets in the data
files.
5. Creating the executable and the setup program.

Remarks:
• If the operating system supports several
languages (Hebrew, Arabic, Greek, etc.),
the corresponding character set will be
automatically used when translating to these
languages.
• If your application is a multilingual application,
this feature must also be managed in the
windows of the user groupware and in the
windows for automatic management of HFSQL
errors. For more details, see the online help.
• The management of Unicode is available in the
HFSQL data files, the window controls and the
WLanguage code.

2 Choosing the languages supported by the project and the analysis
2.1 Languages supported by the project
The different languages supported by the project
are defined in the project description:
1. On the "Project" tab, in the "Project" group, click
"Description". The project description window
appears.
2. In the "Languages" tab, you can add or delete
the languages supported by the project.
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The selected languages will be proposed for all
multilingual resources that can be translated
(captions of controls, menu options, help message
associated with a control, etc).
When changing the project language, changes will
be automatically taken into account:
• for each new element or object created in the
WINDEV editor,
• for each new element or object opened in the
WINDEV editor.
The main language corresponds to the language
used by default at runtime.

Linguistic options
The "Languages" tab of the project description also
allows you to define all language-specific options:
number, currency, date, ...
The parameters used by default are the ones
defined in the Windows language options
(accessible from the Windows control panel).
When creating an edit control or a column in a
Table control that displays numeric data (number,
currency, date, time, etc.), the input mask applied
will be the mask defined in the project language
options. This option is available in the windows.
At runtime, when an edit control or a a column in a
Table control has a mask "Defined by the project",
the input/display mask will automatically adapt
according to the options selected in the project for
the language displayed at runtime.
Remark: The linguistic options are also used to
define the writing direction and the character set
used ("Various" option).
Executable program
When creating the executable program, you have
the ability to specify the languages that will be
taken into account by the executable. You can for
example create a different executable program for
each language supported by the project.
This feature is used to reduce the executable size.

2.2 Languages supported by the analysis
If your project uses an analysis, the languages
supported by the analysis are selected in the data
model editor. The same analysis can be shared
between different projects that do not use the
same languages. Therefore, the analysis might use
more languages than the project.

The different languages configured in the analysis
will be proposed:
• when configuring the shared information of the
items. The description of the controls bound
to the items (options, captions, etc.) can be
entered in the different languages supported by
the analysis. When generating a "full application
RAD" or a window RAD, this information will
be automatically taken into account for all
languages common to the analysis and to the
project.
• for the information printed in the technical
documentation (notes of data files or items).
• for the information managed by "Reports and
Queries". Indeed, if "Reports and Queries" is
supplied with your WINDEV application, you
can translate the name of the data file and the
name of each item. Therefore, the user will be
able to use the names corresponding to his
own language when creating his reports and
queries. This information can be entered in the
"Reports and Queries" tab of the data file and
item description.

2.3 Languages supported by the different
project elements
By default, the different elements of the project
(window, reports, code, classes, sets of procedures,
etc.) support the same languages as the project in
which they were created.
An element can support more languages than
the project (when the element is shared between
several projects that support different languages
for example).

To configure the languages supported by the
analysis:
1. Open the project analysis in the editor.
2. Open the analysis description window: on the
"Analysis" tab, in the "Current element" group,
click "Description".
3. Select the "International" tab in the description
window of the analysis.
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3 Translating the interface into multiple languages
When the different languages supported by the
application have been selected, the information
displayed by the application must be translated
into these different languages.
Several elements must be taken into account to
write the UI in different languages:
• The selected translation mode.
• The supported languages (languages that use a
specific character set or not).
• The use of specific windows (user groupware,
automatic management of HFSQL errors, report
viewer).
• The messages displayed through programming.

3.1 Translation method
WINDEV proposes several translation modes:
• Automatic translation of the UI via a specific
translation tool, installed on the development
computer. This translation is performed in the
WINDEV editor.
• Export all the messages via WDMSG and
reintegrate them once they have been
translated.
Translating the UI
For each element, different multilingual areas
are displayed in the description windows. These
multilingual areas allow you to enter information in
the different languages supported by the project.
To translate this information from WINDEV:
1. Display the WINDEV options for configuring the
translation options of the software used: on the
"Home" tab, in the "Environment" group, expand
"Options" and select "General options of WINDEV".
2. In the "Translation" tab, you can define:
• the default translation tool (and the
transmission mode for the text to translate
and for the translated text).
• the source and destination languages.
3. If a translation tool is specified, a "Translate"
button will be displayed in each element
containing information to translate. This button
is used to translate the selected text via the
specified translation tool.
4. Select the text to be translated and click
"Translate".
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Exporting and reintegrating the
information to translate
WDMSG is used to extract all project messages
(control captions, etc.) and reintegrate them once
they have been translated.
Contact PC SOFT Sales Department for more
details about the conditions for using this product.

3.2 Languages that use a specific character
set
If your application supports languages that use
specific character sets (Greek, Russian, etc.), the
different messages must be translated using these
character sets.
WINDEV allows you to automatically manage the
use of specific character sets in the editor.
When the text cursor is located in the input area of
a language that uses a specific character set, the
corresponding input language (character set used
by the keyboard) is automatically enabled.
Therefore, if a caption is entered in the Russian
section of the caption description, the keyboard will
automatically switch to the Russian character set.
Reminder: To use specific character sets, the files
corresponding to the desired character sets must
be installed in the Windows region settings (control
panel).

3.3 Translating specific windows
HFSQL error management
By default, the windows for managing the HFSQL
errors are supplied in English and in French. To
translate them into another language, you must:
1. Include the default error windows in your
project. The windows are supplied (with their
WLanguage code) as example in \Programs\
Data\Preset windows\HFSQL - Automatic help
windows.
2. Customize the management of errors to use the
HFSQL windows for error management (HOnError).
3. Translate the different messages (see previous
paragraph).

Automatic management of errors
By default, the automatic error management
windows are provided in English and in French. To
translate them into another language, you must:
1. Include the default error windows in your
application. These windows are supplied (as well
as their WLanguage code) in \Programs\Data\
Preset windows\Assertion - Error - Exception.
2. Translate the different messages (see previous
paragraph).
User groupware
By default, the user groupware is provided in
English and French.
To translate an application that uses the user
groupware, you must choose a custom integration
when configuring the user groupware in your
application. Reminder: To configure the user
groupware, go to the "Project" tab, "Project" group
and click "User groupware".
During the custom integration, the different
elements of user groupware will be included via an
internal component.
Then, all you have to do is translate these
elements when translating the project.
Remark: If necessary, when configuring the user
groupware, in the "Execution", tab, select "Manual
run": this allows you to display a window for
selecting the application language before starting
the login window.
Report viewer
By default, the report viewer window is available in
English and in French.
To translate this window, you must integrate the
windows corresponding to the report viewer into
your application. These windows are supplied (as
well as their WLanguage code) in \Programs\Data\
Preset windows\Preview. For more details, see the
online help.
Then, all you have to do is translate these windows.

System menus
WINDEV offers a default popup menu for Edit and
Table controls. This menu allows the user to easily
perform several operations.
To translate these menus, you must own WDMSG.

3.4 Translating WLanguage code messages
In your code, several WLanguage functions allow
you to communicate with the user via character
strings. These messages must also be translated
into the different languages of your application.
To translate a character string typed in the code
editor:
1. Select the character string to be translated.
2. Select "Translate" in the context menu of the
selection. The window for translating messages is
displayed.
3. Type the translation and validate. The code line
is displayed in the code editor:

The
icon indicates that this string has been
translated to other languages. Click the icon to
open the translation window.
Remark: To transform all the messages in your
code into multilingual messages, go to the "Code"
tab, "Languages" group, expand "Translate strings"
and select "Convert simple strings into multilingual
messages".
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4 Choosing the language through programming
A multilingual application is an application that
can be distributed in several languages. The user
will be able to choose the language used by the
application at runtime. You can for example:
• prompt the user to choose the runtime language
the first time the application is started

• include an option (menu option or button for
example) allowing the user to change the current
application language.

5 Managing specific character sets in HFSQL data files
When an application is used to display or save
data in HFSQL data files, this data is typed in the
current language.
If the application is used in a country that uses
a Latin character set, no specific management is
required.

If the application is used in a country that uses
a specific character set, this character set must
also be supported by the data files. Therefore, the
searches, the sorts, ... will be performed according
to the selected character set.

Optimizing an
application

Contenu

WINDEV proposes several methods for optimizing your applications:
• The performance profiler, which allows you to quickly identify time-consuming processes. You
can then optimize the desired process.

Application test
Analyze the performance of the application
during a test and view the longest processes
to optimize the source code.
To start the performance profiler, go to the
"Project" pane, "Audit and performance"
group, expand "Analyze performance" and
select "Analyze performance".

6 Managing the Unicode format and specific character sets
WINDEV proposes two management modes:
• the single charset mode: In this mode, if your
application includes languages that use specific
character sets (Greek, Korean, etc.), change the
following elements through programming:
• the character set used by all screen fonts
(ChangeCharset). This character set can also
be used for the data saved in the HFSQL
files. For more details, see the online help
(keyword: Multilingual).
• the language of the keyboard used by the
application users (ChangeKeyboard).
• the full support of Unicode: This mode is used
to manage the non-Latin character sets. In this
mode, ChangeCharset and ChangeKeyboard
are useless. The change of character set
is automatically performed according to
the language options defined in the project
description. You also have the ability to mix
different character sets.
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The mode for managing the Unicode format
is configured in the options of the current
configuration ("Unicode" tab in the description
window of the configuration).
Important
If you choose to switch your projects to Unicode,
the ANSI/Unicode cohabitation generates some
constraints: The data must be translated when
switching from an encoding system to another one.
Exchanging text strings outside the application
must be adapted to take into account the new
memory representation of strings (in Unicode, 1
character is coded on 2 bytes while it is coded on 1
byte in ANSI): call to API, read or write to the disk to
exchange data, read or write to sockets containing
strings, ...
If you choose to switch your projects to UNICODE, a
wizard starts automatically to measure the impact
of this change.

• The Static Audit of the project which points out potential programming issues (empty groups,
orphaned elements, etc.) as well as large files that can cause abnormally long loading times.

Static audit
Audit report, analysis of the library (to detect
large files) and analysis of the setup package.
To start the static audit, go to the "Project"
pane, "Audit and performance" group, expand
"Edition audit" and select "Trigger edition
audit".
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• The project Dynamic Audit, which detects loss of resources, unprocessed errors and slowness
of the application in its production environment.

Dynamic audit
Analyze the performance of the application
during a test, view processes containing
exceptions and errors that are not properly
handled.
To start the dynamic audit, on the "Project"
pane, expand "Test mode" and select "Debug
the project while the audit is enabled".

Distributing "Reports &
Queries"

Contenu

With "Reports & Queries", which can be freely distributed with your applications, users will be able
to freely customize the reports you provide. Of course, only the reports you have selected can be
customized.

1

2

WINDEV project
Project description

Reports/Queries
Describe the reports & queries

Programming

3

RunReportsAndQueries function
Start “Reports & Queries” (optional)

Use the “?” menu (automatic)
Start from the preview (by default)

4
5
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Executable
Create the executable

Create Setup
Install "Reports & Queries"
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UMC: User
Macro-Code

User Macro-Code: UMC in practice

Contenu

The User Macro-Code (UMC) allows end users to enter their own WLanguage code and include it
in an existing application.
Let’s consider the following case:
A window for entering a customer form requires an email address but it does not check its
format. The user wants to check if the "@" character is in the address.

1 What is the UMC?
The UMC is an option allowing the advanced users
to create their own processes in the application.
The end user can type WLanguage code and
include it in an existing application.
The added processes can be forwarded to the
developer so that they can be added into the
source code of the application.

Several WLanguage features are accessible to
the user and restrictions can be defined by the
developer. For example, forbid the use of functions
for file management. To insure the integrity of data,
the commands for modifying or adding records are
not available to the user.

2 How to enable/disable the UMC?

An icon at the top of the window allows the user to
customize the processes.

The UMC configuration window is displayed. A
new action can be added by the user for this
window. In this case, the email address is
checked.

This feature can be disabled for a window or for the
entire application.
To disable the UMC on a window, check "Forbid the
use of U.M.C." in the "Details" tab of the window
description.
To manage the UMC on the project:
1. Open the project description window: on
the "Project" tab, in the "Project" group, click
"Description".
2. Display the "Advanced" tab. By clicking the
"User Macro Code" button, you have the ability to
allow or forbid the input of User Macro Code for
the entire application.

Two options will be available if you allow it:
• Allow the use of HFSQL commands
HReadFirst, HFilter, HAdd, ...).
• Accept the suggestions made by the users.
This second option allows the application to send
an email when the user creates a macro code.
The "*.MCU" file corresponding to the macro code
is sent in attachment. This allows you to easily
retrieve the suggestions made by the users and
automatically include them in your project! WINDEV
includes an option for importing "*.MCU" files (on
the "Project" tab, in the "Project" group, expand
"Import" and select "User Macro-Codes...").

The user types the WLanguage code. The F1 key is
used to display the WLanguage help.

To enable this feature (that is disabled by default), all you have to do is specify that the project
accepts the UMC:
• in the project description,
• when creating the executable.
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Available
tests

Contenu

WINDEV proposes several methods to test your application. The table below presents these
different modes.

To help you optimize your code, a debugger is supplied with WINDEV.
The debugger allows you to run your applications step by step, by viewing the WLanguage code
run, the content of variables, ...

Type of test
Test of entire project

Description
Simulates the start of the application by the executable.
Used to test the entire application, even if its
development is not completed.
As soon as a problem occurs in the execution of the
project, the debugger can be started to identify and fix
the problem.

Test of current element

Used to test this element as soon as its development is
completed.
The debugger can be run as soon as a problem occurs
in the reports or windows.

Test of a project step by step
(via the debugger)

Used to run the debugger when starting the application.
This solution is used to monitor the operating mode of
the application via the debugger.
You also have the ability to debug a specific executable,
an executable that is already run or an executable run
on another computer.

Unit test

Used to test windows, procedures and classes in an
application at different levels of development.
The test scenarios are automatically generated in
WLanguage from the application test or from the
element test. The scenarios can be directly modified in
the code editor.

Regression test
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Debugging the current project
1. Using a breakpoint, placed in the code editor.
The debugger will be automatically started when the line preceded by a breakpoint is run.
To insert a breakpoint, simply click to the left of the line of code: a red bullet appears :

Used to check the non-regression of an element
between the different application versions.
To do so, select (or create) the test scenario that will be
run.
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2. Using the STOP keyword in the WLanguage code
The debugger will be automatically started when this code line is run.
3. Using the "Debug project" option
The debugger is started when the application test is run. The option "Debug project" can be found
on the "Project" tab, under "Test mode".
4. Pressing Ctrl + Pause during the window or project test
The debugger starts with the action performed after using Ctrl + Pause.

Debugging an executable
WINDEV also allows you to debug the executable associated with the current project in WINDEV.
This executable can:
• be run from WINDEV, on the development computer.
• be currently run on the development computer.
• be run from WINDEV, on a remote computer.
• be currently run on a remote computer.

Unit tests/Automatic
tests

Contenu

Unit tests (also called automatic tests) are used to test windows, procedures and classes in an
application at different levels of development.
To do so, select (or create) the test scenario that will be run.
These scenarios are generated in WLanguage and they can be directly modified.
These scenarios are grouped in the test editor. The test editor analyzes the result of unit tests and
calculates the validation rate of the application.

1

Creating a test scenario
WINDEV window in the editor

1

Using a test scenario
(classes and procedures)
Display test editor

Debugging a component
A component is debugged from the component project. You can:
• Run the component test from the component project.
• Run the component test by running another project found on the development computer. This
allows you to test the component from the project that uses it.
• Run the component test by running an executable found on the development computer. This
allows you to test the component directly from the executable that uses it.

2
3

Record test scenario

WLanguage code of test scenario

2
3

Run test

Correction

Result of the test

To create a unit test on the current window, go to the "Automated tests" tab, "Tests" group, expand
"New" and select "Record a new scenario".
To create a unit test on a procedure or on a class method, select the procedure or class method in
the "Project explorer" pane and select "Unit tests .. Create a unit test" in the context menu.
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Unit tests on the
executable

Application test in practice

Contenu

The unit tests created with WINDEV can be run on a deployed executable, via the test robot.

1

Configuration of
the test robot

4

Test robot

Save the result
in the database
of Control Centers

- Executable path
- Path of test data

3

Results of the tests

WD2XXTest.DLL

2
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Start the executable
deployed in test mode. The
test data is used.

Executable deployed

Test data

with:
- Its framework
- Its data files

with:
- The test library (WDL)
- The test data (“Data of automatic
tests” directory)
- The data files used for the
tests (if necessary)
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1 Overview
WINDEV offers several methods for testing your
applications:
• test of the entire project,
• test of a single window,
• test of a single query,
• test of a single report,
• step-by-step project execution,
• performance test of your application,
• regression test/automatic test.

A test of a single report runs the current report
only. This allows you to check the implementation
of a report as soon as it is developed. Like for the
project test, the debugger can be started as soon
as a problem occurs.

By testing the project you can simulate how
the application will run when launched from an
executable. This allows you to test the entire
application, even if it is not complete. As soon as
a problem occurs, you can start the debugger to
identify and fix the problem.

The performance test allows you to check and
optimize the execution time of your application.

The window test is used to run the current window
only. This allows you to test your project from a
given window or to test a window once it has been
finished. Like for the project test, the debugger can
be started as soon as a problem occurs.
A test of a single query runs the current query only.
This allows you to check the operating mode of a
query as soon as its development is complete.

The step-by-step project execution allows you to
start the debugger when starting the application.
This solution allows you to monitor the application
progress.

The regression test (or automatic test) is based on
the execution of scripts. It is used to check that the
existing features are still supported when running
your applications.
In addition to these different methods, WINDEV
also proposes to find out the "Code coverage" of
application, which means the measurement of
coverage for the tests run on an application. For
more details, see the online help.
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2 Testing and debugging a WINDEV project (development computer)
2.1 Overview
The test of the entire project allows you to simulate
the start of the application with the executable.
This allows you to test the entire application, even
if it is not complete. As soon as a problem occurs in
the execution of the project, the debugger can be
started to identify and fix the problem.
WINDEV proposes an extensive set of application
tests that can be run from the development
computer:
• Test and debugging of the current project in the
editor.
• Execution and debugging of the executable
corresponding to the current project.
• Debugging of an executable already run on the
development computer.
Remark: The test of a project can be run regardless
of the current element in the editor.

2.2 Testing and debugging the current project
To test a project from the editor, go to the "Project"
tab, expand "Test mode" and select "Debug project"
(Ctrl + F9). The editor is automatically minimized
and the project is run.

2.3 Testing and debugging the executable
on the development computer
Some problems can only be reproduced when
running the executable test in real-use conditions.
This test mode allows you to debug an executable
once it is installed on the development computer.
In this case, the code run comes from the libraries
(and not from the code found in the elements
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found on the computer). Therefore, the code of
current project and the executable code may
become out-of-sync: the out-of-sync code is
highlighted in pink during the debug operation.
This test mode is used to run a specific executable
installed on the development computer and to
debug it directly.
For more details, see the online help.

3 Testing and debugging a WINDEV project on the user computer
WINDEV offers several methods to test and debug
a project on the development computer. However,
in some cases, you may have to debug on the
end-user computer (connected by network or by
Internet).
From your office in London, you have the ability
to debug an application that is run in Taiwan. The
debug operation is performed without having to go
anywhere, directly on the user configuration.

2.4 Debugging an executable already run
on the development computer
Some problems can only be reproduced when
running the test of the executable in real-use
conditions.
This test mode allows you to find a problem that
only occurs at runtime (and not in test mode).
The principle is simple:
• The developer starts the executable on their
computer and directly goes to the desired
location in the application.
• In WINDEV, the developer opens the project
corresponding to the executable and asks to be
attached to the executable run.
• The debugger in WINDEV is used to monitor the
program execution step by step.
In this case, the code run comes from the libraries
(and not from the code found in the elements found
on the computer). Therefore, the code of current
project and the executable code may become outof-sync: the out-of-sync code is highlighted in pink
during the debug operation.
For more details, see the online help.

Two features are available:
• Running and debugging the executable on a
remote computer,
• Debugging an application that is currently run on
a remote computer.
For these two features, a specific configuration is
required for the remote computer.
Remark: to debug a WINDEV application remotely,
the application must include the WD270CPL.DLL
library in its framework.
For more details, see the online help.

4 Testing a window
4.1 Testing the window from the editor

4.2 Stopping the window test

To test a window from the editor:
1. Open the window whose test must be run.
2. Click
in the quick access buttons (or press
F9). The editor is automatically minimized and the
window is run.
During the test, all window features can be run.
You will have the ability to open other windows for
example.

Several methods can be used to stop the test:
• 1st method:
Close the application whose test is currently
run. WINDEV displays editor that was used when
starting the test.
• 2nd method:
• Go back to the editor with the taskbar or
press Alt + Tab.
• Confirm that the test must be stopped.
WINDEV displays editor that was used when
starting the test.
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5 Tracing a project
5.1 Debugging principles
Debugging an application consists in:
• checking the operating mode of a process,
• understanding the operating mode of an existing
program,
• checking the value of variables,
• checking the operating mode of special cases in
an application.
The debugger is used to perform these operations.
Remark: WINDEV also includes multiple trace tools
(trace window, information box, etc.). For more
details, see "Debugging without debugger", page
154.

5.2 Debugger overview
The debugger is used to trace the WLanguage
programs in order to help you improve these
programs.
The source code run is viewed on the screen. The
processes run are sorted in hierarchical order in
the "Debugger" pane.
The value of variables can be viewed:
• individually in the on-hover tooltip of each
variable.
• in the "Debugger" pane.

5.3 Debugger features
The debugger is used to:
• find out the call stack,
• view the content of variables or expressions,
• run the code step by step with ability to skip
blocks,
• use conditional breakpoints,
• modify the code while continuing the execution,
• ...

5.4 Debugging without debugger
In some cases, running a program with or without
debugger may be different.
Indeed, the debugger introduces pauses in the
execution of the process during which several tasks
are performed by WINDEV.
Therefore, the debugger cannot be used in a
procedure called by a timer or in the code of a
scrollbar.
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Remark: For more details, see the online help
about the debugger limits.
To debug these applications, you may want to follow
the changes of a value, how different procedures
are called, etc.
This information can be:
• displayed on the screen.
• stored in a trace file.
Caution: If the information is displayed on the
screen, it must be displayed during the application
tests only.
Displaying information
Two tools can be used to display information:
• the information boxes: Info.
Caution: When displayed, information boxes
block the application.
• the trace window: Trace.
The trace window appears in the upper-left
corner of the screen, without interrupting the
program.
Managing the display of the debug
information
Displaying the debug information on the screen is
useful in test mode only.
Any unsuitable display must be removed before
distributing an application.
To avoid any oversight, it is recommended to
manage how the debug information is displayed
via a global procedure. For example:
PROCEDURE MyTrace(StringToTrace)
IF InTestMode() = True THEN
Trace(StringToTrace)
END

In this code, depending on the result of
InTestMode, the trace window appears during the
application test only.
Such procedure allows you to leave the call to the
trace windows in the application code without any
risk of displaying it on the end-user computers.
The call to this trace procedure is identical to the
use of Trace:

Creating a trace file
During long processes (batch processes, etc.),
to check the operating mode of the program, you
must keep a physical trace of the processes run (a
text file for example).
The following procedure is used to manage the
trace display:
• on the screen (/DEBUG parameter in command
line).
• in a text file (default mode).
PROCEDURE MyTrace(StringToTrace)
FilePath is string
FilePath = fDataDirUser() +
ProjectInfo(piProjectName) + ".txt"
File is int
DebugMode is boolean = False
IF Position(CommandLine(), "/DEBUG")
> 0 THEN
DebugMode = True
END
IF DebugMode = True THEN
Trace(StringToTrace)
ELSE
File = fOpen(FilePath, foCrea
teIfNotfound + foWrite + foAdd)
IF File <> -1 THEN

		
DateTimeTrace is DateTime
		
DateTrace is Date
		
TimeTrace is Time
		
DateTimeTrace = SysDateTime()
		
DateTrace = MyDate..Date
		
TimeTrace = MyDate..Time
		
fWriteLine(File,
DateToString(DateTrace) + ...
		
" - " +
TimeToString(TimeTrace))
		
fWriteLine(File, StringToTrace)
		
fWriteLine(File, " ")
		
fClose(File)
END
END

Remarks:
• The trace file is created by default in the user
data directory. This file is named like the project.
This file contains the information to trace during
the program execution.
The information is completed by the date and
time of each "Trace". This allows you to detect a
potential problem during the process.
• Example of trace file content:
01/12/2015 - 10:53:25:20
Customer name: Montgomery

6 Performance test
6.1 Overview

6.2 Starting the performance profiler

The performance profiler is used to check and
optimize the execution time of your application.
Its principle is straightforward:
You test your application. During the test, the
performance profiler keeps track of all the actions
performed and the corresponding processes run.
At the end of the test, the performance profiler
displays:
• the 10 most time-consuming operations
• all the actions performed in the application
whose test was run, sorted by duration (from the
longest one to the shortest one).
You can select a process in order to analyze the
reasons for its processing time in order to optimize
it.

To start the performance profiler, go to the
"Project" tab, "Audit and performance" group,
expand "Analyze performance" and select "Analyze
performance".
The project is automatically run in test mode. The
process to optimize can be run in your application.
To go back to the editor, all you have to do is close
your application.
Then, the performance profiler displays the result
of the analysis.
Remark: We recommend that you use the
performance profiler to optimize your application
(before it is distributed for example).

MyTrace("Customer: "+ ...
Customer.CustomerNum)
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6.3 Reading the performance profiler results
The performance profiler presents the result of the
analysis in several tabs:
• the "Summary" tab presents the ten longest
processes.
• the "Mapping" tab presents a graphical view of
the main processes.
• the "Details" tab presents all processes run
during the application test (from the slowest one
to the fastest one).
• the "Calls" tab is used to see the details of
operations performed in a process.
The following information is displayed for each
process:
Function

Function, event, process or
procedure run.

Total Time

Function execution window.

Nb of calls

Number of calls made to the
function (procedure, event or
process).

Time 1 call

Execution time of a call to the
function (procedure, event or
process).

code %

Percentage of code run outside
the call to a WLanguage
function or outside the call to a
custom function or procedure.

Parent

Process that called the
function.

Remarks:
• The "Full execution" caption represents the total
amount of time for running the application test
with the performance profiler.
• The "Total for XXX Window" caption represents
the total amount of time for running the XXX
window (from its opening to its closing).

6.4 Choosing a process to optimize
The process to optimize is chosen according to
several criteria:
• the process execution time. The longest
processes must necessarily be optimized.
• the percentage of time spent in the process
of the function or procedure. The higher this
percentage is, the greater the number of
processes that can be optimized in the code.
Remark: If the process corresponds to a
WLanguage function, it is fairly hard to optimize it.

7 Regression tests
7.1 Overview
To test a window from the editor:
1. Open the window whose test must be run.
2. Click
in the quick access buttons (or press
F9). The editor is automatically minimized and the
window is run.
During the test, all window features can be run.
You will have the ability to open other windows for
example.

7.2 Automatic tests
Each test contains a scenario that can be directly
edited in the product interface. This scenario is
written in WLanguage and it can be modified at
any time.
These tests can be run before creating the
executable in order to check the operating mode of
an application.
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The following elements can be checked:
• the WINDEV windows.
• the sets of procedures.
• the classes.
• the WINDEV executables.
Each test is associated with a WLanguage code: the
test scenario. This scenario can be viewed in the
code editor. The code of the tests can be modified.
The tests and the associated code are not included
in the executable and they are not supplied to the
end users. The number of tests has no impact on
the size of the application available to end users.
For more details, see the online help (keyword:
"Automatic test").
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The WINDEV
framework

Contenu

The WINDEV framework is the set of libraries (.DLL files) required to run a WINDEV application.
When creating the executable, you can choose to use:
• the framework beside the executable,
• the framework included in the executable,
• the common WINDEV framework.

Using a framework beside the executable
When using a framework beside the executable, the libraries are installed in the directory of each
application. Therefore, each WINDEV application uses its own version of libraries. You have the
ability to rename the libraries when using a framework beside the executable.
Benefits of framework beside the executable:
• Each application can exploit a different version of framework DLLs.
• The framework of a given application can be updated without impacting the other applications.
• The framework can be renamed.

Using the framework included in the executable
When using the framework included in the executable, the executable is stand-alone. The
framework DLLs are not extracted when running the executable.
Benefits of framework included in the executable:
• Stand-alone executable.
• No extraction of framework DLLs.
Remark : Depending on the features used by the application, it may not be possible to use the
framework included in the executable.
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Using the common WINDEV framework
When using the common framework, the libraries are installed in a common directory. These
libraries are shared by all the WINDEV applications installed on the same computer.
Benefits of the common framework:
• The disk space used by the framework (about 30 MB) is shared by all the applications.
• The framework is updated once only for all the applications installed.
• The common framework can be renamed.

The different modes for
installing an application

Contenu

Individual setup
The individual setup consists in creating a setup program that will be installed on each user
computer via a setup media.

Remark : When using the common framework, you have the ability to replace one or more DLLs (if
a specific version is required for example).

Computer
of User 1

Development
computer
Create the
executable

Create the
setup program

Setup

Setup media
(CD-ROM,
USB key, ...)

Use the
application

This setup mode is compatible with:
• data files in HFSQL Classic format installed locally on the user computer,
• data files in HFSQL Classic format installed in network and accessible from the user computer,
• data files in HFSQL Client/Server format installed on a server.
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Network setup (with automatic update)

HTTP setup (with automatic update)

The network setup consists in creating a setup program that will be installed on a server. All the
user computers that want to install the application will start the application setup via the network.

The HTTP setup consists in creating a setup program that will be installed on a Web server.
All the user computers that want to install the application will start the application setup via an
HTTP URL.
If an update is available on the Web server, the application update will be proposed when the
application is started on the user computer.

Development
computer

Computer
of User 1

Create the
executable

Use the
application

Computer
of User 1

Development
computer
Create the
executable

Create the
setup program

Use the
application
Create the setup
program

Setup via
setup media

Application
server

Install the
application
via network

Install
the reference
version
(client
setup)

If an update is available on the application server, the application update will be proposed when
the application is started on the user computer.

Setup
via setup
media

Web
server

Install the
application
by Internet

Install the reference
version (client setup)

A network setup allows for an extensive check of the user computers (versions deployed,
mandatory updates, disconnection of users, etc.)
This setup mode is compatible with:
• data files in HFSQL Classic format installed locally on the user computer,
• data files in HFSQL Classic format installed in network and accessible from the user computer,
• data files in HFSQL Client/Server format installed on a server.
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Multi-site setup (with automatic update)

Push network setup

The multi-site setup allows you to install an application on several different sites (a site can
represent a subsidiary for example).
The multi-site setup consists in creating a setup program that will be installed on a Web server.
All the sites that want to install the application will start the application setup via an HTTP URL. In
this case, the setup program will be installed on a server of the site.
All the user computers that want to install the application will start the setup via the network.
This setup combines the benefits of the network setup and HTTP setup by allowing a large-scale
deployment as well as a granular control of local setups.

The network setup consists in creating a setup program that will be installed on a server.
The setup will be performed from the server, by the network administrator on the user computers
selected by WD2xxAdminExe.

Development
computer

Computer
of User 1

Development
computer

Computer
of User 1

Create the
executable

Create the
executable

Use the
application

Use the
application
Create the
setup
program

Setup
via setup
media

Create the
setup program

Web
server

Setup
by Internet

Application
server

Install the
application
via network

Install the
reference
version (client
setup)

Install
the reference
version (client
setup)
Ask for setup
(via a Web page)

If an update is available on the Web server, the application is automatically updated on the
application server.

Setup
via setup
mediat

Application
server
Install the
reference
version
(client setup)

Install the
application
on the user
computer
via network

WDAdminExe:
Run the setup on
one of the user
computers

Network administrator

A Push setup can be updated either in Push mode, or as part of a network setup.
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Deploying a WINDEV application
When developing an application, one of the
important steps consists in deploying this
application on the user computers.
WINDEV optimizes this deployment by proposing a
large choice:
• in the setup media.
• in the tools used to create the setup program.

1.2 Tools for creating the setup program

• in the different setup modes (single computer or
network).
This chapter briefly describes the different types
of setup proposed by WINDEV and their specific
features.
For more details, see the online help.

Wizard
Create a standard setup program (in X (recommended)
French and in English by default)

X

Maintain a setup program

X

Start mode

1.1 Setup media
Depending on the setup media used (Internet, inhouse network, etc.), WINDEV offers multiple setup
generation modes.
To optimize your setup, choose the recommended
generation mode.
Self-extracting
executable

Multiple
directories

Single directory

CD ROM/DVD
ROM

X
(recommended)

CD ROM/DVD
ROM
In-house
network

X

X

On the "Project"
tab, in the
"Generation"
group, click
"Setup
procedure".

1.3 Different types of setup

Setup generation modes offered by WINDEV

Internet

X

X

X
(recommended)
Autorun
possible

X

X
(recommended)

X

Two types of setup are available in WINDEV:
• Individual setup: recommended for single-user
applications.
The setup program installs the application on
the user computer.
• Setup with automatic update: recommended for
multi-user applications.
The setup with automatic update is performed
in two steps:

Part 5: Setup

WDSETUP
customization

X

X (multilingual
setup for example)

On the "Tools" tab, in
the "Utilities" group,
click "WDInst".

WDSETUP project
available in
the "Examples"
subdirectory of
the WINDEV setup
directory.

• The reference application is installed on the
server. The reference application corresponds
to the setup program of the application on the
user computers.
• The final application is installed on each
user computer by running the setup program
found on the server. The updates will be
automatically performed when the reference
application changes on the server.

2 Creating the setup program
Individual setup
Different types of setup are available:
• Standard setup
The setup program is independent of the
application. All the files required by the
application are installed on the user computers.
To take an update into account, this update
must be run on each user computer.
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WDInst setup editor

Customize a setup program (the
program that is started on the user
computer)

1 Setup: Summary table

Supports

Different tools are available to create, maintain
and customize the setup program.

• Compact setup
A standard setup is performed. However, the
setup program is smaller because it does not
use specific DLLs and some customization
options are not available.
• Setup via MSI package
A standard setup that uses the features of the
integrated Windows installer is performed.
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Setup with automatic update
Different types of setup are available:
• Setup in local area network (LAN) with "Push"
possibly enabled. A first application setup will be
performed on the network, in a shared directory.
This directory will contain the setup program
used by the end users and the reference version
used to manage the updates.
This setup is used to:
• manage the automatic update of the
application installed on the network.
• get the characteristics of the users connected
to the application at a given time.
• configure the location of the files required
by the application. Different cases can be
managed, for example:
• Installing all the application files on the
server.
• Installing the database on the server and
the files required to run the application
(".EXE", ".WDL", ".DLL", ...) on each user
computer.
• Installing part of the database on the
server and another part on each user
computer. The files required to run the
application (".EXE", ".WDL", ".DLL", etc.) are
also installed on each user computer.
• If the "Push" is taken into account, this setup
also allows you to:
• deploy a new application on a network from
a single management computer.
• deploy an update for the application on
a network from a single management
computer.
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• Setup via HTTP (on a proprietary server or in
the CLOUD). A first setup of the application will
be performed on an HTTP server. The users
will connect to a Web page to download the
application setup program.
This setup is used to:
• manage the automatic update of the
application installed on an HTTP server.
• configure the location of the files required
by the application. Different cases can be
managed, for example:
• Installing all the application files on the
server.
• Installing the database on the server and
the files required to run the application
(".EXE", ".WDL", ".DLL", ...) on each user
computer.
• Installing part of the database on the
server and another part on each user
computer. The files required to run the
application (".EXE", ".WDL", ".DLL", etc.) are
also installed on each user computer.
• Multisite setup. This setup is the combination
between a local network setup and an HTTP
setup. The HTTP setup is used to update the
reference setup on the local network.

2.1 Creating a setup program
To create a setup program allowing you to:
• deploy a WINDEV application, you can:
• use the setup program creation wizard directly
from WINDEV (on the "Project" tab, in the
"Generation" group, click "Setup procedure").
This wizard allows you to create the different
types of setup programs.
• use the WDInst setup editor (on the "Tools"
tab, in the "Utilities" group, click "WDInst").
This editor is used to customize the setup
program.
• provide other files, you must use the setup
program creation wizard, started from the setup
editor WDInst ("File .. New" from WDInst).
Reminder: To start WDInst, go to the "Tools" tab,
"Utilities" group and click "WDInst".

2.2 Installing a WINDEV application
Standard, compact or MSI setup
To install your application, simply start the
application setup program on the user computer.
The files required by the application are installed in
the specified setup directory.
To install an update of your application, simply run
the update setup program on the user computer.
The application files modified by the update are
replaced.
Setup with automatic update
To install your application:
1. Start your reference version setup program
from a user computer. The files required by the
reference application are installed in the specified
setup directory. The reference application
corresponds to a client setup program.
2. Run the client setup program from each
user computer. The files required by the client
application are installed in the specified setup
directory.
To install an update of your application:
1. Start your reference version setup update
from a user computer. The files of the reference
application modified by the update are replaced.
These replaced files can be saved.
2. When the application is started from a user
computer, the application update is automatically
proposed.

Setup with automatic update in
PUSH mode
To install your application in PUSH mode:
1. Start your reference version setup program
from a user computer. The files required by the
reference application are installed in the specified
setup directory. The reference application
corresponds to a client setup program.
2. The program for managing the network
applications is automatically started.
3. Select the network computer on which the
setup will be performed.
To install an update of your application in PUSH
mode:
1. Start your reference version setup update
from a user computer. The files of the reference
application modified by the update are replaced.
These replaced files can be saved.
2. Start the program for managing the network
applications.
3. Select the network computer on which the
update will be performed.
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Monitoring your
applications

PART 6

Contenu

An application depends on several external parameters: Web site, HFSQL server, network, ... To
optimize the management of incidents, WINDEV allows you to use a monitoring robot.
The monitoring robot, which is composed of three executables running on different computers, is
used to run different tests: Internet connectivity check, network tests, etc.
If problems occur during a test, the monitoring robot will use different methods to inform you:
• Message sent via PC SOFT’s messaging tool (WDBAL).
• Email.
• Running another program.
Furthermore, a sound alert can be implemented on the monitor.

Configures

User computer:
Monitor
- Manages tests
- Configures robots
- Can directly run tests

Computer 1:
Monitoring robot
- Runs tests on a regular basis
- Sends a message if a problem
occurs

Configures

Computer 2:
Counter-Robot

Monitoring
test

- Tests the monitoring robot on a regular basis
- Sends a message if a problem occurs

Available types of tests
Internet test
(test of a Web site)

Test of HFSQL
Client/Server servers

Network test
(SNMP)

Test of FTP
server

Test of news
server

Test of WINDEV
application

Custom test
(in WLanguage)
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...

Communication

Managing
emails

Contenu

WINDEV proposes several methods for managing emails:
• POP3 or IMAP and SMTP (most common method).
• the "Simple Mail API (also called SMAPI or Simple MAPI)".

POP3 or IMAP and SMTP
These protocols are the standard Internet protocols for email management. They are standardized
by the RFC 1939, 3501 and 5321 documents. These protocols allow you to directly communicate
with the server, available at your ISP.

Local computer
(User)
WINDEV application

SMTP protocol
Send emails

POP3/IMAP
protocol

Email server
(Hosting company)
POP3/IMAP
service

SMTP service

Receive emails

Remote access

• POP3 (Post Office Protocol) is a protocol for reading emails.
• IMAP (Internet Message Access Protocol) is a protocol for reading emails remotely.
• SMTP (Simple Mail Transfer Protocol) is a protocol for sending emails.
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Transferring
files via FTP

Contenu

"Simple Mail API (also called SMAPI or Simple MAPI)"
This mode for email management is used by most Microsoft applications, especially MS Exchange.

FTP (File Transfer Protocol) is a protocol used to transfer files from a site to another remote site.
This protocol is used to exchange files by TCP/IP or Internet.

Local computer
(User)
WINDEV application

Email server
(Hosting company)
POP3 service

Principle
To handle the files found on an FTP server from a WINDEV application, you must follow these
rules:
1. Connecting to an FTP server (FTPConnect).

SMTP service

User computer

Simple MAPI

User
profile
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WINDEV application

Connection

FTP server
FTP account
Anonymous
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2. Sending and retrieving files (according to the connection mode). For a passive connection, the
WINDEV application must request the authorization from the FTP server before any operation is
performed on the server files. You can also:
• find out the characteristics of files found on an FTP server: attributes, size, ...
• handle the files found on an FTP server: creation, deletion, ...
• list the files of a directory found on the FTP server by running a procedure used to perform a
process for each file found.

Managing
sockets

Contenu

WINDEV includes advanced socket management functions .
A socket is a communication resource used by the applications to communicate between
computers regardless of the network type.
This communication mode can be used, for example, to establish a communication between
computers connected by Internet.

Different possibilities

User computer
Passive connection
(Firewall on the FTP server)

1

WINDEV application

Validation

3
Active connection

Ask for
authorization

FTP server
Passive connection
(Firewall on the FTP server)

2

Principle of client application

Action

Action

A client application of a socket server connects to a standard server in order to exchange
information via socket.
Active connection

WINDEV application

WINDEV application
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FTP server
Disconnection

Example: A client WINDEV application can connect to a standard news server on Internet.
Step 1: Connecting to the server
To connect to a server socket, use SocketConnect. This function is used to perform a request for
connecting to the server. The socket is identified by its port and by its address.

3. Closing the connection to the server (FTPDisconnect).

User computer

WINDEV applications can manage sockets according to different modes:
• Client WINDEV application: the application connects to any server and it exchanges data via a
socket.
• WINDEV "Simplified server" application: the WINDEV application is a server, exchanging
information via sockets with a single client computer.
• WINDEV "Standard server" application: the WINDEV application is a server, exchanging
information via sockets with several client computers.

Step 2: Exchanging data
Once two computers have connected their socket, a communication channel is established
between these two computers. These two computers can read and write character strings on the
socket.
To read and write on the server socket, the WINDEV client application must use SocketRead and
SocketWrite.
Step 3: End of communication
To end the communication, all you have to do is close the socket from the client computer with
SocketClose.
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WINDEV and
telephony

Contenu

The different steps can be represented as follows:

Client computer
SocketConnect function

SocketWrite and
SocketRead functions

Server

1

Connection

2

Read/
Write

Disconnection
SocketClose function

3

Remark: the SocketXXX functions can also be used to manage secured sockets according to the
SSL protocol. To do so, use SocketCreateSSL and SocketConnectSSL.

WINDEV allows you to easily manage the incoming and outgoing phone calls via the WLanguage
telephony functions. These functions are used to manage a voice box, an answerphone, ... in a
WINDEV application directly.

Client computer
WINDEV
application

- Call detection
- Identification of calling number

Modem
Automatic dialing

Required configuration:
To be able to use the telephony features, you must have:
• a modem.
To save and play recordings, this modem must include voice support.
To identify the caller, the modem must support Caller ID.
• the Tapi 3.1 protocol.
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Webservices:
concepts

PART 7

Contenu

WINDEV allows you to easily use the Webservices (or XML Web services). A Webservice is an
application available on the Web. WINDEV allows you to access SOAP Webservices (Simple Object
Access Protocol) as well as REST Webservices (Representational State Transfer).
Any WINDEV application can use an existing Webservice.
To use a SOAP Webservice, all you have to do is know the Webservice address and import its
description into the application.

Development
computer

Import the
service
description

Web
server

Webservice
Use the
Webservice
WINDEV executable

To use a REST Webservice, all you have to do is find out the Webservice characteristics and use
RESTSend.
Remark: you also have the ability to expose one or more sets of procedures found in a WINDEV
application as a SOAP or REST Webservice. To do so, you must:
• create a project configuration dedicated to this use,
• for a REST Webservice, create a description of the REST Webservice,
• generate the Webservice,
• deploy it on a WEBDEV Application Server.
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Appendices

Components supplied
with WINDEV

Contenu

WINDEV is supplied with projects corresponding to components. These projects contain:
• a project configuration corresponding to the component.
• a project configuration corresponding to the use of component.
• an internal component.
The list of the main components supplied with WINDEV is as follows:
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WD BGInfo

This example explains how to write information on the
background screen of a computer (IP address, name of the
computer, today’s date, etc).

WD Communication

Used to establish a communication between two applications.
These two applications can be:
• On remote computers. The communication is performed via
sockets.
• On the same computer. The communication is performed
via the Windows messages.

WD Email address
autocomplete

Used to simplify the input of emails.

WD EventLog

Used to:
• List and read the events saved in the event log of Windows.
• Add an event into the event log of Windows.

WD Explorer Bar

Used to manage an address bar similar to the address bar of
the Windows Vista explorer.

WD Extraction

Used to extract and store the content of several documents
(Open Office, Word 2007, ...) in order for them to be found by
the full-text search.

WD Floating Windows

Used to display temporary information to the user without
interrupting his work.

WD Glossary

Used to organize and store the written expressions regularly
used by a customer.
This allows you to propose an access to a “Glossary” that can
be easily customized by the customer himself All the glossary
entries can be organized in tree-like categories.

WD HTML Page Import

Used to import HTML pages with the WLanguage functions.

WD LastDocuments

Allows you to propose a menu option used to open the last
documents opened in the application.
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WD Limitation

WD Managing Logs
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Used to limit an application by different methods:
• Time limitation (the application can be used during a 30day period).
• Limitation to a single computer (the application can be run
only on a single computer).
• Limitation on the number of users (the application cannot
be run by more than n users).
Used to define, for an application, a configuration for the
runtime logs:
• number of log files that must be stored,
• maximum size for each log file,
• information that must be logged.
This example simulates different processes to observe the
management of log files (.wlog files).

WD Photocopier

Used to photocopy documents via a scanner and a printer.

WD PrintModel

Used to manage print profiles.

WD Printout Parameters

Presents the use of iParameter. This function is used to
retrieve the different settings defined for a specific printer.
The printer used is defined by iConfigure(Printer Name).
This component is used to modify different settings:
• The paper orientation,
• The scale,
• The management of TrueType fonts,
• The number of copies,
• The management of color (color or black/white print),
• The double-sided,
• The output style (sheets grouped by copy or by page
number).

WD PrintSpooler

Defines the list of less used printers in order to perform one
or more prints.

WD Progress bars

Used to automatically manage a simple or dual progress bar
that displays the remaining time or the number of process
steps.

WD Select RTF

Used to perform all types of searches in an RTF control. You
have the ability to search for:
• the words in bold,
• the words in italic,
• the words of a specific color,
• a character string containing specific words.
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WD Signature

Allows you to easily include a ready-to-use ‘Signature’ control
in your WINDEV applications. This control is very useful for
the applications intended to operate on touch-screen devices,
TabletPC in Windows XP, interactive devices, ...

WD Simplexe

Used to perform calculations from the Simplexe algorithm.

WD Sockets

Used to establish a communication between two applications
by using sockets.

WD SystemInfo

Proposes three categories of functions used to group
information about the current computer, the user and the
network to which the current computer is connected.

WD Touch Screen

Used for interfacing a tactile screen that can replace the
standard keyboard. This keyboard allows you to use a WINDEV
application on a computer not equipped with a keyboard.

WD Trace Socket

Allows you to trace a communication via socket, on a given
address, on a given port. This allows you to understand the
principle of dialog via socket between two applications.
In the applications that dialog via socket, you will be able to
see all of the exchanges performed on the socket even if no
trace option was specified by the developers.
This example also allows you to better understand the
operating mode of network protocols based on sockets:
POP3, SMTP, FTP, HTTP, etc.
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Examples supplied with
WINDEV

Contenu

The examples supplied with WINDEV are intended to help you learn the features of WINDEV.
Their source code is commented and detailed.
Several types of examples are supplied with WINDEV:
• Full examples: these examples correspond to full applications that can be used without any
adaptation.
• Training examples: these examples illustrate a specific feature.
These examples can be opened directly from the WINDEV home window:
• If the example is not installed on the computer, it will be automatically downloaded (from a PC
SOFT server) and opened.
• If the example is installed on the computer, a copy is automatically made in "My projects\My
examples".
The open example corresponds to the copy of the original example. This allows you to work or make
changes to this copy. Therefore, the initial example is stored. Every time you open the example (via
the "Open an example" button), you can work on the modified or initial version.
Features of some examples supplied with WINDEV.

Full examples

This example is a simplified HTTP proxy. You have the ability
to save the connections and to find out the pages that have
been viewed.

WD Live Messaging

Presents the functions for managing the sockets.

WD Loan

Enables you to simulate loans and to:
• calculate the amount of monthly payments according to the
amount of the loan.
• calculate the amount that can be borrowed according to
the amount of a monthly payment.
• calculate the interest on investment from a monthly
deposit.
For each case, you have the ability to print the depreciation
schedule corresponding to your parameters.

WD Magnifier

Used to zoom a section of the screen via a magnifier. The
zoom value can be multiplied by 8.

WD Mail

This application is a full email client. It is based on the Email
objects. This email client is used to send and retrieve emails
by using the POP, IMAP and SMTP protocols.

WD Manager of task DotNet

Used to list the applications and processes via the .NET
functions.
Used to perform different processes on the applications and
on the processes.

WD Managing a computer
fleet

Allows you to manage a computer fleet. For each computer,
you have the ability to define its characteristics, its
components and its users.
These features are implemented via the use of queries,
reports and combo boxes.

WBSetup

Used to create customize the setup by physical media of a
WEBDEV site.

WD Burner Lite

Used to burn data CDs, DVDs or Blue-Ray disks.

WD Burner

Used to burn data CDs, DVDs or Blue-Ray disks.

WD File Synchronization

Used to synchronize two file directories.
After the synchronization, the destination directory is identical
to the source directory. The comparison is performed on the
presence and on the date of the files.

WD Managing Contacts

This example is a full FTP client allowing you to store several
FTP servers. Then, you have the ability to perform multi-file
transfers from the local computer to the server or from the
FTP server to the local computer. To do so, we are using the
standard functions of WLanguage (FTPConnect, etc).

Used to manage contacts and to send emails to them.
You also have the ability to synchronize these contacts with
the ones found on the mobile device linked to the PC and with
the ones of Outlook.

WD Multimedia

Presents an advanced use of a Gantt chart.
Used to create a Gantt chart with tasks, links, cumulative
tasks and milestones.
The tasks can be edited in a specific window.
The created chart can be saved in a file in order to be
reloaded thereafter.

Enables you to read and play:
• videos (AVI, MPEG, ...),
• sound files (MP3, WAV),
• audio CDs,
• Flash animations.

WD Office Image Editor

This example presents the operating mode of Image Editor
control of WINDEV.

WD Office PDFReader

This example presents the operating mode of PDF Reader
control of WINDEV.

WD FTP File Transfer

WD Gantt
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WD Office Spreadsheet

This example presents the operating mode of Spreadsheet
control of WINDEV.

WD Office Word Processing

This example illustrates the operation of the Word Processing
control of WINDEV.

WD Organizer

Used to synchronize the appointments in your Outlook, Lotus
Notes and Google calendars.

WD Outlook

Enables you to read and write in the Outlook folders:
• Messaging,
• Calendar,
• Contacts,
• Tasks.
This example is intended to operate with the standard version
of Outlook supplied with Office.

WD Password
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Presents a “box” of passwords. It can be used to manage the
passwords created when using the Internet sites but also in
applications or in everyday’s life (codes, ...).
It can also be used as a generator of passwords to produce
secure passwords.

WD POP3Proxy

This example presents a POP3 proxy. In this example, the
proxy is used to automatically archive the emails in a HFSQL
database.

WD RSS Reader

Presents the use of classes for reading the RSS streams.

WD Sales Management

A “trendy” application for sales management that includes
dynamic tabs and ribbon.

WD Schedule

Used to create a schedule containing click areas.

WD Simple Internet Browser

This example presents the features of WINDEV’s HTML
control and includes a simplified web browser with browsing
history, favorites, etc.

WD Telephony

Uses the telephony functions of WINDEV:
• To dial a phone number,
• To detect and identify the incoming calls.

WD Video Conference

Used to start a conference with a remote user.
Used to send a file to a recipient and to establish a dialog
with him.
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WD WebCam

Presents the integration of a Web Camera in a WINDEV
window.
You can:
• View the image broadcasted by the camera,
• Perform an immediate capture,
• Capture the scene broadcasted as a Windows animation
(“AVI” file).

WD Zip

Used to create and read compressed archives in “WDZ”
format (WINDEV ZIP).

WDSETUP

This example explains how to create a custom setup
procedure for your application with WINDEV.

Training examples
WD Active Directory DotNet

Allows you to view the content of Active Directory. This
viewing is performed via .NET objects found in the System.
DirectoryServices assembly.

WD Animated Menu

This example proposes different menu animations.

WD Auto Error Management

This example is an educational example about the automatic
management of errors.
This example presents the case of fatal errors, non-fatal
errors, errors on several levels.

WD Bluetooth

This example presents the use of the Bluetooth functions:
• to list the accessible Bluetooth devices,
• to list the services proposed by a device,
• to connect to a Bluetooth device,
• to send a file to a device via the “OBEX” functions of
WLanguage.

WD ChainedList

Supplies the tools for building chained lists with simple
chaining. A list with simple chaining is used to store and
browse in organized way a set of ordinary values.

WD Changing Skin Templates

This example presents a solution allowing the users to
dynamically change the skin templates.

WD Chart

This training example explains how to use the chart control. All
the available types of charts are presented.

WD Coloring Search

This example explains how to highlight the sought words in the
results of a Full-Text search.
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WD Controlling Excel

Used to control Excel via OLE Automation. All the Excel
functions can be used.

WD DOTNET WMI

The WMI (Windows Management Instrumentation) is used to
exhaustively manage the applications and the devices. The
WMI can be compared to a database that groups various
information about a computer.

WD Controlling LibreOffice

Used to control LibreOffice via OLE Automation. All the
LibreOffice functions can be used.

WD Controlling Outlook

Used to control Outlook via OLE Automation. All the Outlook
functions can be used.

WD Drawing on Chart

This example is based on the use of an internal component
allowing you to draw elements on a chart control: Min/Max
areas, Various areas, Flags, Plots and monitoring trackers,...

WD Controlling Spreadsheets

This example explains how to control the OpenOffice Calc
spreadsheet and the Excel spreadsheet with a generic code.

WD DuplexPrintout

The purpose of this example is to propose a universal
interface used to control these applications without having to
worry about the application to control.

This example presents a solution for double-sided printing that
can be disabled, which means that the back sides may not be
printed.

WD
Controlling
processor

WD Duplication

This educational example explains how to duplicate a
database on a server.

WD Controlling Word

Used to control Word via OLE Automation. All the Word
functions can be used.

WD Evaluation period

Allows you to limit the use of an application to a given period
(trial period).

WD Dashboard

The “WD Dashboard” example explains how to use the
Dashboard control.

WD Example of unit test

WD DataBinding

The “WD DataBinding” example explains how a control can be
linked to a WLanguage variable.

This example presents the use of the test editor supplied with
WINDEV via two different cases:
• the test of a window.
• the test of a global procedure.

WD Detecting HFSQL Errors

Presents the module for assisted management of HFSQL
errors:
• the default operating mode,
• the customization options.

WD Extended Map

This example shows the different features of the Map control
in desktop (Windows) and mobile (Android, iOS) devices

WD Flowchart

This example is used to create organization charts.

WD Gallery Control

This example demonstrates the use of the "Image Gallery"
control.

WD Graphic Objects

This example is an editor of graphic objects.
You can:
• move, resize the objects,
• perform selections with the lasso or with the mouse,
• cut/copy/paste the objects,
• delete/duplicate the objects,
• save the created documents and print them..

WD Handling the Organizer
control

Example for using the Organizer control. The following features
are used: Creating an appointment, Saving an organizer,
Restoring an organizer.

WD HFSQL Explain Analyzer

Visually represents the details of the execution plane of a SQL
query via SQL EXPLAIN.

WD HotKey

Used to define your own keyboard shortcuts.

WD HTML Export

Manages the external files. Also explains how to handle the
files in HTML format.

word

WD Device Opening
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This example is used to add or delete an application into/from
the automatic opening system for the removable devices by
programming.

WD DirectoryObserver

This example presents the use of the .NET delegates (.NET
events) in WLanguage.

WD DirectX

This example allows you to use DirectX 9.0 in your WINDEV
applications.

WD Discovering MVP - Part 1

This training example explains how to implement an MVP
architecture (Model View Presenter) in a project.

WD Discovering MVP - Part 2

This training example explains how to implement an MVP
architecture (Model View Presenter) in a project for a simple
analysis (Customer - Order - Order line - Product).

WD DOTNET Delegate

This educational example explains how to interact with the
.NET delegates.
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WD Input checks

Checks the data typed by the user (name, company, city, zip
code, email address, etc.) in a form window.

WD Interactive Application

Presents the use of WinEdXXX function in an interactive
application.
This application is used to mange a connected house (switch
the lights on, find out the temperature).

WD JAVA Calls

WD Java Chart Designer
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Presents the call to the methods of classes of a JAR archive
via the WLanguage JavaExecuteFunction function.
It also explains how to fill a memory table (same operating
mode in Java and in Windows).
This example explains how to create charts via the drawing
functions.
Three types of charts are presented: column, scatter, line.

WD JavaMail

Used to create an applet that can be used in an Internet page.
This applet is used to read and send emails.

WD JSON

This example shows how to use the JSON format with WINDEV:
type of variable, type of item, import/export, ...

WD Jump lists

JumpList in Windows 7
A JumpList is a menu accessible from the Start menu or from
the application icon in the taskbar.

WD Lasso

Uses a selection lasso in an Image control to perform a zoom
in a preview control.

WD Mailshot

Used to send a “mailing” by Internet.

WD Managing HFSQL Errors

This example presents the management of HFSQL errors
(duplicate, integrity).
This example explains how to customize the process when an
error occurs.

WD Managing the Java errors

This training example explains the operating mode and the
implementation of the mechanism for managing the WINDEV
errors.

WD Multiple Clipboards

This example automatically manages a multi-level clipboard
between all the WINDEV applications started on the computer.

WD Multitouch

This example is using an internal component that gives you
the ability to use the Windows Touch features in a WINDEV
application.

WD Multi-Windowing

Used to understand the principle of multi-windowing in
WINDEV.
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WD Network frames

The analysis of the frames that circulate on the network
allows the administrators to audit the network and to detect
inconsistencies. To listen to the network, the application is
based on the Winsock 2 API and on the RAW Socket.

WD OAuth

The example proposes to connect to Google and Microsoft via
the AuthIdentify function and the OAuth2Parameter type.

WD Object Detection

This example shows how to use AIDetect.

WD Office365

This example presents the connection to Microsoft Office365
APIs and it allows you to use the Outlook contacts.

WD OLEDB

Used to access external databases via OLE DB.

WD OPC UA

This example shows how to communicate with an OPC UA
server.

WD OPC

Presents the implementation of OPC protocol in WINDEV.

WD OpenGL

Allows you to interface OpenGL and WINDEV. OpenGL is a
software interface used to draw three-dimensional objects
(3D).

WD OSD

OSD means: On-Screen Display. It is the name given to the
interfaces that appear on the computer or television screens
for example. They are often used to perform settings. These
types of menus are displayed above all the elements found on
the screen. This example explains how to create this type of
interface in WINDEV.

WD PC Info

Used to find out the language of the computer on which the
application is run.

WD Persistence

This example presents the use of InitParameter,
LoadParameter, SaveParameter. These functions are used to
configure the backup of controls, variables and parameters.

WD PivotTable

This example presents the use of the Pivot Table control.
This Pivot Table control is used to display dynamic statistics
by performing groupings. These statistics are calculated from
the database.

WD PowerPoint Generation

This example explains how to generate a PowerPoint
presentation from:
• the data found in a WINDEV application such as the data
found in tables, charts.
• and from a base PowerPoint document (.pptx).

WD PowerShell

This example allows you to run a powershell script from a
WINDEV application and retrieve the result and the report.
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WD Printing TreeViews

Allows you to print a TreeView. This example uses a “TreePrnt”
class that can be easily re-used in any treeview control.

WD SystemAPIs

Presents the use of Windows APIs.

WD Queries

Allows you to perform calculations, to pass parameters or to
print the result of a SQL query on a HFSQL data file.

WD Text-To-Speech

This example explains how to perform a speech synthesizer in
a WINDEV application by using the SpeechSynthesizer class of
the .NET framework.

WD Reflexive link

Uses a “reflexive” link to manage the family trees: each person
has several parents and several children All these records are
stored in the same file.

WD Timeline

Proposes an internal component used to handle a ‘Timeline’
control template. A timeline is used to display in a linear way a
set of events that occurred over a given period of time.

WD RemoteControl

Used to implement the remote control of a WINDEV
application.

WD Toasts

WD Reports

This example presents the different methods for creating a
report:
• prints based on different data sources (queries, variables,
...).
• prints based on controls (Table, Spreadsheet, PVT, ...).
• printing composite reports.
• specific prints (portrait/landscape, report with watermark,
report with bar code, ...).

This example shows how to use the ToastDisplay and
ToastDisplayIW functions as well as Toast variables. A Toast
is a temporary message used to inform the user without
interrupting the application.

WD Transaction

Illustrates the operating mode of transactions when placing
an order.

WD TreeMap

Uses the TreeMap control in order to view the content of a
directory and the space occupied by each file included in this
directory.

WD Trigger

Used to enter the expenses for the contributors of a company.
Two modes are available:
• View with ability to perform modifications (read/write),
• Read-only,
The triggers are used to check the access to the files according
to the selected mode.

WD Two-factor Authentication

This example shows how to use two-factor authentication to
secure access to user accounts. It uses TOTP authentication,
which generates a 6-digit code every 30 seconds.

WD Universal Replication

Explains how to synchronize the data of different sites by
using the universal replication.

WD User Groupware

Presents the operating mode of User Groupware.

WD Using DotNET classes

Allows you to use the .NET classes in WLanguage. Used to:
• analyze a character string,
• configure the dialog boxes displayed.

WD Using DOTNET

Used to convert a currency into other currencies.
The basis of this project (the cEuro class) is used to create a
.Net assembly.

WD Using sockets

Presents the use of sockets in client/server mode.
Each socket is handled via a thread.

WD WDSETUP Plugin

This project contains the elements required to create a setup
plugin (or “extension”) for WDSETUP.

WD Riak

WD Riak presents an example for using the Riak database in
WLanguage.

WD RibbonSearch

The “WD RibbonSearch” example proposes a solution to find
an element in a Ribbon control from its caption and tooltip.

WD SchedulerWithBreak

The “WD SchedulerWithBreak” example proposes a solution
for managing breaks in a Scheduler control.

WD Screen Saver

Used to manage a screen saver via the management of timers
and Windows events.

WD Search Control

This example explains how to manage an edit control used to
perform “Google” FullText searches in your database.

WD Search On Composite
Keys

Presents the use of filters and the use of composite keys in
order to optimize the search times on a HFSQL data file.

WD Server trigger

This example presents the use of server triggers.

WD Service

This example presents the creation of a “service” application
with WINDEV.

WD SharingMemory

This example explains how to use the functions for sharing
memory.

WD Simple OOP

Example about the OOP with WINDEV.

WD Syntactic Coloring

This example proposes a base class used to perform a
syntactic coloring on a text.
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WD Webservice Client

This example illustrates the use of WebServices.

WD Webservice Server

This example illustrates the use of the WebServices.

WD Website automation

This example shows how to automate a website using
WINDEV’s HTML Control and the WLanguage HTMLxxx
functions

WD Who is locking

Signals to the users of a HFSQL database in network who is
locking a record.

WD WindowsUpdate

This example explains how to manage the updates available
on Windows Update.

WD Wizard

Manages a “Wizard” window.

Additional examples will be available on our website (www.windev.com).
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